THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB's public domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Any Internet Protocol (IP) addresses and phone numbers used in this document are not intended to be actual addresses and phone numbers. Any examples, command display output, network topology diagrams, and other figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses or phone numbers in illustrative content is unintentional and coincidental.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

© 2017 Cisco Systems, Inc. All rights reserved.
CONTENTS

Preface xi

Audience xii
Organization xii
Conventions xii
Related Documentation xv
Obtaining Documentation and Submitting a Service Request xv

CHAPTER 1 Mesh Network Components 1

Mesh Access Points 1
Licensing for Mesh Access Points on a 5508, 3504 5520 and 8540 Series Cisco Comptroller 1
Access Point Roles 2
Network Access 3
Network Segmentation 4
Cisco Indoor Mesh Access Points 4
Cisco Outdoor Mesh Access Points 5
Frequency Bands 6
Dynamic Frequency Selection 7
Antennas 8
Client Access Certified Antennas (Third-Party Antennas) 9
Cisco Wireless LAN Controllers 9
Cisco Prime Infrastructure 10
Architecture 10
Control and Provisioning of Wireless Access Points 10
CAPWAP Discovery on a Mesh Network 10
Dynamic MTU Detection 10
Adaptive Wireless Path Protocol 11
Traffic Flow 11
Mesh Neighbors, Parents, and Children 12
Criteria to Choose the Best Parent 13
Ease Calculation 13
Parent Decision 14
SNR Smoothing 14
Loop Prevention 14

CHAPTER 2 Mesh Deployment Modes 15
Wireless Mesh Network 15
Wireless Backhaul 15
Universal Access 16
Point-to-Multipoint Wireless Bridging 16
Point-to-Point Wireless Bridging 17
Configuring Mesh Range (CLI) 18

CHAPTER 3 Design Considerations 19
Wireless Mesh Constraints 19
Wireless Backhaul Data Rate 19
Controller Planning 23

CHAPTER 4 Air Time Fairness in Mesh Deployments rel 8.4 25
Air Time Fairness in Mesh Deployments Rel 8.4 25
Pre-requisite and Supported Features in 8.4 release 25
Cisco Air Time Fairness (ATF) Use Cases 26
ATF Functionality and Capabilities 26
ATF on Mesh Feature Overview 27
ATF Modes of Operation 30
Configuring ATF on Mesh 30

CHAPTER 5 Site Preparation and Planning 37
Site Survey 37
Pre-Survey Checklist 37
Outdoor Site Survey 38
Determining a Line of Sight 38
## CHAPTER 6

### Connecting the Cisco 1500 Series Mesh Access Points to the Network

- Adding Mesh Access Points to the Mesh Network 80
- Adding MAC Addresses of Mesh Access Points to MAC Filter 81
  - Adding the MAC Address of the Mesh Access Point to the Controller Filter List (GUI) 82
  - Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI) 83
- Defining Mesh Access Point Role 83
  - General Notes about MAP and RAP Association With The Controller 83
  - Configuring the AP Role (GUI) 84
  - Configuring the AP Role (CLI) 84
- Configuring Multiple Controllers Using DHCP 43 and DHCP 60 85
- Backup Controllers 86
  - Configuring Backup Controllers (GUI) 87
  - Configuring Backup Controllers (CLI) 88
- Configuring External Authentication and Authorization Using a RADIUS Server 90
  - Configuring RADIUS Servers 91
  - Enabling External Authentication of Mesh Access Points (GUI) 92
    - Adding a Username to a RADIUS Server 92
    - Enable External Authentication of Mesh Access Points (CLI) 93
  - View Security Statistics (CLI) 93
- Mesh PSK Key provisioning in release 8.2 94
  - Wireless Mesh Components Supported 94
  - Feature Configuration Step-by-Step 95
    - Mesh PSK GUI Configuration 95
    - Mesh PSK Provisioning with Controllers In Mobility Group 101
  - CLI Commands for PSK Provisioning 101
- Configuring Global Mesh Parameters 101
  - Configuring Global Mesh Parameters (GUI) 102
  - Configuring Global Mesh Parameters (CLI) 105
  - Viewing Global Mesh Parameter Settings (CLI) 106
- Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2 107
- Backhaul Client Access 111
  - Configuring Backhaul Client Access (GUI) 112
<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuring Backhaul Client Access (CLI)</td>
<td>112</td>
</tr>
<tr>
<td>Configuring Local Mesh Parameters</td>
<td>113</td>
</tr>
<tr>
<td>Configuring Wireless Backhaul Data Rate</td>
<td>113</td>
</tr>
<tr>
<td>Configuring Ethernet Bridging</td>
<td>115</td>
</tr>
<tr>
<td>Enabling Ethernet Bridging (GUI)</td>
<td>117</td>
</tr>
<tr>
<td>Configuring Native VLAN (GUI)</td>
<td>118</td>
</tr>
<tr>
<td>Configuring Native VLAN (CLI)</td>
<td>118</td>
</tr>
<tr>
<td>Configuring Bridge Group Names (CLI)</td>
<td>119</td>
</tr>
<tr>
<td>Configuring Bridge Group Names</td>
<td>119</td>
</tr>
<tr>
<td>Configuring Interoperability with Cisco 3200</td>
<td>119</td>
</tr>
<tr>
<td>Configuring Power and Channel Settings</td>
<td>121</td>
</tr>
<tr>
<td>Configuring Power and Channel Settings (GUI)</td>
<td>121</td>
</tr>
<tr>
<td>Configuring Antenna Gain</td>
<td>121</td>
</tr>
<tr>
<td>Configuring Antenna Gain (GUI)</td>
<td>121</td>
</tr>
<tr>
<td>Configuring Antenna Gain (CLI)</td>
<td>122</td>
</tr>
<tr>
<td>Configuring Dynamic Channel Assignment</td>
<td>122</td>
</tr>
<tr>
<td>Configuring Radio Resource Management on a Bridge Mode Access Point</td>
<td>124</td>
</tr>
<tr>
<td>Configuring Advanced Features</td>
<td>125</td>
</tr>
<tr>
<td>Configuring Ethernet VLAN Tagging</td>
<td>126</td>
</tr>
<tr>
<td>Ethernet Port Notes</td>
<td>127</td>
</tr>
<tr>
<td>VLAN Registration</td>
<td>127</td>
</tr>
<tr>
<td>Ethernet VLAN Tagging Guidelines</td>
<td>128</td>
</tr>
<tr>
<td>Enabling Ethernet VLAN Tagging (GUI)</td>
<td>129</td>
</tr>
<tr>
<td>Configuring Ethernet VLAN Tagging (CLI)</td>
<td>130</td>
</tr>
<tr>
<td>Viewing Ethernet VLAN Tagging Configuration Details (CLI)</td>
<td>131</td>
</tr>
<tr>
<td>Workgroup Bridge Interoperability with Mesh Infrastructure</td>
<td>131</td>
</tr>
<tr>
<td>Configuring Workgroup Bridges</td>
<td>133</td>
</tr>
<tr>
<td>Guidelines for Configuration</td>
<td>136</td>
</tr>
<tr>
<td>Configuration Example</td>
<td>137</td>
</tr>
<tr>
<td>WGB Association Check</td>
<td>139</td>
</tr>
<tr>
<td>Link Test Result</td>
<td>141</td>
</tr>
<tr>
<td>WGB Wired/Wireless Client</td>
<td>142</td>
</tr>
<tr>
<td>Client Roaming</td>
<td>143</td>
</tr>
<tr>
<td>WGB Roaming Guidelines</td>
<td>143</td>
</tr>
</tbody>
</table>
Contents

CHAPTER 7  Checking the Health of the Network  167

  Show Mesh Commands  167

  Viewing General Mesh Network Details  167

  Viewing Mesh Access Point Details  169

  Viewing Global Mesh Parameter Settings  170

  Viewing Bridge Group Settings  171

  Viewing VLAN Tagging Settings  171

  Viewing DFS Details  171

  Viewing Security Settings and Statistics  172

  Viewing GPS Status  172

  Viewing Mesh Statistics for a Mesh Access Point  173

  Viewing Mesh Statistics for a Mesh Access Point (GUI)  173

  Viewing Mesh Statistics for an Mesh Access Point (CLI)  176

  Viewing Neighbor Statistics for a Mesh Access Point  177

Configuration Example  144

Troubleshooting Tips  144

Configuring Voice Parameters in Indoor Mesh Networks  145

Call Admission Control  145

Quality of Service and Differentiated Services Code Point Marking  145

Guidelines For Using Voice on the Mesh Network  151

Voice Call Support in a Mesh Network  152

Enabling Mesh Multicast Containment for Video  153

  Viewing the Voice Details for Mesh Networks (CLI)  154

  Enabling Multicast on the Mesh Network (CLI)  157

IGMP Snooping  157

Locally Significant Certificates for Mesh APs  158

  Guidelines for Configuration  158

  Differences Between LSCs for Mesh APs and Normal APs  159

  Certificate Verification Process in LSC AP  159

  Getting Certificates for LSC Feature  159

  Configuring a Locally Significant Certificate (CLI)  161

  LSC-Related Commands  163

  Controller GUI Security Settings  164

  Deployment Guidelines  165
## Contents

### CHAPTER 8

**Troubleshooting** 181

- Installation and Connections 181
- Debug Commands 182
- Remote Debug Commands 183
- AP Console Access 183
- Cable Modem Serial Port Access From an AP Configuration 184
- Mesh Access Point CLI Commands 186
- Mesh Access Point Debug Commands 189
- Defining Mesh Access Point Role 189
- Backhaul Algorithm 189
- Passive Beaconing (Anti-Stranding) 190
- Dynamic Frequency Selection 191
  - DFS in RAP 192
  - DFS in MAP 193
  - Preparation in a DFS Environment 194
  - Monitoring DFS 195
  - Frequency Planning 195
  - Good Signal-to-Noise Ratios 196
  - Access Point Placement 196
  - Check Packet Error Rate 196
- Bridge Group Name Misconfiguration 196
- Misconfiguration of the Mesh Access Point IP Address 198
- Misconfiguration of DHCP 199
- Identifying the Node Exclusion Algorithm 199
- Throughput Analysis 201

### CHAPTER 9

**Managing Mesh Access Points with Cisco Prime Infrastructure** 203

- Adding Campus Maps, Outdoor Areas, and Buildings with Cisco Prime Infrastructure 204
  - Adding Campus Maps 204
  - Adding Outdoor Areas 204
  - Adding a Building to a Campus Map 205
Contents

Adding Mesh Access Points to Maps with Cisco Prime Infrastructure 206
Monitoring Mesh Access Points Using Google Earth 207
   Launching Google Earth in Cisco Prime Infrastructure 208
   Viewing Google Earth Maps 208
Adding Indoor Mesh Access Points to Cisco Prime Infrastructure 211
Managing Mesh Access Points with Cisco Prime Infrastructure 212
   Monitoring Mesh Networks Using Maps 212
      Monitoring Mesh Link Statistics Using Maps 212
      Monitoring Mesh Access Points Using Maps 213
      Monitoring Mesh Access Point Neighbors Using Maps 214
   Monitoring Mesh Health 215
Viewing Mesh Statistics for a Mesh Access Point 217
Viewing the Mesh Network Hierarchy 222
   Using Mesh Filters to Modify Map Display of Maps and Mesh Links 223
Monitoring Workgroup Bridges 225
   Multiple VLAN and QoS Support for WGB Wired Clients 226
      Workgroup Bridge Guidelines 227
      Configuring VLAN and QoS Support (CLI) 228
      Workgroup Bridge Output 228
      WGB Detail on Controller 230
      Troubleshooting Tips 231
Viewing AP Last Reboot Reason 232
Preface

This document provides design and deployment guidelines for the deployment of secure enterprise, campus, and metropolitan Wi-Fi networks within the Cisco wireless mesh networking solution, a component of the Cisco Unified Wireless Network (CUWN).

Mesh networking employs Cisco Aironet 1500 Series outdoor mesh access points and indoor mesh access points (Cisco Aironet 1130, 1240, 1250, 2600, 2700, 3500, 3600 and 3700 series access points) along with the Cisco Wireless LAN Controller, and Cisco Prime Infrastructure to provide scalable, central management, and mobility between indoor and outdoor deployments. Control and Provisioning of Wireless Access Points (CAPWAP) protocol manages the connection of mesh access points to the network.

End-to-end security within the mesh network is supported by employing Advanced Encryption Standard (AES) encryption between the wireless mesh access points and Wi-Fi Protected Access 2 (WPA2) clients. This document also outlines radio frequency (RF) components to consider when designing an outdoor network.

The features described in this document are for the following products:

- Cisco Aironet 1570 (1572) series outdoor mesh access points
- Cisco Aironet 1560 (1562) series outdoor mesh access points
- Cisco Aironet 1550 (1552) series outdoor mesh access points
- Cisco Aironet 1530 series outdoor mesh access points
- Cisco Aironet 2600, 2700 3500, 3600, and 3700 series indoor mesh access points
- Mesh features in Cisco Wireless LAN Controller
- Mesh features in Cisco Prime Infrastructure

This chapter contains the following sections:

- Audience, page xii
- Organization, page xii
- Conventions, page xii
- Related Documentation, page xv
- Obtaining Documentation and Submitting a Service Request, page xv
### Audience

This document is for experienced network administrators who design and deploy mesh networks and configure and maintain Cisco mesh access points and Cisco wireless LAN controllers.

### Organization

This guide is organized into these chapters:

<table>
<thead>
<tr>
<th>Chapter Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mesh Network Components</td>
<td>This chapter describes the components of a mesh network.</td>
</tr>
<tr>
<td>Mesh Deployment Modes</td>
<td>This chapter describes the various deployment modes of mesh access points.</td>
</tr>
<tr>
<td>Design Considerations</td>
<td>This chapter describes the design considerations involved in a mesh network.</td>
</tr>
<tr>
<td>Air Time Fairness in Mesh Deployments rel 8.4</td>
<td>This chapter describes the air time fairness in mesh deployments.</td>
</tr>
<tr>
<td>Site Preparation and Planning</td>
<td>This chapter describes the implementation details and configuration examples.</td>
</tr>
<tr>
<td>Connecting the Cisco 1500 Series Mesh Access Points to the Network</td>
<td>This chapter describes the procedures involved in connecting mesh access points to a network and configuring the mesh access points.</td>
</tr>
<tr>
<td>Checking the Health of the Network</td>
<td>This chapter describes the commands to enter to check the health of a mesh network.</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>This chapter describes the troubleshooting information.</td>
</tr>
<tr>
<td>Managing Mesh Access Points with Cisco Prime Infrastructure</td>
<td>This chapter describes information about managing access points with Cisco Prime Infrastructure.</td>
</tr>
</tbody>
</table>

### Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>bold font</td>
<td>Commands and keywords and user-entered text appear in bold font.</td>
</tr>
<tr>
<td>italic font</td>
<td>Document titles, new or emphasized terms, and arguments for which you supply values are in italic font.</td>
</tr>
<tr>
<td>[ ]</td>
<td>Elements in square brackets are optional.</td>
</tr>
<tr>
<td>{x</td>
<td>y</td>
</tr>
</tbody>
</table>
### Conventions

<table>
<thead>
<tr>
<th>Convention</th>
<th>Indication</th>
</tr>
</thead>
<tbody>
<tr>
<td>[x</td>
<td>y</td>
</tr>
<tr>
<td>string</td>
<td>A nonquoted set of characters. Do not use quotation marks around the string or the string will include the quotation marks.</td>
</tr>
<tr>
<td>courier font</td>
<td>Terminal sessions and information the system displays appear in courier font.</td>
</tr>
<tr>
<td>&lt;&gt;</td>
<td>Nonprinting characters such as passwords are in angle brackets.</td>
</tr>
<tr>
<td>[]</td>
<td>Default responses to system prompts are in square brackets.</td>
</tr>
<tr>
<td>!, #</td>
<td>An exclamation point (!) or a pound sign (#) at the beginning of a line of code indicates a comment line.</td>
</tr>
</tbody>
</table>

---

**Note**

Means reader take note.

---

**Tip**

Means the following information will help you solve a problem.

---

**Caution**

Means reader be careful. In this situation, you might perform an action that could result in equipment damage or loss of data.

---

**Warning**

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar with standard practices for preventing accidents. (To see translations of the warnings that appear in this publication, refer to the appendix "Translated Safety Warnings.")

<table>
<thead>
<tr>
<th>Warning Title</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Waarschuwing</td>
<td>Dit waarschuwingssymbool betekent gevaar. U verkeert in een situatie die lichamelijk letsel kan veroorzaken. Voordat u aan enige apparatuur gaat werken, dient u zich bewust te zijn van de bij elektrische schakelingen betrokken risico's en dient u op de hoogte te zijn van standaard maatregelen om ongelukken te voorkomen. (Voor vertalingen van de waarschuwingen die in deze publicatie verschijnen, kunt u het aanhangsel &quot;Translated Safety Warnings&quot; (Vertalingen van veiligheidsvoorschriften) raadplegen.)</td>
</tr>
<tr>
<td>Varoitus</td>
<td>Tämä varoitusmerkki merkitsee vaaraa. Olet tilanteessa, joka voi johtaa ruumiinvamanaan. Ennen kuin työskentelet minkään laitteiston parissa, ota selvää sähkökytkentöihin liittyvistä vaaroista ja tavanomaisista onnettomuksien ehkäisykeinoista. (Tässä julkaisussa esiintyvien varoitusten käännöksiä löydät liitteestä &quot;Translated Safety Warnings&quot; (käännetyt turvallisuutta koskevat varoitukset).)</td>
</tr>
<tr>
<td>Warning Title</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Attention</td>
<td>Ce symbole d'avertissement indique un danger. Vous vous trouvez dans une situation pouvant entraîner des blessures. Avant d'accéder à cet équipement, soyez conscient des dangers posés par les circuits électriques et familiarisez-vous avec les procédures courantes de prévention des accidents. Pour obtenir les traductions des mises en garde figurant dans cette publication, veuillez consulter l'annexe intitulée « Translated Safety Warnings » (Traduction des avis de sécurité).</td>
</tr>
<tr>
<td>Warnung</td>
<td>Dieses Warnsymbol bedeutet Gefahr. Sie befinden sich in einer Situation, die zu einer Körperverletzung führen könnte. Bevor Sie mit der Arbeit an irgendeinem Gerät beginnen, seien Sie sich der mit elektrischen Stromkreisen verbundenen Gefahren und der Standardpraktiken zur Vermeidung von Unfällen bewußt. (Übersetzungen der in dieser Veröffentlichung enthaltenen Warnhinweise finden Sie im Anhang mit dem Titel &quot;Translated Safety Warnings&quot; (Übersetzung der Warnhinweise).)</td>
</tr>
<tr>
<td>Avvertenza</td>
<td>Questo simbolo di avvertenza indica un pericolo. Si è in una situazione che può causare infortuni. Prima di lavorare su qualsiasi apparecchiatura, occorre conoscere i pericoli relativi ai circuiti elettrici ed essere al corrente delle pratiche standard per la prevenzione di incidenti. La traduzione delle avvertenze riportate in questa pubblicazione si trova nell'appendice, &quot;Translated Safety Warnings&quot; (Traduzione delle avvertenze di sicurezza).</td>
</tr>
<tr>
<td>Advarsel</td>
<td>Dette varselsymbol betyr fare. Du befinner deg i en situasjon som kan føre til personskade. For du utfører arbeid på utstyr, må du være oppmerksom på de faremomentene som elektriske kretser innebærer, samt gjøre deg kjent med vanlig praksis når det gjelder å unngåulykker. (Hvis du vil se oversettelser av de advarslene som finnes i denne publikasjonen, kan du se i vedlegget &quot;Translated Safety Warnings&quot; [Oversatte sikkerhetsadvarslar].)</td>
</tr>
<tr>
<td>Aviso</td>
<td>Este símbolo de aviso indica perigo. Encontra-se numa situação que lhe poderá causar danos fisicos. Antes de começar a trabalhar com qualquer equipamento, familiarize-se com os perigos relacionados com circuitos elétricos, e com quaisquer práticas comuns que possam prevenir possíveis acidentes. (Para ver as traduções dos avisos que constam desta publicação, consulte o apêndice &quot;Translated Safety Warnings&quot; - &quot;Traduções dos Avisos de Segurança&quot;).</td>
</tr>
<tr>
<td>¡Advertencia!</td>
<td>Este símbolo de aviso significa peligro. Existe riesgo para su integridad física. Antes de manipular cualquier equipo, considerar los riesgos que entraña la corriente eléctrica y familiarizarse con los procedimientos estándar de prevención de accidentes. (Para ver traducciones de las advertencias que aparecen en esta publicación, consultar el apéndice titulado &quot;Translated Safety Warnings&quot;).</td>
</tr>
<tr>
<td>Warning</td>
<td>Denna varningssymbol signalerar fara. Du befinner dig i en situation som kan leda till personskada. Innan du utför arbete på någon utrustning måste du vara medveten om farorna med elkretsar och känna till vanligt förfarande för att förebygga skador. (Se förklaringar av de varningar som förekommer i denna publikation i appendix &quot;Translated Safety Warnings&quot; [Översatta säkerhetsvarningar].)</td>
</tr>
</tbody>
</table>
Related Documentation

These documents provide complete information about the Cisco Unified Wireless Network solution:

- Cisco Wireless LAN Controller Configuration Guide
- Cisco Wireless LAN Controller Command Reference
- Cisco Prime Infrastructure Configuration Guide
- Release Notes for Cisco Wireless LAN Controllers and Lightweight Access Points

Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly What's New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

Subscribe to the What's New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.
CHAPTER 1

Mesh Network Components

This chapter describes the mesh network components.
The Cisco wireless mesh network has four core components:

• Cisco Aironet series access points

Note

Cisco Aironet 1520 series mesh access points are not supported because of their End-of-Life status.

• Cisco Wireless LAN Controller (hereafter referred to as controller)
• Cisco Prime Infrastructure
• Mesh software architecture

This chapter contains the following sections:

• Mesh Access Points, page 1
• Cisco Wireless LAN Controllers, page 9
• Cisco Prime Infrastructure, page 10
• Architecture, page 10

Mesh Access Points

Licensing for Mesh Access Points on a 5508, 3504 5520 and 8540 Series Cisco Comptroller

To use both mesh and non-mesh access points with a Cisco 3504, 5500 and 8500 Series Controller, only the base license is required from the 7.0 release and later releases. For more information about obtaining and installing licenses, see the Cisco Wireless LAN Controller Configuration Guide at http://www.cisco.com/en/US/products/ps10315/products_installation_and_configuration_guides_list.html.
Access Point Roles

Access points within a mesh network operate in one of the following two ways:

1. Root access point (RAP)
2. Mesh access point (MAP)

**Note**
All access points are configured and shipped as mesh access points. To use an access point as a root access point, you must reconfigure the mesh access point to a root access point. In all mesh networks, ensure that there is at least one root access point.

While the RAPs have wired connections to their controller, the MAPs have wireless connections to their controller.

MAPs communicate among themselves and back to the RAP using wireless connections over the 802.11a/n/g radio backhaul. MAPs use the Cisco Adaptive Wireless Path Protocol (AWPP) to determine the best path through the other mesh access points to the controller.

Bridge mode access points support CleanAir in mesh backhaul and provides only the interference device report (IDR) and Air Quality Index (AQI) reports.

**Note**
The RAP or MAP does not generate Bridge Protocol Data Unit (BPDU) itself. However, the RAP or MAP forwards the BPDU to upstream devices if the RAP or MAP received the BPDU from its connected wired or wireless interface across the network.
This figure shows the relationship between RAPs and MAPs in a mesh network.

Figure 1: Simple Mesh Network Hierarchy

Network Access

Wireless mesh networks can simultaneously carry two different traffic types. They are as follows:

- Wireless LAN client traffic
- MAP Ethernet port traffic

Wireless LAN client traffic terminates on the controller, and the Ethernet traffic terminates on the Ethernet ports of the mesh access points.

Access to the wireless LAN mesh for mesh access points is managed by the following authentication methods:

- MAC authentication—Mesh access points are added to a database that can be referenced to ensure they are provided access to a given controller and mesh network.
- External RADIUS Authentication—Mesh access points can be externally authorized using a RADIUS server such as Cisco ACS (4.1 and later) and ISE that supports the client authentication type of Extensible Authentication Protocol-FAST (EAP-FAST) with certificates and and WPA2/PSK on the WLCs.
Network Segmentation

Membership to the wireless LAN mesh network for mesh access points is controlled by the bridge group names (BGNs). Mesh access points can be placed in similar bridge groups to manage membership or provide network segmentation.

Cisco Indoor Mesh Access Points

The following access point platforms are supported in this release:

- Cisco Aironet 1600 Series Access Points
- Cisco Aironet 1700 Series Access Points
- Cisco Aironet 2600 Series Access Points
- Cisco Aironet 2700 Series Access Points
- Cisco Aironet 3500 Series Access Points
- Cisco Aironet 3600 Series Access Points
- Cisco Aironet 3700 Series Access Points
- Cisco Aironet 1530 Series Access Points
- Cisco Aironet 1540 Series Access Points
- Cisco Aironet 1550 Series Access Points
- Cisco Aironet 1560 Series Access Points
- Cisco Aironet 1570 Series Access Points
- Cisco Industrial Wireless 3700 Series Access Points

Note: In 8.5 release the following APs will be supported.


Note: Enterprise 11n/ac mesh is an enhancement added to the CUWN feature to work with the 802.11n/ac access points. Enterprise 11ac mesh features are compatible with non-802.11ac mesh but adds higher backhaul and client access speeds. The 802.11ac indoor access points are two-radio Wi-Fi infrastructure devices for select indoor deployments. One radio can be used for local (client) access for the access point and the other radio can be configured for wireless backhaul. If Universal Backhaul Access is enabled, the 5-GHz and 2.4–GHz radios in rel 8.2 can be used for local (client) access as well as a backhaul. Enterprise 11ac mesh supports P2P, P2MP, and mesh types of architectures.
You have a choice of ordering indoor access points directly into the bridge mode, so that these access points can be used directly as mesh access points. If you have these access points in a local mode (non-mesh), then you have to connect these access points to the controller and change the AP mode to the bridge mode (mesh). This scenario can become cumbersome particularly if the volume of the access points being deployed is large and if the access points are already deployed in the local mode for a traditional non-mesh wireless coverage.

The Cisco indoor mesh access points are equipped with the following two simultaneously operating radios:

- From rel 8.2 2.4 GHz radio used for data backhaul and client access if UBA is enable
- 5-GHz radio used for data backhaul and client access if Universal Backhaul Access is enabled

The 5-GHz radio supports the 5.15 GHz, 5.25 GHz, 5.47 GHz, and 5.8 GHz bands.

**Cisco Outdoor Mesh Access Points**

Cisco outdoor mesh access points comprise of the Cisco Aironet 1500 series access points. The 1500 series includes 1572 11ac outdoor access points, 1552 and 1532 11n outdoor mesh access points, and the newer 1540 and 1560 11ac wave 2 series.

Cisco 1500 series mesh access points are the core components of the wireless mesh deployment. AP1500s are configured by both the controller (GUI and CLI) and Cisco Prime Infrastructure. Communication between outdoor mesh access points (MAPs and RAPs) is over the 802.11a/n/acr radio backhaul. Client traffic is generally transmitted over the 802.11b/g/n radio (802.11a/n/acc can also be configured to accept client traffic).

The mesh access point can also operate as a relay node for other access points not directly connected to a wired network. Intelligent wireless routing is provided by the Adaptive Wireless Path Protocol (AWPP). This Cisco protocol enables each mesh access point to identify its neighbors and intelligently choose the optimal path to the wired network by calculating the cost of each path in terms of the signal strength and the number of hops required to get to a controller.

Uplinks support includes Gigabit Ethernet (1000BASE-T) and a small form-factor (SFP) slot that can be plugged for a fiber or cable modem interface. Both single mode and multimode SFPs up to 1000BASE-BX are supported. The cable modem can be DOCSIS 2.0 or DOCSIS/EuroDOCSIS 3.0 depending upon the type of mesh access point.

AP1550s are available in a hazardous location hardware enclosure. When configured, the AP1500 complies with safety standards for Class I, Division 2, Zone 2 hazardous locations.

The mesh access points can operate, apart from the mesh mode, in the following modes:

- **Local mode**—In this mode, the AP can handle clients on its assigned channel or while monitoring all channels on the band over a 180-second period. During this time, the AP listens on each channel for 50 milliseconds for rogue client beacons, noise floor measurements, interference, and IDS events. The AP also scans for CleanAir interference on the channel.

- **FlexConnect mode**—FlexConnect is a wireless solution for branch office and remote office deployments. The FlexConnect mode enables you to configure and control access points in a branch or remote office from the corporate office through a WAN link without having to deploy a controller in each office. The FlexConnect mode can switch client data traffic locally and perform client authentication locally when the connection to the controller is lost. When connected to the controller, the FlexConnect mode can also tunnel traffic back to the controller.

- **Flex+Bridge Mode**—In this mode, both the Flexconnect and Bridge mode configuration options are available on the access point.
• Monitor mode—In this mode, the AP radios are in the receive state. The AP scans all the channels every 12 seconds for rogue client beacons, noise floor measurements, interference, IDS events, and CleanAir intruders.

• Rogue Detector mode—In this mode, the AP radio is turned off, and the AP listens only to the wired traffic. The controller passes the APs that are configured as rogue detectors as well as lists of suspected rogue clients and AP MAC addresses. The rogue detector listens for ARP packets and can be connected to all broadcast domains through a trunk link.

• Sniffer mode—In this mode, the AP captures and forwards all packets on a channel to a remote device that decodes the packets with packet analyzer software such as Wireshark.

• Bridge mode—In this mode, the AP is configured to build a wireless mesh network where wired network cabling is not available.

You can configure these modes using both the GUI and CLI. For configuration instructions, see the Cisco Wireless LAN Controller Configuration Guide.

Note
MAPs can only be configured in Bridge / Flex+Bridge mode regardless of their wired or wireless backhaul. If the MAPs have a wired backhaul, you must change their AP role to RAP before you change the AP Mode.

Note
For complete details and specification of all models of outdoor Mesh AP please visit this link below:

Frequency Bands

Both the 2.4-GHz and 5-GHz frequency bands are supported on the indoor and outdoor access points.

Figure 2: Frequency Bands Supported By 802.11a Radios on AP1500s
FCC United States

U-NII-1
This band can now be used indoors and outdoors
Maximum power is increased to 30 dBm (1 Watt) assuming antenna is 6 dBi
Power should be reduced by 1 dB for every dB antenna gain exceeds 6 dBi
When used outdoors, EIRP power in the upwards direction above 30 degrees is limited to 125 mW (20.9 dBm)

U-NII-2A and U-NII2C
Must include Dynamic Frequency Selection (DFS) radar detection
Terminal Doppler Weather Radar (TWDR) bands (channels 120, 124 & 128) are now available with new DFS test requirements

U-NII-3
Band extended from 5825 MHz to 5850 MHz

Europe

U-NII-1
23 dBm Maximum–Not permitted for outdoor usage

U-NII-2A
23 dBm Maximum–Not permitted for outdoor usage

U-NII-2C
30 dBm Maximum

U-NII-3
Only available in UK at 23 dBm for Indoor usage only

Dynamic Frequency Selection

Previously, devices employing radar operated in frequency subbands without other competing services. However, controlling regulatory bodies are attempting to open and share these bands with new services like wireless mesh LANs (IEEE 802.11).

To protect existing radar services, the regulatory bodies require that devices wishing to share the newly opened frequency subband behave in accordance with the Dynamic Frequency Selection (DFS) protocol. DFS dictates that to be compliant, a radio device must be capable of detecting the presence of radar signals. When a radio detects a radar signal, it is required to stop transmitting to for at least 30 minutes to protect that service. The radio then selects a different channel to transmit on but only after monitoring it. If no radar is detected on the projected channel for at least one minute, then the new radio service device may begin transmissions on that channel.

The AP performs a DFS scan on the new DFS channel for 60 seconds. However, if a neighboring AP is already using that new DFS channel, the AP does not perform the DFS scan.

The process for a radio to detect and identify a radar signal is a complicated task that sometimes leads to incorrect detects. Incorrect radar detections can occur due to a large number of factors, including due to uncertainties of the RF environment and the ability of the access point to reliably detect actual on-channel radar.
The 802.11h standard addresses DFS and Transmit Power Control (TPC) as it relates to the 5-GHz band. Use DFS to avoid interference with radar and TPC to avoid interference with satellite feeder links.

Figure 3: DFS and TPC Band Requirements

<table>
<thead>
<tr>
<th>Frequency (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

Antennas

Overview

Antenna choice is a vital component of any wireless network deployment. There are two broad types of antennas:

- Directional
- Omnidirectional

Each type of antenna has a specific use and is most beneficial in specific types of deployments. Because antennas distribute RF signal in large lobed coverage areas determined by antenna design, successful coverage is heavily reliant on antenna choice.

An antenna gives a mesh access point three fundamental properties: gain, directivity, and polarization:

- Gain—A measure of the increase in power. Gain is the amount of increase in energy that an antenna adds to an RF signal.
- Directivity—The shape of the transmission pattern. If the gain of the antenna increases, the coverage area decreases. The coverage area or radiation pattern is measured in degrees. These angles are measured in degrees and are called beam-widths.

Note

Beamwidth is defined as a measure of the ability of an antenna to focus radio signal energy toward a particular direction in space. Beamwidth is usually expressed in degrees HB (Horizontal Beamwidth); usually, the most important one is expressed in a VB (Vertical Beamwidth) (up and down) radiation pattern. When viewing an antenna plot or pattern, the angle is usually measured at half-power (3 dB) points of the main lobe when referenced to the peak effective radiated power of the main lobe.
An 8-dBi antenna transmits with a horizontal beamwidth of 360 degrees, causing the radio waves to disperse power in all directions. Therefore, radio waves from an 8-dBi antenna do not go nearly as far as those radio waves sent from a 14-dBi patch antenna (or a third-party dish) that has a more narrow beamwidth (less than 360 degrees).

**Note**

- Polarization—The orientation of the electric field of the electromagnetic wave through space. Antennas can be polarized either horizontally or vertically, though other kinds of polarization are available. Both antennas in a link must have the same polarization to avoid an additional unwanted loss of signal. To improve the performance, an antenna can sometimes be rotated to alter polarization, which reduces interference. A vertical polarization is preferable for sending RF waves down concrete canyons, and horizontal polarization is generally more preferable for wide area distribution. Polarization can also be harnessed to optimize for RF bleed-over when reducing RF energy to adjacent structures is important. Most omnidirectional antennas ship with vertical polarization as their default.

**Antenna Options**

A wide variety of antennas are available to provide flexibility when you deploy the mesh access points over various terrains. Refer to the applicable access point data sheet or ordering guide for a list of supported antennas.


**Client Access Certified Antennas (Third-Party Antennas)**

You can use third-party antennas with AP1500s. However, note the following:

- Cisco does not track or maintain information about the quality, performance, or reliability of the noncertified antennas and cables.
- RF connectivity and compliance is the customer’s responsibility.
- Compliance is only guaranteed with Cisco antennas or antennas that are of the same design and gain as Cisco antennas.
- Cisco Technical Assistance Center (TAC) has no training or customer history with regard to non Cisco antennas and cables.

**Cisco Wireless LAN Controllers**

The wireless mesh solution is supported on Cisco 2500, 3504, 5500, and 8500 Series Wireless LAN Controllers.

Cisco Prime Infrastructure

The Cisco Prime Infrastructure provides a graphical platform for wireless mesh planning, configuration, and management. Network managers can use the Prime Infrastructure to design, control, and monitor wireless mesh networks from a central location.

With the Prime Infrastructure, network administrators have a solution for RF prediction, policy provisioning, network optimization, troubleshooting, user tracking, security monitoring, and wireless LAN systems management. Graphical interfaces make wireless LAN deployment and operations simple and cost-effective. Detailed trending and analysis reports make the Prime Infrastructure vital to ongoing network operations.

The Prime Infrastructure runs on a server platform with an embedded database, which provides scalability that allows hundreds of controllers and thousands of Cisco mesh access points to be managed. Controllers can be located on the same LAN as the Prime Infrastructure, on separate routed subnets, or across a wide-area connection.

Architecture

Control and Provisioning of Wireless Access Points

Control and provisioning of wireless access points (CAPWAP) is the provisioning and control protocol used by the controller to manage access points (mesh and nonmesh) in the network.

CAPWAP Discovery on a Mesh Network

The process for CAPWAP discovery on a mesh network is as follows:

1. A mesh access point establishes a link before starting CAPWAP discovery, whereas a non mesh access point starts CAPWAP discovery using a static IP for the mesh access point, if any.

2. The mesh access point initiates CAPWAP discovery using a static IP for the mesh access point on the Layer 3 network or searches the network for its assigned primary, secondary, or tertiary controller. A maximum of 10 attempts are made to connect.

Note

The mesh access point searches a list of controllers configured on the access point (primed) during setup.

3. If Step 2 fails after 10 attempts, the mesh access point falls back to DHCP and attempts to connect in 10 tries.

4. If both Steps 2 and 3 fail and there is no successful CAPWAP connection to a controller.

5. If there is no discovery after attempting Steps 2, 3, and 4, the mesh access point tries the next link.

Dynamic MTU Detection

If the MTU is changed in the network, the access point detects the new MTU value and forwards that to the controller to adjust to the new MTU. After both the access point and the controller are set at the new MTU,
all data within their path are fragmented into the new MTU. The new MTU size is used until it is changed. The default MTU on switches and routers is 1500 bytes.

**Adaptive Wireless Path Protocol**

The Adaptive Wireless Path Protocol (AWPP) is designed specifically for wireless mesh networking to provide ease of deployment, fast convergence, and minimal resource consumption.

AWPP takes advantage of the CAPWAP WLAN, where client traffic is tunneled to the controller and is therefore hidden from the AWPP process. Also, the advance radio management features in the CAPWAP WLAN solution are available to the wireless mesh network and do not have to be built into AWPP.

AWPP enables a remote access point to dynamically find the best path back to a RAP for each MAP that is part of the RAP's bridge group (BGN). Unlike traditional routing protocols, AWPP takes RF details into account.

To optimize the route, a MAP actively solicits neighbor MAP. During the solicitation, the MAP learns all of the available neighbors back to a RAP, determines which neighbor offers the best path, and then synchronizes with that neighbor. The path decisions of AWPP are based on the link quality and the number of hops.

AWPP automatically determines the best path back to the CAPWAP controller by calculating the cost of each path in terms of the signal strength and number of hops. After the path is established, AWPP continuously monitors conditions and changes routes to reflect changes in conditions. AWPP also performs a smoothing function to signal condition information to ensure that the ephemeral nature of RF environments does not impact network stability.

**Traffic Flow**

The traffic flow within the wireless mesh can be divided into three components:

1. Overlay CAPWAP traffic that flows within a standard CAPWAP access point deployment; that is, CAPWAP traffic between the CAPWAP access point and the CAPWAP controller.
2. Wireless mesh data frame flow.
3. AWPP exchanges.

As the CAPWAP model is well known and the AWPP is a proprietary protocol, only the wireless mesh data flow is described. The key to the wireless mesh data flow is the address fields of the 802.11 frames being sent between mesh access points.

An 802.11 data frame can use up to four address fields: receiver, transmitter, destination, and source. The standard frame from a WLAN client to an AP uses only three of these address fields because the transmitter address and the source address are the same. However, in a WLAN bridging network, all four address fields are used because the source of the frame might not be the transmitter of the frame, because the frame might have been generated by a device behind the transmitter.
Figure 4: Wireless Mesh Frame, on page 12 shows an example of this type of framing. The source address of the frame is MAP:03:70, the destination address of this frame is the controller (the mesh network is operating in Layer 2 mode), the transmitter address is MAP:D5:60, and the receiver address is RAP:03:40.

As this frame is sent, the transmitter and receiver addresses change on a hop-by-hop basis. AWPP is used to determine the receiver address at each hop. The transmitter address is known because it is the current mesh access point. The source and destination addresses are the same over the entire path.

If the RAP's controller connection is Layer 3, the destination address for the frame is the default gateway MAC address, because the MAP has already encapsulated the CAPWAP in the IP packet to send it to the controller, and is using the standard IP behavior of using ARP to find the MAC address of the default gateway.

Each mesh access point within the mesh forms an CAPWAP session with a controller. WLAN traffic is encapsulated inside CAPWAP and is mapped to a VLAN interface on the controller. Bridged Ethernet traffic can be passed from each Ethernet interface on the mesh network and does not have to be mapped to an interface on the controller (see Figure 5: Logical Bridge and WLAN Mapping, on page 12).

Mesh Neighbors, Parents, and Children

Relationships among mesh access points are as a parent, child, or neighbor (see Figure 6: Parent, Child, and Neighbor Access Points, on page 13).

- A parent access point offers the best route back to the RAP based on its ease values. A parent can be either the RAP itself or another MAP.
  - Ease is calculated using the SNR and link hop value of each neighbor. Given multiple choices, generally an access point with a higher ease value is selected.
A child access point selects the parent access point as its best route back to the RAP.

A neighbor access point is within RF range of another access point but is not selected as its parent or a child because its ease values are lower than that of the parent.

**Figure 6: Parent, Child, and Neighbor Access Points**

---

**Criteria to Choose the Best Parent**

AWPP follows this process in selecting parents for a RAP or MAP with a radio backhaul:

- A list of channels with neighbors is generated by passive scanning in the `scan` state, which is a subset of all backhaul channels.
- The channels with neighbors are sought by actively scanning in the `seek` state and the backhaul channel is changed to the channel with the best neighbor.
- The parent is set to the best neighbor and the parent-child handshake is completed in the `seek` state.
- Parent maintenance and optimization occurs in the `maintain` state.

This algorithm is run at startup and whenever a parent is lost and no other potential parent exists, and is usually followed by CAPWAP network and controller discovery. All neighbor protocol frames carry the channel information.

Parent maintenance occurs by the child node sending a directed NEIGHBOR_REQUEST to the parent and the parent responding with a NEIGHBOR_RESPONSE.

Parent optimization and refresh occurs by the child node sending a NEIGHBOR_REQUEST broadcast on the same channel on which its parent resides, and by evaluating all responses from neighboring nodes on the channel.

A parent mesh access point provides the best path back to a RAP. AWPP uses ease to determine the best path. Ease can be considered the opposite of cost, and the preferred path is the path with the higher ease.

**Ease Calculation**

Ease is calculated using the SNR and hop value of each neighbor, and applying a multiplier based on various SNR thresholds. The purpose of this multiplier is to apply a spreading function to the SNRs that reflects various link qualities.
Figure 7: Parent Path Selection, on page 14 shows the parent path selection where MAP2 prefers the path through MAP1 because the adjusted ease value (436906) though this path is greater then the ease value (262144) of the direct path from MAP2 to RAP.

**Figure 7: Parent Path Selection**

![Diagram of parent path selection](image)

**Parent Decision**

A parent mesh access point is chosen by using the adjusted ease, which is the ease of each neighbor divided by the number of hops to the RAP:

\[
\text{adjusted ease} = \min (\text{ease at each hop}) / \text{Hop count}
\]

**SNR Smoothing**

One of the challenges in WLAN routing is the ephemeral nature of RF, which must be considered when analyzing an optimal path and deciding when a change in path is required. The SNR on a given RF link can change substantially from moment to moment, and changing route paths based on these fluctuations results in an unstable network, with severely degraded performance. To effectively capture the underlying SNR but remove moment-to-moment fluctuations, a smoothing function is applied that provides an adjusted SNR.

In evaluating potential neighbors against the current parent, the parent is given 20 percent of bonus-ease on top of the parent’s calculated ease, to reduce the ping-pong effect between parents. A potential parent must be significantly better for a child to make a switch. Parent switching is transparent to CAPWAP and other higher-layer functions.

**Loop Prevention**

To ensure that routing loops are not created, AWPP discards any route that contains its own MAC address. That is, routing information apart from hop information contains the MAC address of each hop to the RAP; therefore, a mesh access point can easily detect and discard routes that loop.
Mesh Deployment Modes

This chapter describes the mesh deployment modes and contains the following sections:

- Wireless Mesh Network, page 15
- Wireless Backhaul, page 15
- Point-to-Multipoint Wireless Bridging, page 16
- Point-to-Point Wireless Bridging, page 17

Wireless Mesh Network

In a Cisco wireless outdoor mesh network, multiple mesh access points comprise a network that provides secure, scalable outdoor wireless LAN.

The three RAPs are connected to the wired network at each location and are located on the building roof. All the downstream access points operate as MAPs and communicate using wireless links (not shown).

Both MAPs and RAPs can provide WLAN client access; however, the location of RAPs are often not suitable for providing client access. All the three access points in are located on the building roofs and are functioning as RAPs. These RAPs are connected to the network at each location.

Some of the buildings have onsite controllers to terminate CAPWAP sessions from the mesh access points but it is not a mandatory requirement because CAPWAP sessions can be back hauled to a controller over a wide-area network (WAN).

Note

CAPWAP over CAPWAP is not supported. AP in local mode connected on the RAP or MAP ethernet port is not a supported configuration.

Wireless Backhaul

In a Cisco wireless backhaul network, traffic can be bridged between MAPs and RAPs. This traffic can be from wired devices that are being bridged by the wireless mesh or CAPWAP traffic from the mesh access points. This traffic is always AES encrypted when it crosses a wireless mesh link such as a wireless backhaul.
AES encryption is established as part of the mesh access point neighbor relationship with other mesh access points. The encryption keys used between mesh access points are derived during the EAP authentication process.

**Universal Access**

You can configure the backhaul on mesh access points to accept client traffic over its 802.11a radio. This feature is identified as Backhaul Client Access in the controller GUI (Monitor > Wireless). When this feature is disabled, backhaul traffic is transmitted only over the 802.11a or 802.11a/n radio and client association is allowed only over the 802.11b/g or 802.11b/g/n radio. For more information about the configuration, see the Configuring Advanced Features.

**Note**

In rel 8.2 and higher the backhaul is also supported on 2.4 GHz.

**Point-to-Multipoint Wireless Bridging**

In the point-to-multipoint bridging scenario, a RAP acting as a root bridge connects multiple MAPs as non-root bridges with their associated wired LANs. By default, this feature is disabled for all MAPs. If Ethernet bridging is used, you must enable it on the controller for the respective MAP and for the RAP.

This figure shows a simple deployment with one RAP and two MAPs, but this configuration is fundamentally a wireless mesh with no WLAN clients. Client access can still be provided with Ethernet bridging enabled, although if bridging between buildings, MAP coverage from a high rooftop might not be suitable for client access.

*Figure 8: Point-to-Multipoint Bridging Example*
Point-to-Point Wireless Bridging

In a point-to-point bridging scenario, a 1500 Series Mesh AP can be used to extend a remote network by using the backhaul radio to bridge two segments of a switched network. This is fundamentally a wireless mesh network with one MAP and no WLAN clients. Just as in point-to-multipoint networks, client access can still be provided with Ethernet bridging enabled, although if bridging between buildings, MAP coverage from a high rooftop might not be suitable for client access.

If you intend to use an Ethernet bridged application, we recommend that you enable the bridging feature on the RAP and on all MAPs in that segment. You must verify that any attached switches to the Ethernet ports of your MAPs are not using VLAN Trunking Protocol (VTP). VTP can reconfigure the trunked VLANs across your mesh and possibly cause a loss in connection for your RAP to its primary WLC. An incorrect configuration can take down your mesh deployment.

Figure 9: Point-to-Point Bridging Example

For security reasons the Ethernet port on the MAPs is disabled by default. It can be enabled only by configuring Ethernet bridging on the Root and the respective MAPs. To enable Ethernet bridging using the controller GUI, choose Wireless > All APs > Details for the AP page, click the Mesh tab, and then select the Ethernet Bridging check box.

Note: The overall throughput of backhaul radio decreases by half for each hop of a mesh tree. When the Ethernet-bridged clients are used in MAPs and heavy traffic is passed, it may result in a high throughput consumption, which may cause the downlink MAPs to disassociate from the network due to throughput starvation.

Ethernet bridging has to be enabled for the following two scenarios:

When you want to use the mesh nodes as bridges.

When you want to connect Ethernet devices such as a video camera on the MAP using its Ethernet port.

Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in question to the controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must also enable Ethernet bridging on MAP1 (parent MAP), and on the RAP connecting to the controller.

To configure range parameters for longer links, choose Wireless > Mesh. Optimum distance (in feet) should exist between the root access point (RAP) and the farthest mesh access point (MAP). Range from the RAP bridge to the MAP bridge has to be mentioned in feet.

The following global parameter applies to all mesh access points when they join the controller and all existing mesh access points in the network:

Range: 150 to 132,000 feet
Configuring Mesh Range (CLI)

- To configure the distance between the nodes doing the bridging, enter the `config mesh range` command. APs reboot after you specify the range.

**Note**

To estimate the range and the AP density, you can use range calculators that are available at:

Range Calculator for all access points: [http://173.37.206.125/aspnet_client/system_web/2_0_50727/WNG_Coverage_Capacity_Calculator_V2.0_HTML/WNG_Coverage_Capacity_Calculator_V2.0.htm](http://173.37.206.125/aspnet_client/system_web/2_0_50727/WNG_Coverage_Capacity_Calculator_V2.0_HTML/WNG_Coverage_Capacity_Calculator_V2.0.htm)

- To view the mesh range, enter the `show mesh config` command.
Design Considerations

This chapter describes important design considerations and provides an example of a wireless mesh design. Each outdoor wireless mesh deployment is unique, and each environment has its own challenges with available locations, obstructions, and available network infrastructure. Design requirements driven by expected users, traffic, and availability needs are also major design criteria. This chapter contains the following sections:

- Wireless Mesh Constraints, page 19
- Controller Planning, page 23

Wireless Mesh Constraints

The following are a few system characteristics to consider when you design and build a wireless mesh network. Some of these characteristics apply to the backhaul network design and others to the CAPWAP controller design:

Wireless Backhaul Data Rate

Backhaul is used to create only the wireless connection between the access points. The backhaul interface is 802.11a/n/ac/g depending upon the access point. The rate selection is important for effective use of the available RF spectrum. The rate can also affect the throughput of client devices, and throughput is an important metric used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in inferior products, and the potential for catastrophic network congestion and collapse.

Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can extend farther from the access point than can higher data rates, for example 1300 Mbps. As a result, the data rate affects cell coverage and consequently the number of access points required. Different data rates are achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time than sending the equivalent data at a higher bit rate, resulting in reduced throughput.
A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and interconnection.

Note

The data rate can be set on the backhaul on a per AP basis. It is not a global command.

The required minimum LinkSNR for backhaul links per data rate is shown in Table 1.

Table 1: Backhaul Data Rates and Minimum LinkSNR Requirements

<table>
<thead>
<tr>
<th>802.11a Data Rate (Mbps)</th>
<th>Minimum Required LinkSNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>54</td>
<td>31</td>
</tr>
<tr>
<td>48</td>
<td>29</td>
</tr>
<tr>
<td>36</td>
<td>26</td>
</tr>
<tr>
<td>24</td>
<td>22</td>
</tr>
<tr>
<td>18</td>
<td>18</td>
</tr>
<tr>
<td>12</td>
<td>16</td>
</tr>
<tr>
<td>9</td>
<td>15</td>
</tr>
<tr>
<td>6</td>
<td>14</td>
</tr>
</tbody>
</table>

- The required minimum LinkSNR value is driven by the data rate and the following formula: \( \text{Minimum SNR} + \text{fade margin} \).

Table 2 summarizes the calculation by data rate.

- Minimum SNR refers to an ideal state of noninterference, nonnoise, and a system packet error rate (PER) of no more than 10 percent.
- Typical fade margin is approximately 9 to 10 dB.

Minimum Required LinkSNR Calculations by Data Rate

Table 2: Backhaul Data Rates and Minimum LinkSNR Requirements for 802.11n

<table>
<thead>
<tr>
<th>802.11n Date Rate (Mbps)</th>
<th>Spatial Stream</th>
<th>Minimum Required LinkSNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>15</td>
<td>1</td>
<td>9.3</td>
</tr>
<tr>
<td>30</td>
<td>1</td>
<td>11.3</td>
</tr>
<tr>
<td>45</td>
<td>1</td>
<td>13.3</td>
</tr>
</tbody>
</table>
If we take into account the effect of MRC for calculating Minimum Required Link SNR. Table 3 shows the required LinkSNR for 802.11a/g (2.4 GHz and 5 GHz) for AP1552 and 1522 with 3 Rx antennas (MRC gain).

\[
\text{LinkSNR} = \text{Minimum SNR} - \text{MRC} + \text{Fade Margin} (9 \text{ dB})
\]

**Table 3: Required Link SNR Calculations for 802.11a/g**

<table>
<thead>
<tr>
<th>802.11a/g MCS (Mbps)</th>
<th>Modulation</th>
<th>Minimum SNR (dB)</th>
<th>MRC Gain from 3 RXs (dB)</th>
<th>Fade Margin (dB)</th>
<th>Required Link SNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>4.7</td>
<td>9</td>
<td>9.3</td>
</tr>
<tr>
<td>9</td>
<td>BPSK 3/4</td>
<td>6</td>
<td>4.7</td>
<td>9</td>
<td>10.3</td>
</tr>
<tr>
<td>12</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>4.7</td>
<td>9</td>
<td>11.3</td>
</tr>
<tr>
<td>18</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>4.7</td>
<td>9</td>
<td>13.3</td>
</tr>
<tr>
<td>24</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>4.7</td>
<td>9</td>
<td>17.3</td>
</tr>
<tr>
<td>36</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>4.7</td>
<td>9</td>
<td>21.3</td>
</tr>
</tbody>
</table>
If we consider only 802.11n rates, then Table 4 shows LinkSNR requirements with AP1552 for 2.4 and 5 GHz.

**Table 4: Requirements for LinkSNR with AP1552 for 2.4 and 5 GHz**

<table>
<thead>
<tr>
<th>No. of Spatial Streams</th>
<th>11n MCS</th>
<th>Modulation</th>
<th>Minimum SNR (dB)</th>
<th>MRC Gain from 3 RXs (dB)</th>
<th>Fade Margin (dB)</th>
<th>Link SNR (dB)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>MCS 0</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>4.7</td>
<td>9</td>
<td>9.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 1</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>4.7</td>
<td>9</td>
<td>11.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 2</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>4.7</td>
<td>9</td>
<td>13.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 3</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>4.7</td>
<td>9</td>
<td>17.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 4</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>4.7</td>
<td>9</td>
<td>21.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 5</td>
<td>64QAM 2/3</td>
<td>20</td>
<td>4.7</td>
<td>9</td>
<td>24.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 6</td>
<td>64QAM 3/4</td>
<td>22</td>
<td>4.7</td>
<td>9</td>
<td>26.3</td>
</tr>
<tr>
<td>1</td>
<td>MCS 7</td>
<td>64QAM 5/6</td>
<td>23</td>
<td>4.7</td>
<td>9</td>
<td>27.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 8</td>
<td>BPSK 1/2</td>
<td>5</td>
<td>1.7</td>
<td>9</td>
<td>12.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 9</td>
<td>QPSK 1/2</td>
<td>7</td>
<td>1.7</td>
<td>9</td>
<td>14.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 10</td>
<td>QPSK 3/4</td>
<td>9</td>
<td>1.7</td>
<td>9</td>
<td>16.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 11</td>
<td>16QAM 1/2</td>
<td>13</td>
<td>1.7</td>
<td>9</td>
<td>20.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 12</td>
<td>16QAM 3/4</td>
<td>17</td>
<td>1.7</td>
<td>9</td>
<td>24.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 13</td>
<td>64QAM 2/3</td>
<td>20</td>
<td>1.7</td>
<td>9</td>
<td>27.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 14</td>
<td>64QAM 3/4</td>
<td>22</td>
<td>1.7</td>
<td>9</td>
<td>29.3</td>
</tr>
<tr>
<td>2</td>
<td>MCS 15</td>
<td>64QAM 5/6</td>
<td>23</td>
<td>1.7</td>
<td>9</td>
<td>30.3</td>
</tr>
</tbody>
</table>
With two spatial streams, the MRC gain is halved, that is the MRC gain is reduced by 3 dB. This is because the system has \(10 \log (3/2 \text{ SS})\) instead of \(10 \log (3/1 \text{ SS})\). If there were to have been 3 SS with 3 RX, then the MRC gain would have been zero.

- Number of backhaul hops is limited to eight but we recommend three to four hops.

  The number of hops is recommended to be limited to three or four primarily to maintain sufficient backhaul throughput, because each mesh access point uses the same radio for transmission and reception of backhaul traffic, which means that throughput is approximately halved over every hop. For example, the maximum throughput for 24 Mbps is approximately 14 Mbps for the first hop, 9 Mbps for the second hop, and 4 Mbps for the third hop.

- Number of MAPs per RAP.

  There is no current software limitation on how many MAPs per RAP you can configure. However, it is suggested that you limit the number to 20 MAPs per RAP.

- Number of controllers

  - The number of controllers per mobility group is limited to 72.

- Number of mesh access points supported per controller.

## Controller Planning

The following items affect the number of controllers required in a mesh network:

- Mesh access points (RAPs and MAPs) in the network.

  The wired network that connects the RAP and controllers can affect the total number of access points supported in the network. If this network allows the controllers to be equally available to all access points without any impact on WLAN performance, the access points can be evenly distributed across all controllers for maximum efficiency. If this is not the case, and controllers are grouped into various clusters or PoPs, the overall number of access points and coverage are reduced.

- Number of mesh access points (RAPs and MAPs) supported per controller. See Table 1.

  For clarity, nonmesh access points are referred to as local access points in this document.

### Table 5: Mesh Access Point Support by Controller Model

<table>
<thead>
<tr>
<th>Controller Model</th>
<th>Local AP Support (nonmesh)</th>
<th>Maximum Possible Mesh AP Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>5505</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>2504</td>
<td>75</td>
<td>75</td>
</tr>
<tr>
<td>WiSM2</td>
<td>500</td>
<td>500</td>
</tr>
<tr>
<td>5520</td>
<td>1500</td>
<td>1500</td>
</tr>
</tbody>
</table>
**Controller Planning**

<table>
<thead>
<tr>
<th>Controller Model</th>
<th>Local AP Support (nonmesh)</th>
<th>Maximum Possible Mesh AP Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>8540</td>
<td>6000</td>
<td>6000</td>
</tr>
</tbody>
</table>

1 Local AP support is the total number of nonmesh APs supported on the controller model.
2 For 5508, controllers, the number of MAPs is equal to (local AP support - number of RAPs).
3 For 2504, controllers, the number of MAPs is equal to (local AP support - number of RAPs).


---

**Note**

Mesh is fully supported on Cisco 5508 Controllers. The Base License (LIC-CT508-Base) is sufficient for indoor and outdoor APs. The WPlus License (LIC-WPLUS-SW) is merged with the base license. The WPlus License is not required for indoor mesh APs.
Air Time Fairness in Mesh Deployments rel 8.4

This section of the document introduces the ATF on Mesh APs and provides guidelines for its deployment. The purpose of this section is to:

- Provide an overview of ATF on Mesh APs
- Highlight supported Key Features
- Provide details on deploying and managing the ATF on Mesh APs

Pre-requisite and Supported Features in 8.4 release

Mesh ATF is supported on AireOS 8.4 or higher release on a Wireless LAN Controller. Mesh ATF is supported on 1550/128, 1570 and all other IOS based APs.

<table>
<thead>
<tr>
<th>AP Feature</th>
<th>1550 (64 MB)</th>
<th>1550 (128 MB)</th>
<th>1570</th>
<th>3700</th>
<th>1530</th>
<th>1540</th>
<th>1560</th>
</tr>
</thead>
<tbody>
<tr>
<td>Feature</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Basic Mesh</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>8.4</td>
</tr>
<tr>
<td>Flex+Mesh</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Fast Convergence (background scanning)</td>
<td>No</td>
<td>8.3</td>
<td>8.3</td>
<td>Yes</td>
<td>8.3</td>
<td>No</td>
<td>8.4</td>
</tr>
<tr>
<td>Wired Clients on RAP</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>
Cisco Air Time Fairness (ATF) Use Cases

Public Hotspots (Stadium/Airport/Convention Center/Other)
In this instance a public network is sharing a WLAN between two (or more) service providers and the venue. Subscribers to each service provider can be grouped and each group can be allocated a certain percentage of airtime.

Education
In this instance, a university is sharing a WLAN between students, faculty, and guests. The guest network can be further partitioned by service provider. Each group can be assigned a certain percentage of airtime.

Enterprise or Hospitality or Retail
In this instance, the venue is sharing a WLAN between employees and guests. The guest network can be further partitioned by service provider. The guests could be sub-grouped by tier of service type with each subgroup being assigned a certain percentage of airtime, for example a paid group is entitled to more airtime than the free group.

Time Shared Managed Hotspot
In this instance, the business entity managing the hotspot, such as a service provider or an enterprise, can allocate and subsequently lease airtime to other business entities.

ATF Functionality and Capabilities

ATF Functionality and Capabilities:

• ATF policies are applied only in the downlink direction (AP transmitting frames to client). Only airtime in the downlink direction, that is AP to client, can be controlled accurately by the AP. Although airtime in the uplink direction, that is client to AP, can be measured, it cannot be strictly controlled. Although the AP can constrain airtime for packets that it sends to clients, the AP can only measure airtime for packets that it 'hears' from clients because it cannot strictly limit their airtime.
- ATF policies are applied only on wireless data frames; management and control frames get ignored.
- When ATF is configured per-SSID, each SSID is granted airtime according to the configured policy.
- ATF can be configured to either drop or defer frames that exceed their airtime policies. If the frame is deferred, it will be buffered and transmit at some point in the future when the offending SSID has a sufficient airtime budget. Of course, there is a limit as to how many frames can be buffered. If this limit is crossed, frames will be dropped regardless.
- ATF can be globally enabled or disabled.
- ATF can be enabled or disabled on an individual access point, AP group or entire network.
- Allocation is applied Per SSID and Per Client.
- Applies to Downstream only.
- Can be configured in WLC GUI/CLI and PI.
- Can be applied to all APs on a Network to AP Group or one AP.
- Supported on APs in Local mode: AP1260, 1550-128Mb, 1570, 1700, 2600, 2700, 3500, 3600, 3700.

**ATF on Mesh Feature Overview**

AirTime Fairness on Mesh Aps feature is very close conceptually to the ATF feature support release for Local Aps in the previous releases. We are strongly recommend to review that feature and deployment steps in the guide at [http://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Air_Time_Fairness_Phase1_and_Phase2_Deployment_Guide.html](http://www.cisco.com/c/en/us/td/docs/wireless/technology/mesh/8-2/b_Air_Time_Fairness_Phase1_and_Phase2_Deployment_Guide.html).

At the present time, enterprise class, high density stadium and other major Wi-Fi deployments with Cisco IOS 11n, 11ac Indoor APs are benefited by "per SSID" based Airtime Fairness and "per Client within a SSID" based Airtime Fairness through 8.1 MR1 and 8.2 releases.
In a same way, currently, there is a demand from the Customers with large scale Outdoor wireless mesh deployments to serve their users by providing fairness among the Wi-Fi users across the Outdoor wireless mesh network in utilizing the AP radio Airtime downstream and also provide administrators the key control to enforce SLA (implied on multiple cellular operator through Wi-Fi hotspot) on the Wi-Fi users across the Outdoor wireless mesh network. However, since all Wi-Fi users traffic is bridged between MAPs and RAPs through the wireless backhaul radio and there is no SSID concept on wireless backhaul radio for backhaul nodes to enforce policies through SSID's for each backhaul node, there is no easy solution for Wi-Fi users across the Outdoor wireless mesh network to get treated fairly in terms of utilizing the Wi-Fi airtime through their Outdoor Wireless Mesh Aps. As far as the clients on client access radios are concerned, it's fairly simple to regulate the airtime fairness through SSIDs (w/ o/w client fair sharing) in a similar way how it is done for Cisco unified local mode APs.

Before the solution overview of supporting ATF on mesh, lets quickly recap ATF - Airtime Fairness (ATF) is basically a concept which provides an ability to regulate/enforce the AP radio airtime in downstream direction for the clients associated through the SSID's. As a result, the Wi-Fi users on wireless network are fairly treated in terms of utilizing the radio WiFi radio airtime. This basically provides the key control either to enforce SLA additionally or simply to avoid certain group or individual from occupying an unfair amount of WiFi airtime on a particular or on a given AP radio. A service level agreement (SLA) is a contract between a service provider (either internal or external) and the end user that defines the level of service expected from the service provider. SLAs are output-based in that their purpose is specifically to define what the customer will receive.

In general, in the Mesh architecture, the Mesh Aps (Parents, child MAPs) in a Mesh Tree will be accessing the same channel (let's forget about extended sub-backhaul radios for a minute) on backhaul radio for mesh connectivity between Parents and child Maps. Whereas, the Root AP will be connected wired to the controller and MAPs will be connected wireless to the controller. Hence all the CAPWAP, Wi-Fi traffic will be bridged to the controller through the wireless backhaul radio and through RAP. In terms of the physical locations, normally the RAPs will be placed at roof top and the MAPs in multiple hops will be placed some distance apart within each other based on the Mesh network segmentation guidelines. Hence each MAP in a Mesh tree can provide 100% of their own radio airtime downstream to their users though each MAP accessing the same medium. To compare this in non-mesh scenario, where there can be neighboring local mode unified Aps in the arena next to each other in different rooms serving to their respective clients on the same channel with each providing 100% radio airtime downstream. Therefore, ATF has no control over enforcing clients in two different neighboring AP's accessing the same medium. Similarly, it's applicable for MAPs in a Mesh tree. For Outdoor/Indoor Mesh Aps, Airtime fairness must be supported on client access radios which serve regular clients as same as how we currently support ATF on non-mesh unified local mode Aps to serve the clients and additionally it must also be supported on backhaul radios which bridge the traffic to/from the clients on client access radios to RAPs (one hop) or through MAPs to RAPs (multiple hops). Its bit tricky to support ATF on backhaul radio’s using the same SSID/Policy/Weight/Client fair sharing model. Since backhaul radio’s doesn't have SSIDs and it always bridges traffic through their hidden backhaul nodes. Henceforth, on the backhaul radios either in RAP or MAP, the radio airtime downstream will be fair shared equally based on the number of backhaul nodes. This approach eliminates the problem and provides fairness to users across wireless mesh network in the case where the clients associated to 2nd hop MAP can stall the clients associated to 1st hop MAP where 2nd hop MAP is connected wireless to 1st hop MAP through backhaul radio though the Wi-Fi users in the MAPs are separated by a physical location. In the scenario, when a backhaul radio has an option to serve normal clients through universal client access feature, ATF considers the regular clients into single node and group them into it. It enforces the Airtime by equally fair sharing the radio airtime downstream based on the number of nodes (backhaul nodes + single node for regular clients). We will see more details how this solution is turned into design in the next sections.
A bigger mesh design will looks like this:
**ATF Modes of Operation**

The Framework behind the ATF monitor mode is to allow the user to view and get the stats of overall Air Time being used i.e. to report the Air Time usage for all the AP transmissions. The ATF in monitor mode can be enabled on following levels.

- **Disable Mode**: By default ATF is disabled on the WLC
- **Monitor Mode**: To monitor airtime usage on your network
- **Enforce—Policy Mode**: Assigning ATF policies on your network
- **Strict Enforcement**
- **Optimized**

**Configuring ATF on Mesh**

To configure, ATF on mesh, perform the following steps:

**Step 1**
Backhaul Client Access- enable/disable.

```
(5520-MA1) >config mesh client-access enable
```
### Configuring ATF on Mesh

#### Step 2

RAP Downlink Backhaul configure 5 or 2.4 GHz

```bash
(5520-MA1) > config mesh backhaul slot <0/1> all
```
Step 3  Create ATF Policy with Weight and Client Sharing

(5520-MA1) >config atf 802.11a mode ?

disable        Disables ATF
enforce-policy Configures ATF in enforcement mode
monitor        Configures ATF in monitor mode

(5520-MA1) >config atf 802.11a mode enforce-policy

(5520-MA1) >config atf policy create 1 mesh 25 client-sharing enable
Step 4  Configure Enforcement mode per AP/AP Group/Network with Enforcement type and WLAN and Policy applied.

Figure 10:

(5520-MA1) > config atf 802.11a optimization enable
Step 5 Configure Mesh Universal Access Client Airtime Allocation.

> config ap atf 802.11a client-access airtime-allocation <5 - 90> <ap-name> override enable/disable
> config ap atf 802.11b client-access airtime-allocation <5 - 90> <ap-name> override enable/disable
### Configuring ATF on Mesh

#### Mesh Universal Access Client Airtime Allocation

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Radio Type</th>
<th>No of Nodes</th>
<th>Default % Alloc Per Node</th>
<th>Current % Allocation on Client Access Node</th>
<th>Current % Allocation on Backhaul Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>v51_mp1_ap1072</td>
<td>802.11a</td>
<td>10</td>
<td>0</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>v51_mp2_ap3700</td>
<td>802.11b</td>
<td>0</td>
<td>100</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>v51_mp3_ap7000</td>
<td>802.11b</td>
<td>0</td>
<td>100</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>v51_mp2b_ap3700</td>
<td>802.11b</td>
<td>0</td>
<td>100</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>v51_mp3b_ap3700</td>
<td>802.11b</td>
<td>0</td>
<td>100</td>
<td>NA</td>
<td>NA</td>
</tr>
</tbody>
</table>
Site Preparation and Planning

This chapter describes the site preparation and planning for your mesh network and contains the following sections:

- Site Survey, page 37
- Wireless Mesh Network Coverage Considerations, page 44
- Indoor Mesh Interoperability with Outdoor Mesh, page 78

Site Survey

We recommend that you perform a radio site survey before installing the equipment. A site survey reveals problems such as interference, Fresnel zone, or logistics problems. A proper site survey involves temporarily setting up mesh links and taking measurements to determine whether your antenna calculations are accurate. Determine the correct location and antenna before drilling holes, routing cables, and mounting equipment.

Note

When power is not readily available, we recommend you to use an unrestricted power supply (UPS) to temporarily power the mesh link.

Pre-Survey Checklist

Before attempting a site survey, determine the following:

- How long is your wireless link?
- Do you have a clear line of sight?
- What is the minimum acceptable data rate within which the link runs?
- Is this a point-to-point or point-to-multipoint link?
- Do you have the correct antenna?
- Can the access point installation area support the weight of the access point?
Outdoor Site Survey

Deploying WLAN systems outdoors requires a different skill set to indoor wireless deployments. Considerations such as weather extremes, lightning, physical security, and local regulations need to be taken into account.

When determining the suitability of a successful mesh link, define how far the mesh link is expected to transmit and at what radio data rate. Remember that the data rate is not directly included in the wireless routing calculation, and we recommend that the same data rate is used throughout the same mesh.

Design recommendations for mesh links are as follows:

- MAP deployment cannot exceed 35 feet in height above the street.
- MAPs are deployed with antennas pointed down toward the ground.
- Typical 5-GHz RAP-to-MAP distances are 1000 to 4000 feet.
- RAP locations are typically towers or tall buildings.
- Typical 5-GHz MAP-to-MAP distances are 500 to 1000 feet.
- MAP locations are typically short building tops or streetlights.
- Typical 2.4-GHz MAP-to-client distances are 500 to 1000 feet (depends upon the type of access point).
- Clients are typically laptops, Smart Phones, Tablets, and CPEs. Most of the clients operate in the 2.4-GHz band.
- In release 8.2 and above 2.4GHz radios can be used for backhaul and slightly longer distances can be achieved; however at the same time lower throughput is expected.

Determining a Line of Sight

When you determine the suitability of a successful link, you must define how far the link is expected to transmit and at what radio data rate. Very close links, one kilometer or less, are fairly easy to achieve assuming there is a clear line of sight (LOS)—a path with no obstructions.

Because mesh radio waves have very high frequency in the 5-GHz band, the radio wavelength is small; therefore, the radio waves do not travel as far as radio waves on lower frequencies, given the same amount of power. This higher frequency range makes the mesh ideal for unlicensed use because the radio waves do not travel far unless a high-gain antenna is used to tightly focus the radio waves in a given direction.
This high-gain antenna configuration is recommended only for connecting a RAP to the MAP. To optimize mesh behavior, omnidirectional antennas are used because mesh links are limited to one mile (1.6 km). The curvature of the earth does not impact line-of-sight calculations because the curvature of the earth changes every six miles (9.6 km).

Weather

In addition to free space path loss and line of sight, weather can also degrade a mesh link. Rain, snow, fog, and any high humidity condition can slightly obstruct or affect the line of sight, introducing a small loss (sometimes referred to as rain fade or fade margin), which has little effect on the mesh link. If you have established a stable mesh link, the weather should not be a problem; however, if the link is poor to begin with, bad weather can degrade performance or cause loss of link.

Ideally, you need a line of sight; a white-out snow storm does not allow a line of sight. Also, while storms may make the rain or snow itself appear to be the problem, many times it might be additional conditions caused by the adverse weather. For example, perhaps the antenna is on a mast pipe and the storm is blowing the mast pipe or antenna structure and that movement is causing the link to come and go, or there might be a large build-up of ice or snow on the antenna.

Fresnel Zone

A Fresnel zone is an imaginary ellipse around the visual line of sight between the transmitter and receiver. As radio signals travel through free space to their intended target, they could encounter an obstruction in the Fresnel area, degrading the signal. Best performance and range are attained when there is no obstruction of this Fresnel area. Fresnel zone, free space loss, antenna gain, cable loss, data rate, link distance, transmitter power, receiver sensitivity, and other variables play a role in determining how far your mesh link goes. Links can still occur as long as 60 percent to 70 percent of the Fresnel area is unobstructed, as illustrated in Figure 11: Point-to-Point Link Fresnel Zone, on page 39.

Figure 11: Point-to-Point Link Fresnel Zone
Figure 12: Typical Obstructions in a Fresnel Zone, on page 40 illustrates an obstructed Fresnel zone.

Figure 12: Typical Obstructions in a Fresnel Zone

It is possible to calculate the radius of the Fresnel zone (in feet) at any particular distance along the path using the following equation:

\[ F_1 = 72.6 \times \sqrt{\frac{d}{4 \times f}} \]

where

- \( F_1 \) = the first Fresnel zone radius in feet
- \( D \) = total path length in miles
- \( F \) = frequency (GHz)

Normally, 60 percent of the first Fresnel zone clearance is recommended, so the above formula for 60 percent Fresnel zone clearance can be expressed as follows:

\[ 0.60 \times F_1 = 43.3 \times \sqrt{\frac{d}{4 \times f}} \]

These calculations are based on a flat terrain.

Figure 13: Removing Obstructions in a Fresnel Zone, on page 40 shows the removal of an obstruction in the Fresnel zone of the wireless signal.

Figure 13: Removing Obstructions in a Fresnel Zone

Fresnel Zone Size in Wireless Mesh Deployments

To give an approximation of size of the maximum Fresnel zone to be considered, at a possible minimum frequency of 4.9 GHz, the minimum value changes depending on the regulatory domain. The minimum figure quoted is a possible band allocated for public safety in the USA, and a maximum distance of one mile gives a Fresnel zone of clearance requirement of 9.78 ft = 43.3 x SQR(1/(4*4.9)). This clearance is relatively easy to achieve in most situations. In most deployments, distances are expected to be less than one mile, and the
frequency greater than 4.9 GHz, making the Fresnel zone smaller. Every mesh deployment should consider the Fresnel zone as part of its design, but in most cases, it is not expected that meeting the Fresnel clearance requirement is an issue.

**Hidden Nodes Interference**

The mesh backhaul uses the same 802.11a channel for all nodes in that mesh, which can introduce hidden nodes into the WLAN backhaul environment.

Figure 14: Hidden Nodes

Figure 14: Hidden Nodes, on page 41 shows the following three MAPs:

- MAP X
- MAP Y
- MAP Z

If MAP X is the route back to the RAP for MAP Y and Z, both MAP X and MAP Z might be sending traffic to MAP Y at the same time. MAP Y can see traffic from both MAP X and Z, but MAP X and Z cannot see each other because of the RF environment, which means that the carrier sense multi-access (CSMA) mechanism does not stop MAP X and Z from transmitting during the same time window; if either of these frames is destined for a MAP, it is corrupted by the collision between frames and requires retransmission.

Although all WLANs at some time can expect some hidden node collisions, the fixed nature of the MAP makes hidden node collisions a persistent feature of the mesh WLAN backhaul under some traffic conditions such as heavy loads and large packet streams.

Both the hidden node problem and the exposed node problem are inherent to wireless mesh networks because mesh access points share the same backhaul channel. Because these two problems can affect the overall network performance, the Cisco mesh solution seeks to mitigate these two problems as much as possible. For example, the AP1500s have at least two radios: one for backhaul access on a 5-GHz channel and the other for 2.4-GHz client access. In addition, the radio resource management (RRM) feature, which operates on the 2.4-GHz radio, enables cell breathing and automatic channel change, which can effectively decrease the collision domains in a mesh network.

There is an additional solution that can help to further mitigate these two problems. To reduce collisions and to improve stability under high load conditions, the 802.11 MAC uses an exponential backoff algorithm, where contending nodes back off exponentially and retransmit packets whenever a perceived collision occurs. Theoretically, the more retries a node has, the smaller the collision probability will be. In practice, when there are only two contending stations and they are not hidden stations, the collision probability becomes negligible.
after just three retries. The collision probability increases when there are more contending stations. Therefore, when there are many contending stations in the same collision domain, a higher retry limit and a larger maximum contention window are necessary. Further, collision probability does not decrease exponentially when there are hidden nodes in the network. In this case, an RTS/CTS exchange can be used to mitigate the hidden node problem.

**Preferred Parent Selection**

You can configure a preferred parent for a MAP. This feature gives more control to you and enables you to enforce a linear topology in a mesh environment. You can skip AWPP and force a parent to go to a preferred parent.

**Preferred Parent Selection Criteria**

The child AP selects the preferred parent based on the following criteria:

- The preferred parent is the best parent.
- The preferred parent has a link SNR of at least 20 dB (other parents, however good, are ignored).
- The preferred parent has a link SNR in the range of 12 dB and 20 dB, but no other parent is significantly better (that is, the SNR is more than 20 percent better). For an SNR lower than 12 dB, the configuration is ignored.
- The preferred parent is not blacklisted.
- The preferred parent is not in silent mode because of dynamic frequency selection (DFS).
- The preferred parent is in the same bridge group name (BGN). If the configured preferred parent is not in the same BGN and no other parent is available, the child joins the parent AP using the default BGN.

**Configuring a Preferred Parent**

To configure a preferred parent, enter the following command:

```
(Cisco Controller) > config mesh parent preferred AP_name MAC
```

where:

- `AP_name` is the name of the child AP that you have to specify.
- `MAC` is the MAC address of the preferred parent that you have to specify.

---

**Note**

When you configure a preferred parent, ensure that you specify the MAC address of the actual mesh neighbor for the desired parent. This MAC address is the base radio MAC address that has the letter `f` as the final character. For example, if the base radio MAC address is `00:24:13:0f:92:00`, then you must specify `00:24:13:0f:92:0f` as the preferred parent. This is the actual MAC address that is used for mesh neighbor relationships.
The following example shows how to configure the preferred parent for the MAP1SB access point, where 00:24:13:0f:92:00 is the preferred parent’s MAC address:

(Cisco Controller) > config mesh parent preferred MAP1SB 00:24:13:0f:92:0f

To configure a preferred parent using the controller GUI, follow these steps:

2. Enter the MAC address of the preferred parent in the Preferred Parent text box.

**Note**

To clear the Preferred Parent value, enter none in the Preferred Parent Text box.

3. Click Apply.

**Note**

When the preferred parent is entered, no other mesh configurations can be made at the same time. You must apply the changes and wait for 90 seconds before other mesh changes can be made.

**Related Commands**

The following commands are related to preferred parent selection:

- To clear a configured parent, enter the following command:

  (Cisco Controller) > config mesh parent preferred AP_name none

- To get information about the AP that is configured as the preferred parent of a child AP, enter the following command:

  (Cisco Controller) > show ap config general AP_name

The following example shows how to get the configuration information for the MAP1SB access point, where 00:24:13:0f:92:00 is the MAC address of the preferred parent:

(Cisco Controller) > show ap config general MAP1

Cisco AP Identifier......................... 9
Cisco AP Name................................. MAP1
Country code................................. US - United States
Regulatory Domain allowed by Country..... 802.11bg:-A 802.11a:-A
AP Country code.................. US - United States
AP Regulatory Domain................. 802.11bg:-A 802.11a:-A
Switch Port Number...................... 1
MAC Address................................. 12:12:12:12:12:12
IP Address Configuration.................. DHCP
IP Address.................................. 209.165.200.225
IP NetMask.................................. 255.255.255.224
CAPWAP Path MTU.......................... 1485
Domain.....................................
Name Server.................................
Telnet State................................. Disabled
Ssh State.................................... Disabled
Cisco AP Location.......................... default location
Co-Channel Interference

In addition to hidden node interference, co-channel interference can also impact performance. Co-channel interference occurs when adjacent radios on the same channel interfere with the performance of the local mesh network. This interference takes the form of collisions or excessive deferrals by CSMA. In both cases, performance of the mesh network is degraded. With appropriate channel management, co-channel interference on the wireless mesh network can be minimized.

Wireless Mesh Network Coverage Considerations

This section provides a summary of items that must be considered for maximum wireless LAN coverage in an urban or suburban area, to adhere to compliance conditions for respective domains.

The following recommendations assume a flat terrain with no obstacles (green field deployment).
We always recommend that you perform a site survey before taking any real estimations for the area and creating a bill of materials.

**Cell Planning and Distance**

**For the Cisco 1500 Series Access Points**

The RAP-to-MAP ratio is the starting point. For general planning purposes, the current ratio is 20 MAPs per RAP.

We recommend the following values for cell planning and distance in nonvoice networks:

- **RAP-to-MAP ratio**—Recommended maximum ratio is 20 MAPs per RAP.
- **AP-to-AP distance**—A spacing of no more than of 2000 feet (609.6 meters) between each mesh access point is recommended. When you extend the mesh network on the backhaul (no client access), use a cell radius of 1000 feet (304.8 meters).
- **Hop count**—Three to four hops.
  - One square mile in feet (52802), is nine cells and you can cover one square mile with approximately three or four hops (see Figure 1 and Figure 2.)
• For 2.4 GHz, the local access cell size radius is 600 feet (182.88 meters). One cell size is around $1.31 \times 10^6$, so there are 25 cells per square mile. (See Figure 3 and Figure 4.)

**Figure 15: Cell Radius of 1000 Feet and Access Point Placement for Nonvoice Mesh Networks**

![Cell Radius of 1000 Feet and Access Point Placement for Nonvoice Mesh Networks](image)

**Figure 16: Path Loss Exponent 2.3 to 2.7**

![Path Loss Exponent 2.3 to 2.7](image)

**Figure 17: Cell Radius of 600 Feet and Access Point Placement for Nonvoice Mesh Networks**

![Cell Radius of 600 Feet and Access Point Placement for Nonvoice Mesh Networks](image)
For the Cisco 1550 Series Access Points

As seen in the previous section, we recommend a cell radius of 600 feet, and an AP to AP distance of 1200 feet. Normally, an AP to AP distance that is twice the AP to client distance is recommended. That is, if we halve the AP to AP distance, we will get the approximate cell radius.
The AP1500 series offers comparatively better range and capacity as it has the 802.11n functionality. It has advantages of ClientLink (Beamforming) in downstream, better receiver sensitivities because of MRC in upstream, multiple transmitter streams and a few other advantages of 802.11n such as channel combining and so on. The 1552 access points can provide comparatively larger and higher capacity cells.

**Note**
Link budgets are different for different country domains. The discussion in this section takes into account the most widely distributed and large country domains: -A and -E.

Comparison of Link Budgets of AP1572 Series and AP1552 Series in 2.4- and 5-GHz Bands (-A Domain) See Table 1.

**Table 6: Link Budget Comparison for the 2.4-GHz band in -A/-B Domain**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Cisco 1572 (-B Domain)</th>
<th>Cisco 1552 (-A Domain)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Frequency Band</td>
<td>2412–2462 MHz</td>
<td>2412–2462 MHz</td>
</tr>
<tr>
<td>Interface</td>
<td>802.11a/b/g/n/ac</td>
<td>W2</td>
</tr>
<tr>
<td>Channel Bandwidth</td>
<td>20 MHz</td>
<td>20 MHz</td>
</tr>
<tr>
<td>No. of Tx Spatial Streams</td>
<td>Up to 2</td>
<td>Up to 2</td>
</tr>
<tr>
<td>PHY Data Rates</td>
<td>16 Mbps</td>
<td>16 Mbps</td>
</tr>
</tbody>
</table>

Note: Up to 216 Mbps with 3SS 144 Mbps for 2SS

See Table 1.
Site Preparation and Planning

Cell Planning and Distance

- Cisco 1572 (-B Domain)
- Cisco 1562 (-A Domain)
- Cisco 1532 (-A Domain)
- Cisco 1552 (-A Domain)

**Parameter**

**30 dBm** for 1562I
**27 dBm** for 1562E/D
**29 dBm** for 1562I
**27 dBm** for 1562E/D
**28 dBm**

**Composite**

- 5 Tx Power
- Conducted

- 93 dBm at 6 Mbps
- 81 dBm at 54 Mbps
- 76 dBm at 216 Mbps

- 92 dBm at 6 Mbps
- 76 dBm at 54 Mbps
- 71 dBm at 216 Mbps

- 94 dBm at 6 Mbps
- 79 dBm at 54 Mbps
- 73 dBm at 150 Mbps

**Rx Sensitivity**

- 43 or 23 dBm

**MRC**

- 0.5 dB

- 0.5 dB, with external antenna

---

4 40-MHz channel bonding in 2.4 GHz is not applicable. Therefore, the maximum data rate is 144 Mbps.

5 Composite power is the power when we have two Tx streams enabled in AP1552.
For the 5-GHz band, see Table 2.

**Table 7: Link Budget Comparison for the 5-GHz band in -A/-B Domain**

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Band</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Interface</td>
<td>802.11a/n/ac</td>
<td>802.11a/b/g/n/acW2</td>
<td>802.11a/n</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Channel No.</td>
<td>50</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Spatial Streams</td>
<td>3</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>W2</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
The 20-MHz channel bonding to form a 40-MHz channel is available in 5 GHz. Therefore, we can go up to a data rate of 300 Mbps.

As discussed in the previous section, Path Loss Exponents (PLE) and Link Budget windows work together. For a full clear path, PLE is 2.0. For AP to AP, there is comparatively more clearance than AP to client. For AP to AP, PLE can be taken as 2.3 because it can be assumed that the height of both APs is about 10 meters, which means a good line of sight (but without Fresnel zone clearance).

For AP to client, PLE should be greater than or equal to 2.5 because the client is only 1 meter high. Therefore, there will be less Fresnel zone clearance. This applies to both the 2.4-GHz and 5-GHz bands.

Let us consider AP to AP link budget in 5 GHz for -A domain because 5 GHz is used as a backhaul for mesh. We can take a legacy data rate of 9 Mbps to estimate the range (see Table 3).

---

**Note**

This is the lowest data rate for outdoor 802.11n APs, which carries the Cisco's ClientLink (Beamforming for Legacy clients) advantage. It provides a gain of up to 4 dB in the downlink direction.
Table 8: AP to AP RF Link Budget, 5.8 GHz: 9 Mbps (-A domain)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Cisco 1552 I/C</th>
<th>Cisco 1552 E/H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx Power Conducted at 9 Mbps, 20 MHz bandwidth</td>
<td>28 dBm, Composite</td>
<td>26 dBm, Composite</td>
</tr>
<tr>
<td>Tx Antenna Cable Loss</td>
<td>0 dB</td>
<td>0.5 dB</td>
</tr>
<tr>
<td>Tx Antenna Gain</td>
<td>4 dBi (inbuilt antenna)</td>
<td>7 dBi</td>
</tr>
<tr>
<td>Tx Beam Forming (BF)</td>
<td>4 dB</td>
<td>4 dB</td>
</tr>
<tr>
<td>Tx EIRP</td>
<td>36 dBm</td>
<td>36.5 dBm</td>
</tr>
<tr>
<td>Rx Antenna Gain</td>
<td>4 dBi</td>
<td>7 dBi</td>
</tr>
<tr>
<td>Rx Antenna Cable Loss</td>
<td>0 dB</td>
<td>0.5 dB</td>
</tr>
<tr>
<td>Rx Sensitivity</td>
<td>–91 dBm at 9 Mbps</td>
<td>–91 dBm at 9 Mbps</td>
</tr>
<tr>
<td>System Gain</td>
<td>131 dB</td>
<td>134 dB</td>
</tr>
<tr>
<td>Fade Margin</td>
<td>9 dB</td>
<td>9 dB</td>
</tr>
<tr>
<td>Range between APs (LOS, PLE = 2.3)</td>
<td>829 meters (2722 feet)</td>
<td>1120 meters (3675 feet)</td>
</tr>
</tbody>
</table>

A fade margin of 9 dB is assumed, which is inconsistent with the assumption to calculate the required SNR values in the *Wireless Mesh Constraints* section.

Link Budget Analysis for AP to Client (-A Domain)

This section contains a link budget analysis for the AP to the Client, so that you know how far away a client can go from the AP with a system gain value in each band. In this analysis, the focus is on the system gain for upstream and downstream. A link should be balanced for upstream and downstream, but it might not happen. Generally, there is a higher antenna gain and higher Tx power available on the AP rather than on the client. But, this can also be opposite in a few regulatory domains because of different EIRP limit requirements. Therefore, the lowest of both upstream and downstream should be taken to calculate the AP to the client distance because that will be the decision factor. For example, if there is a higher downstream gain than upstream, the upstream should be the decision maker for the cell size because the upstream system gain allows only the client to connect to the AP.

The regulatory domain values of Tx EIRP and Rx sensitivities decide whether upstream or downstream has the lower system gain. The cell size should be determined by upstream and not downstream.

Because most of the clients available are 2.4-GHz clients, the focus is on the 2.4-GHz AP to the.

For the AP to client link budget in 2.4 GHz, let us assume a client Tx power of 20 dB and an antenna gain of 0 dBi (see Table 4). For the -A domain EIRP limit is 36 dBm for 2.4- and 5-GHz bands.
Table 9: Outdoor 11n AP-to-Client, at 2.4 GHz: 9 Mbps Data Rate (~A domain)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Cisco 1552 I/C</th>
<th>Cisco 1552 E/H</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DS</td>
<td>US</td>
<td></td>
</tr>
<tr>
<td>Tx Power Conducted</td>
<td>28 dBm (AP)</td>
<td>20 dBm (Client)</td>
<td>Composite power at 9 Mbps, 20 MHz bandwidth</td>
</tr>
<tr>
<td></td>
<td>20 dBm (AP)</td>
<td>20 dBm (Client)</td>
<td></td>
</tr>
<tr>
<td>Tx Antenna Gain</td>
<td>2 dBi (AP)</td>
<td>0 dBi (Client)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 dBi (AP)</td>
<td>0 dBi (Client)</td>
<td></td>
</tr>
<tr>
<td>Tx Beam Forming (BF)</td>
<td>4 dB (AP)</td>
<td>0 dB (Client)</td>
<td>Legacy Rate ClientLink. Helps only in DS.</td>
</tr>
<tr>
<td></td>
<td>4 dB (AP)</td>
<td>0 dB (Client)</td>
<td></td>
</tr>
<tr>
<td>Tx EIRP</td>
<td>34 dBm</td>
<td>20 dBm</td>
<td></td>
</tr>
<tr>
<td></td>
<td>36 dBm</td>
<td>20 dBm</td>
<td></td>
</tr>
<tr>
<td>Rx Antenna Gain</td>
<td>0 dBi (Client)</td>
<td>2 dBi (AP)</td>
<td></td>
</tr>
<tr>
<td></td>
<td>0 dBi (Client)</td>
<td>4 dBi (AP)</td>
<td></td>
</tr>
<tr>
<td>Rx Sensitivity</td>
<td>–90 dBm (Client)</td>
<td>–94 dBm (AP)</td>
<td>Includes 4.7 dB MRC gain for AP1552</td>
</tr>
<tr>
<td></td>
<td>–90 dBm (Client)</td>
<td>–94 dBm (AP)</td>
<td></td>
</tr>
<tr>
<td>System Gain</td>
<td>124 dB</td>
<td>116 dB</td>
<td></td>
</tr>
<tr>
<td></td>
<td>126 dB</td>
<td>118 dB</td>
<td></td>
</tr>
<tr>
<td>Range (AP to Client)</td>
<td>268 meters (881 feet)</td>
<td>323 meters (1058 feet)</td>
<td>LOS, PLE = 2.5</td>
</tr>
</tbody>
</table>

The ~A domain AP to client link budget in 2.4 GHz band is limited by upstream. That is, the upstream has lower system gain, and therefore, the decision factor will be upstream.

Cell sizes for AP to Client in 2.4 GHz for different AP1552 models can be decided by picking the lowest of the following two:

- AP to Client distance in the 2.4-GHz band (from Table 4)
- Half of the distance between AP to AP on the 5-GHz backhaul (from Table 2)

Because most of the clients available are 2.4-GHz clients, we recommend the cell size taking 2.4 GHz values into consideration (see Table 5).

Table 10: Lowest of AP to Client and Half of AP to AP Backhaul Distance

<table>
<thead>
<tr>
<th>AP Type (~A Domain)</th>
<th>AP to Client 2.4 GHz</th>
<th>Half of AP to AP backhaul Distance in 5 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552 C/I</td>
<td>250 meters (800 feet)</td>
<td>415 meters (1360 feet)</td>
</tr>
<tr>
<td>1552 E/H</td>
<td>300 meters (1000 feet)</td>
<td>560 meters (1840 feet)</td>
</tr>
</tbody>
</table>
For the AP to the AP distance, you can take double the AP to the client distance (see Table 6).

Table 11: Recommendations for Cell Radius

<table>
<thead>
<tr>
<th>AP Type (-A Domain)</th>
<th>AP to Client</th>
<th>AP to AP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552 C/I</td>
<td>250 meters (800 feet)</td>
<td>500 meters (1600 feet)</td>
</tr>
<tr>
<td>1552 E/H</td>
<td>300 meters (1000 feet)</td>
<td>600 meters (2000 feet)</td>
</tr>
</tbody>
</table>

The following assumptions are made:

• Height: APs are at 33 feet (10 meters); Client at 3.3 feet (1 meter)

• Throughput greater than 1 Mbps

• Decreasing AP-to-AP distance improves coverage

• Near LoS. For Less LoS scenarios, you must reduce the distance assumptions
Flat Terrain Environment

AP Densities result as follows:

- AP1552C and AP1552I: 14 AP/sq. mile = 5.3 AP/sq. km
- AP1552E and AP1552H: 9 AP/sq. mile = 3.5 AP/sq. km

With these recommendations, the likelihood of getting healthy cells is more.

**Note**

For 5-GHz clients, the cell radius is comparatively smaller because higher the frequency, higher is the attenuation. The 2.4-GHz band has almost 13 dB better link budget than 5 GHz.

Comparison of Link Budgets of AP1520 Series and AP1552 Series in 2.4- and 5-GHz Bands (-E Domain)

In the -E Domain, EIRP limits are comparatively much lower. EIRP limit for 2.4 Ghz is 20 dBm and for 5 GHz is 30 dBm.

Let us consider 5 GHz because it is used as a backhaul for mesh. We can take a legacy data rate of 9 Mbps to estimate the range.

**Note**

PLE is 2.3 for backhaul.

AP to AP RF Link Budget, 5.6 GHz: 9 Mbps (-E domain)

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Cisco 1552 I/C</th>
<th>Cisco 1552 E/H</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tx Power Conducted at 9 Mbps, 20 MHz bandwidth</td>
<td>22 dBm, Composite</td>
<td>19 dBm, Composite</td>
</tr>
<tr>
<td>Tx Antenna Cable Loss</td>
<td>0 dB</td>
<td>0.5 dB</td>
</tr>
<tr>
<td>Tx Antenna Gain</td>
<td>4 dBi (inbuilt antenna)</td>
<td>7 dBi</td>
</tr>
<tr>
<td>Tx Beamforming (BF)</td>
<td>4 dB</td>
<td>4 dB</td>
</tr>
<tr>
<td>Tx EIRP</td>
<td>30 dBm</td>
<td>30.5 dBm</td>
</tr>
<tr>
<td>Rx Antenna Gain</td>
<td>4 dBi</td>
<td>7 dBi</td>
</tr>
<tr>
<td>Rx Antenna Cable Loss</td>
<td>0 dB</td>
<td>0.5 dB</td>
</tr>
<tr>
<td>Rx Sensitivity</td>
<td>–91 dBm at 9 Mbps</td>
<td>–91 dBm at 9 Mbps</td>
</tr>
<tr>
<td>System Gain</td>
<td>125 dB</td>
<td>127 dB</td>
</tr>
<tr>
<td>Fade Margin</td>
<td>9 dB</td>
<td>9 dB</td>
</tr>
</tbody>
</table>
The AP1552 models with inbuilt antennas (1552C/I) have the same system gain as AP1522s for 5 GHz backhaul giving the AP to AP distance of 1543 feet.

Link Budget Analysis for AP to Client (-E Domain)

This section contains link budget analysis for AP to Client in the 2.4-GHz band. In this analysis, the focus is on the system gain for upstream and downstream. Ideally, the link should be balanced for upstream and downstream, but practically it may not happen. Therefore, the decision factor for the cell radius will be the lowest of both upstream and downstream.

For AP to client link budget in 2.4 GHz, let us assume a client Tx power of 20 dB and an antenna gain of 0 dBi.

For -E domain, the EIRP limit is 20 dBm for the 2.4-GHz band and 30 dBm for the 5-GHz band.

**Table 13: Outdoor 11n AP-to-Client, at 2.4 GHz: 9 Mbps Data Rate (-E domain)**

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Cisco 1552 I/C</th>
<th>Cisco 1552 E/H</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DS</td>
<td>US</td>
<td>DS</td>
</tr>
<tr>
<td>Tx Power Conducted</td>
<td>15 dBm (AP)</td>
<td>20 dBm (Client)</td>
<td>13 dBm (AP)</td>
</tr>
<tr>
<td>Tx Antenna Gain</td>
<td>2 dBi (AP)</td>
<td>0 dBi (Client)</td>
<td>4 dBi (AP)</td>
</tr>
<tr>
<td>Tx Beamforming (BF)</td>
<td>3 dB (AP)</td>
<td>0 dB (Client)</td>
<td>3 dB (AP)</td>
</tr>
<tr>
<td>Tx EIRP</td>
<td>20 dBm</td>
<td>20 dBm</td>
<td>20 dBm</td>
</tr>
<tr>
<td>Rx Antenna Gain</td>
<td>0 dBi (Client)</td>
<td>2 dBi (AP)</td>
<td>0 dBi (Client)</td>
</tr>
<tr>
<td>Rx Sensitivity</td>
<td>−91 dBm (Client)</td>
<td>−94 dBm (AP)</td>
<td>−91 dBm (Client)</td>
</tr>
<tr>
<td>System Gain</td>
<td>111 dB</td>
<td>116 dB</td>
<td>111 dB</td>
</tr>
<tr>
<td>Range (AP to Client)</td>
<td>173 meters (567 feet)</td>
<td>173 meters (567 feet)</td>
<td>LOS, PLE = 2.5 (5 dB fade margin)</td>
</tr>
</tbody>
</table>
The AP to client link budget in the 2.4-GHz band on the -E domain is limited by downstream. Therefore, downstream has a lower system gain. Thus, the decision factor will be downstream.

Cell sizes for AP to Client in 2.4 GHz for different AP1552 models can be decided by picking the lowest of the following two:

- AP to Client distance in 2.4 GHz band (from Table 8)
- Half of the distance between AP to AP on 5 GHz backhaul (from Table 7)

Because most of the clients available are 2.4-GHz clients, we recommend the cell size taking 2.4 GHz values into consideration (see Table 9).

**Table 14: Lowest of AP to Client and Half of AP to AP Backhaul Distance**

<table>
<thead>
<tr>
<th>AP Type (-E Domain)</th>
<th>AP to Client 2.4 GHz</th>
<th>Half of AP to AP backhaul Distance in 5 GHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552 C/I</td>
<td>180 meters (600 feet)</td>
<td>235 meters (770 feet)</td>
</tr>
<tr>
<td>1552 E/H</td>
<td>180 meters (600 feet)</td>
<td>288 meters (944 feet)</td>
</tr>
</tbody>
</table>

For AP to AP distance we can take double the AP to Client distance (see Table 10).

**Table 15: Recommendations for Cell Radius**

<table>
<thead>
<tr>
<th>AP Type (-E Domain)</th>
<th>AP to Client</th>
<th>AP to AP</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552 C/I</td>
<td>180 meters (600 feet)</td>
<td>360 meters (1200 feet)</td>
</tr>
<tr>
<td>1552 E/H</td>
<td>180 meters (600 feet)</td>
<td>360 meters (1200 feet)</td>
</tr>
</tbody>
</table>

To estimate the range and the AP density, you can use range calculators that are available at

**Note**


**Assumptions for the Cisco Range Calculator**

- The Range Calculator has been edited to stay within limitations for Tx power and EIRP under the listed regulatory domains. There may be cases where it exceeds the limitations. You must verify that the installation is within the laws of the location in which it is being installed.
- All antenna ports must be used for external antenna models for effective performance. Otherwise, range is significantly compromised.
• The Tx power is the total composite power of both Tx paths.
• Rx sensitivity is the composite sensitivity of all three Rx paths. That is, MRC is included.
• The Range Calculator assumes that ClientLink (Beamforming) is switched on.
• When you use the Range Calculator, available power levels change based upon the regulatory domain, the antenna (or antenna gain) selected, and the data rate selected. You must verify all parameters after making any parameter changes.
• You can select a different antenna than the two that are available by default. If you enter a high gain antenna and choose a power that goes over the EIRP limit, then you get a warning and the range equals 0.
• You can choose only the channels that the access point is certified for.
• You can only select only valid power levels.

The RAPs shown in Figure 20: PoP with Multiple RAPs, on page 58 are simply a starting point. The goal is to use the RAP location in combination with the RF antenna design to ensure that there is a good RF link to the MAP within the core of the cell, which means that the physical location of the RAPs can be on the edge of the cell, and a directional antenna is used to establish a link into the center of the cell. Therefore, the wired network location of a RAP might play host to the RAP of multiple cells, as shown in Figure 20: PoP with Multiple RAPs, on page 58.

Figure 20: PoP with Multiple RAPs

When the basic cell composition is settled, the cell can be replicated to cover a greater area. When replicating the cells, a decision needs to be made whether to use the same backhaul channel on all cells or to change backhaul channels with each cell. In the example shown in Figure 21: Multiple RAP and MAP Cells, on page
59, various backhaul channels (B2, C2, and D2) per cell have been chosen to reduce the co-channel interference between cells.

**Figure 21: Multiple RAP and MAP Cells**

Choosing various channels reduces the co-channel interference at the cell boundaries, at the expense of faster mesh convergence, because MAPs must fall back to seek mode to find neighbors in adjacent cells. In areas of high-traffic density, co-channel interference has the highest impact, which is likely to be around the RAP. If RAPs are clustered in one location, a different channel strategy is likely to give optimal performance; if RAPs are dispersed among the cells, using the same channel is less likely to degrade performance.

When you lay out multiple cells, use channel planning similar to standard WLAN planning to avoid overlapping channels, as shown in **Figure 22: Laying out Various Cells**, on page 59.

**Figure 22: Laying out Various Cells**
If possible, the channel planning should also minimize channel overlap in cases where the mesh has expanded to cover the loss of a RAP connection, as shown in Figure 23: Failover Coverage, on page 60.

**Figure 23: Failover Coverage**

---

**Collocating Mesh Access Points**

The following recommendations provide guidelines to determine the required antenna separation when you collocate AP1500s on the same tower. The recommended minimum separations for antennas, transmit powers, and channel spacing are addressed.

The goal of proper spacing and antenna selection is to provide sufficient isolation by way of antenna radiation pattern, free space path loss, and adjacent or alternate adjacent channel receiver rejection to provide independent operation of the collocated units. The goal is to have negligible throughput degradation due to a CCA hold-off, and negligible receive sensitivity degradation due to a receive noise floor increase.

You must follow antenna proximity requirements, which depend upon the adjacent and alternate adjacent channel usage.

**Collocating AP1500s on Adjacent Channels**

If two collocated AP1500s operate on adjacent channels such as channel 149 (5745 MHz) and channel 152 (5765 MHz), the minimum vertical separation between the two AP1500s is 40 feet (12.192 meters) (the requirement applies for mesh access points equipped with either 8 dBi omnidirectional or 17 dBi high-gain directional patch antennas).

If two collocated AP1500s operate on channels 1, 6, or 11 (2412 to 2437 MHz) with a 5.5-dBi omnidirectional antenna, then the minimum vertical separation is 8 feet (2.438 meters).

**Collocating AP1500s on Alternate Adjacent Channels**

If two collocated AP1500s operate on alternate adjacent channels such as channel 149 (5745 MHz) and channel 157 (5785 MHz), the minimum vertical separation between the two AP1500s is 10 feet (3.048 meters) (the requirements applies for mesh access points equipped with either 8-dBi omnidirectional or 17-dBi high-gain directional patch antennas).

If two collocated AP1500s operate on alternate adjacent channels 1 and 11 (2412 MHz and 2462 MHz) with a 5.5-dBi omnidirectional antenna, then the minimum vertical separation is 2 feet (0.609 meters).
In summary, a 5-GHz antenna isolation determines mesh access point spacing requirements and antenna proximity must be followed and is dependent upon the adjacent and alternate adjacent channel usage.

**Special Considerations for Indoor Mesh Networks**

Note these considerations for indoor mesh networks:

- For outdoors, voice is supported on a best-effort basis on a mesh infrastructure.
- Quality of Service (QoS) is supported on the local 2.4-GHz client access radio and on the 5-GHz.
- Cisco also supports static Call Admission Control (CAC) in CCXv4 clients, which provides CAC between the access point and the client.
- RAP-to-MAP ratio—The recommended ratio is 3 to 4 MAPs per RAP.
- AP-to-AP distance:
  - For 11n and 11ac mesh APs, a spacing of no more than 250 feet between each mesh AP with a cell radius of 125 feet is recommended.
- Hop count—For data, the maximum is 4 hops. No more than 2 hops is recommended for voice.
- RF considerations for client access on voice networks:
  - Coverage hole of 2 to 10 percent
  - Cell coverage overlap of 15 to 20 percent
  - Voice needs RSSI and SNR values that are at least 15 dB higher than data requirements
  - RSSI of -67 dBm for all data rates should be the goal for 11b/g/n and 11a/n
  - SNR should be 25 dB for the data rate used by client to connect to the AP
  - Packet error rate (PER) should be configured for a value of one percent or less
  - Channel with the lowest utilization (CU) must be used
    Check the CU when no traffic is running
Radio resource manager (RRM) can be used to implement the recommended RSSI, PER, SNR, CU, cell coverage, and coverage hole settings on the 802.11b/g/n radio (RRM is not available on 802.11a/n radio).

Figure 24: Cell Radius of 100 Feet (30.4 meters) and Access Point Placement for Voice Mesh Networks

Although you can use directional antenna and have an AP-to-AP distance longer than 250 feet (76.2 meters), for seamless roaming, we recommend that you have an AP-to-AP distance no more than 250 feet.

Figure 25: Cell Radius of 125 Feet (38 meters) and Access Point Placement for Indoor 11n Mesh Networks

Note: Although you can use directional antenna and have an AP-to-AP distance longer than 250 feet (76.2 meters), for seamless roaming, we recommend that you have an AP-to-AP distance no more than 250 feet.
Mesh AP Back-Ground Scan rel 8.3

In release 8.3 additional enhancements introduced for faster mesh convergence - Mesh AP background scan feature. There are already two Mesh convergence features implemented in releases 8.0 and 8.1 WLC software releases to reduce convergence time taken for a MAP and to re-converge the mesh network faster:

- Mesh Subset channel based convergence in rel 8.0
- Mesh Clear Channel Notification Convergence in rel 8.1

With both features in place, a 3rd Hop MAP in a mesh tree is able to re-converge and recover its data path in less than 10 seconds.

This new Mesh Background Scanning and Auto parent selection will further improve convergence times and parent selection reliability and stability - a MAP should be able to find and connect with a better potential parent across any channels and maintain its uplink with a best parent all the time.

Note

This implementation of BG scanning will be applicable to Marvell-based APs. Specifically, AP1550, AP1570 and IW3702.

A child MAP maintains its uplink with its parent using AWPP - Neighbor Discovery Request/Response (NDReq/NDResp) messages which are acting as keep-alives. If there are consecutive losses of NDResp messages, a parent is declared to be lost and the child MAP tries to find its new parent. A MAP maintains a list of neighbors of current on-channel, and on losing its current parent, it will try roaming to next best potential neighbor in the same serving channel. But if there are no other neighbors found in same channel, it has to do scan/seek across all/subset channels to find a parent.

Each off-channel list node will have a neighbor list managing all neighbors heard in that channel. Upon each off-channel NDReq broadcasts, the neighbors will be updated with latest SNR values based on their NDResp packets. A misscount parameter will indicate the number of times a neighbor did not respond to off-channel scan attempt. Each adjacency neighbor will have its adjusted Ease updated after every BG Scan cycle with latest linkSNR value.

This feature tries to avoid finding a parent across other channels by scan/seek which are time consuming, but keeps the child MAP updated with all the neighbors across all channels and will help just 'switching' to a neighbor of any channel and use him as its next parent for its uplink. This 'switching' parent procedure need not be a triggered event like parent loss detection, but also on identifying a better parent using 'Auto parent selection algorithm' when the child MAP still has its current parent uplink active. The "Auto Parent selection algorithm" is based on the new "ease" values. For better convergence calculation in rel 8.3 a new "Ease" value introduced for smoother and faster parent or neighbor finding and auto parent connection algorithm. The Ease value is based on SNR, number of Hops, Timers and load values. For the off-channel neighbors the AdjustedEase value will be used and a best neighbor per off-channel shall be identified based on its highest AdjustedEase value. StickyEase shall be applicable only for on-channel parent.

A child MAP will switch between optimal parents based on periodic evaluation of best neighbors across all off-channels. Best next parent is identified with highest adjustedEase value of another off-channel neighbor compared to current on-channel parent's stickyEase.

Table below illustrates the new convergence times based on different convergence configuration options. With the implementation of the latest CCN and Background scan features and fast convergence the First Hop MAP can achieve a 3 to 4 sec convergence.
<table>
<thead>
<tr>
<th></th>
<th>Parent Loss Detection/ Keep Alive Timers</th>
<th>Channel Scan/Seek Channels</th>
<th>DHCP/CAPWAP Information</th>
<th>Time per hop (sec)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>21 / 3 sec</td>
<td>Scan/Seek all 2.4 and 5 Ghz Channels</td>
<td>Renew / Restart CAPWAP</td>
<td>48.6*</td>
</tr>
<tr>
<td>Fast</td>
<td>7 / 3 sec</td>
<td>Scan/Seek only channels found in same bridge group</td>
<td>Maintain DHCP and CAPWAP</td>
<td>20.5*</td>
</tr>
<tr>
<td>Very Fast</td>
<td>4 / 1.5 sec</td>
<td>Scan/Seek only channels found in same bridge group</td>
<td>Maintain DHCP and CAPWAP</td>
<td>15.9*</td>
</tr>
<tr>
<td>CCN/BG Scan Fast/VF</td>
<td>4 / 3 sec for 50ms</td>
<td>Scan/Seek only channels found in same bridge group</td>
<td>Maintain DHCP and CAPWAP</td>
<td>8-10 sec</td>
</tr>
</tbody>
</table>

**DFS and None-DFS Channel Scan**

**Non-DFS channel scan**

- A MAP goes off-channel periodically, transmits NDReq broadcast packets on the selected off-channel, and shall receive NDResp packets from all 'reachable' neighbors.
- Off-channel scan periodicity will occur every 3 seconds and stay for a maximum of 50 milliseconds per off-channel.
- NDReq has to be transmitted every 10 milliseconds to send at least 4 messages within 50 milliseconds dwell time to hear better from each neighbor.

**DFS channel scan**

Per regulatory restrictions, an AP shall not transmit over a DFS channel (when set on radio for off-channel scan) unless the channel is declared to be 'safe to send'. If there are radar signals detected, there should be no transmission and the channel should be avoided for AP's wireless Tx/Rx. One way to make sure that the channel is safe to send is by when the AP does passive scan and it receives any packet from other neighbors who are on DFS on-channel.

- To enable MAPs receive a packet during their off-channel scan over a DFS channel, all other on-channel DFS neighbors shall transmit the AWPP mesh beacons if there is no Tx/Rx in last 50 milliseconds.
- These mesh beacons will help the MAPs which is doing the off-channel on the DFS channel to declare 'safe to send' and do off-channel activities.
The illustration above shows a typical Off-Channel convergence process during the "standard" or "fast/very fast" configuration.

**Note**
The timers in the table are for the illustration purpose only.

The illustration below shows Mesh convergence and Parent Auto Switching when the "ease" value dictates switching to a better parent is prompted by new "ease value" even if the original parent is still available.

### Configuring Mesh Convergence

Configuration steps are very simple to invoke new Background Scan feature.

Perform the following steps to configure controller using GUI:

---

**Cisco Wireless Mesh Access Points, Design and Deployment Guide, Release 8.1–8.4**
SUMMARY STEPS

1. On the controller choose **Wireless > Mesh** tabs and then under the "Convergence" section of the Mesh configuration choose Mode and then enable CCN and Background Scan.

2. Note, that under Mode there are three options to select the convergence mode, as indicated above the convergence times will change drastically depending on the mode selected.

DETAILED STEPS

Step 1

On the controller choose **Wireless > Mesh** tabs and then under the "Convergence" section of the Mesh configuration choose Mode and then enable CCN and Background Scan.

Background scan configure from CLI using the following commands:

```
(Cisco Controller) >config mesh background-scanning

enable       Enable background scanning on Mesh
disable      Disable background scanning on Mesh
```

Configure CCN using the following CLI command:

```
(Cisco Controller) >config mesh background-scanning enable
```
Step 2  Note, that under Mode there are three options to select the convergence mode, as indicated above the convergence times will change drastically depending on the mode selected.

### Convergence

<table>
<thead>
<tr>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>VeryFast</td>
</tr>
<tr>
<td>Standard</td>
</tr>
<tr>
<td>Fast</td>
</tr>
<tr>
<td>Noise-Tolerant</td>
</tr>
<tr>
<td>Very-Fast</td>
</tr>
</tbody>
</table>

- **Channel Change Notification**
  - Enabled
  - Disabled

- **Background Scanning**
  - Enabled

From the CLI the same convergence configured using the following commands:

```
(Cisco Controller) > config mesh ccn
enable
(Cisco Controller) > config mesh ccn enable
```

**Note**  In Standard mode CCN and BG scan options do not apply

### Managing Mesh Features

There are several commands introduced to debug and troubleshoot convergence issues

- `Debug mesh convergence enable` — debug trace
Debug mesh bgscan enable/disable

Show mesh convergence—for state and counters
Show mesh bgscan

Cyprus_MAP1#sh mesh ?
adjacency  MESH Adjacency
backhaul   MESH backhaul
channel    MESH channel
config     MESH config parameter
convergence MESH convergence info
dfs        MESH dfs information
ethernet    show mesh ethernet bridging
forwarding MESH Forwarding
inventory  platform inventory
linktest   MESH linktest stats
lsc        MESH lsc details
module     MESH module detail
mperf       MESH BW tool
security    MESH Security show
simulation MESH simulated configuration
status     MESH status

Show mesh bgscan

AP1572-7a7f.09c0#sh mesh ?
adjacency  MESH Adjacency
backhaul   MESH backhaul
channel    MESH channel
config     MESH config parameter
convergence MESH convergence info
dfs        MESH dfs information
ethernet    show mesh ethernet bridging
forwarding MESH Forwarding
inventory  platform inventory
linktest   MESH linktest stats
lsc        MESH lsc details
module     MESH module detail
mperf       MESH BW tool
security    MESH Security show
simulation MESH simulated configuration
status     MESH status
Wireless Propagation Characteristics

Table 16: Comparison of 2.4-GHz and 5-GHz Bands, on page 70 provides a comparison of the 2.4-GHz and 5-GHz bands.

The 2.4-GHz band provides better propagation characteristics than 5 GHz, but 2.4 GHz is an unlicensed band and has historically been affected with more noise and interference to date than the 5-GHz band. In addition, because there are only three backhaul channels in 2.4 GHz, co-channel interference would result. Therefore, the best method to achieve comparable capacity is by reducing system gain (that is, transmit power, antenna gain, receive sensitivity, and path loss) to create smaller cells. These smaller cells require more access points per square mile (greater access point density).

Table 16: Comparison of 2.4-GHz and 5-GHz Bands

<table>
<thead>
<tr>
<th>2.4-GHz Band Characteristics</th>
<th>5-GHz Band Characteristics</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 channels</td>
<td>22 channels (-A/-B regulatory domain)</td>
</tr>
<tr>
<td>More prone to co-channel interference</td>
<td>No co-channel interference</td>
</tr>
<tr>
<td>Lower power</td>
<td>Higher power</td>
</tr>
<tr>
<td>Lower SNR requirements given lower data rates</td>
<td>Higher SNR requirements given higher data rates</td>
</tr>
<tr>
<td>Better propagation characteristics than 5 GHz but more susceptible to noise and interference</td>
<td>Worse propagation characteristics than 2.4 GHz but less susceptible to noise and interference</td>
</tr>
<tr>
<td>Unlicensed band. Widely available throughout the world.</td>
<td>Not as widely available in the world as 2.4-GHz. Licenses in some countries.</td>
</tr>
</tbody>
</table>
2.4 GHz has more penetration capability across the obstacles due to a larger wavelength. In addition, 2.4 GHz has lower date rates which increases the success of the signal to reach the other end.

CleanAir

The 1550/1560/1570 series access points contain the CleanAir chipset, allowing full CleanAir support. CleanAir in mesh can be implemented on the 2.4 GHz radio and provides clients complete 802.11n/ac data rates while detecting, locating, classifying, and mitigating radio frequency (RF) interference. This provides a carrier class management and customer experience and ensures that you have control over the spectrum in the deployed location. CleanAir enabled RRM technology on the outdoor platform detects, quantifies, and mitigates Wi-Fi and non-Wi-Fi interference on 2.4 GHz radios. Access points operating in Bridge Mode support CleanAir in 2.4 GHz client access mode.

CleanAir AP Modes of Operation

Bridge (Mesh) Mode AP—CleanAir capable access points offer complete CleanAir functionality in the 2.4 GHz band and CleanAir advisor on the 5 GHz radio. This is across all access points that operate in Bridge mode.

Tight silicon integration with the Wi-Fi radio allows the CleanAir hardware to listen between traffic on the channel that is currently being served with no penalty to throughput of attached clients. That is, line rate detection without interrupting client traffic.

Bridge mode access points support Radio Resource Management (RRM) on the 2.4 GHz band, which helps to mitigate the interference from WiFi interferers. RRM is only available on the 5 GHz band, if a Bridge mode RAP has no child MAPs.

A CleanAir Mesh AP only scans one channel of each band continuously. In a normal deployment density, there should be many access points on the same channel, and at least one on each channel, assuming RRM is handling channel selection. In 2.4 GHz, access points have sufficient density to ensure at least three points of classification. An interference source that uses narrow band modulation (operates on or around a single frequency) is only detected by access points that share the frequency space. If the interference is a frequency hopping type (uses multiple frequencies—generally covering the whole band), it is detected by every access point that can hear it operating in the band.

Monitor Mode AP (MMAP)—A CleanAir monitor mode AP is dedicated and does not serve client traffic. The monitor mode ensures that all bands-channels are routinely scanned. The monitor mode is not available for access points in bridge (mesh) mode because in a mesh environment, access points also talk to each other on the backhaul. If a mesh AP (MAP) is in the monitor mode, then it cannot perform mesh operation.

Local Mode AP—When an outdoor access point is operating in local mode, it can preform full CleanAir and RRM on both the 2.4 GHz and 5 GHz channels. It will predominately scan its primary channel, but will periodically go off-channel to scan the rest of the spectrum. Enhanced Local Mode (ELM) wIPS detection is not available on the 1532, 1550, or 1570.

Spectrum Expert Connect Mode (optional) (SE Connect)—An SE Connect AP is configured as a dedicated spectrum sensor that allows connection of the Cisco Spectrum Expert application running on a local host to use the CleanAir AP as a remote spectrum sensor for the local application. This mode allows viewing of the raw spectrum data such as FFT plots and detailed measurements. This mode is intended for only remote troubleshooting.
Pseudo MAC (PMAC) and Merging

PMAC and Merging phenomenon is similar to the one for Generation 2 access points in local mode. A PMAC is calculated as part of the device classification and included in the interference device record (IDR). Each AP generates the PMAC independently. While it is not identical for each report (at a minimum the measured RSSI of the device is likely different at each AP), it is similar. The function of comparing and evaluating PMACs is called merging. The PMAC is not exposed to customer interfaces. Only the results of merging are available in the form of a cluster ID.

The same device can be detected by multiple APs. All the PMACs and IDRs are analyzed on the controller and a report is generated called a device cluster, which shows the APs detecting the device and the device cluster showing the AP which is hearing the device as strongest.

In this merging spatial proximity, RF proximity (RF neighbor relationship) work together. If there are six similar IDRs with 5 APs nearby and another one from an AP that is far away, it is unlikely that it is the same interferer. Therefore, a cluster is formed taking all these into account. MSE and the controller first rely on RF Neighbor lists to establish spatial proximity in a merge.

PMAC Convergence and Merging depends upon the following factors:

• Density of the sensors
• Quality of the observed classification
• RSSI from the interferer to the APs
• RF neighbor list at the APs

So RRM on 2.4 GHz in mesh also plays a key role in deciding the merging aspect. APs should be RF neighbors for any possibility of Merging. RF Neighbor list is consulted and spatial relationships for IDRs are taken into account for Merging.

Because there is no Monitor Mode in mesh, a single controller merging occurs on the controller. The result of a controller merge is forwarded to the MSE (if present) along with all of the supporting IDRs.
For more than one WLC (possible in outdoor deployments), merging occurs on the MSE. MSE does more advanced merging and extracts location and historical information for interferers. No Location is performed on controller merged interferers. Location is done on the MSE.

Figure 26: Pseudo MAC Merging in Outdoors

After PMAC signature merging, you can identify which AP can hear the device, and which AP is the center of a cluster. In the figure above, the values are relevant to the band selected. The label R on AP indicates that the AP is a RAP and the line between APs shows the mesh relationship.

Event Driven Radio Resource Management and Persistence Device Avoidance

There are two key mitigation features that are present with CleanAir. Both rely directly on information that can only be gathered by CleanAir. Event Driven Radio Resource Management (EDRRM) and Persistence Device Avoidance (PDA). For mesh networks, they work exactly the same way as for nonmesh networks in the 2.4-GHz band.

Note

EDRRM and PDA are only available in a Greenfield installation and configured off by default.

CleanAir Access Point Deployment Recommendations

CleanAir is a passive technology that does not affect the normal operation of Wi-Fi networks. There is no inherent difference between a CleanAir deployment and a mesh deployment.
Locating a non-Wi-Fi device has a lot of variables to consider. Accuracy increases with power, duty cycle, and the number of channels hearing the device. This is advantageous because higher power, higher duty cycle, and devices that impact multiple channels are considered to be severe with respect to interference to networks.

**Note**

There is no guarantee of accuracy for location of non-Wi-Fi devices.

There are a lot of variables in the world of consumer electronics and unintentional electrical interference. Any expectation of accuracy that is derived from current Client or Tag location accuracy models does not apply to non-Wi-Fi location and CleanAir features.

Important notes to consider:

- CleanAir mesh AP supports the assigned channel only.
- Band Coverage is implemented by ensuring that channels are covered.
- The CleanAir mesh AP can hear very well, and the active cell boundary is not the limit.
- For Location solutions, the RSSI cutoff value is \(-75\) dBm.
- A minimum of three quality measurements is required for location resolution.

In most deployments, it is difficult to have a coverage area that does not have at least three APs nearby on the same channel in the 2.4-GHz band. In locations where there is minimal density, while the location resolution is likely not supported, the active user channel is protected.

Deployment considerations are dependent upon planning the network for desired capacity and ensuring that you have the correct components and network paths in place to support CleanAir functions. RF proximity and the importance of RF Neighbor Relations cannot be understated. It is important to keep in mind the PMAC and the merging process. If a network does not have a good RF design, the neighbor relations is affected, which in turn affects CleanAir performance.

The AP Density recommendations for CleanAir remain the same as normal mesh AP deployment.

Location resolution in the Outdoors is to the nearest AP. Devices are located near the AP which is physically closest to the device. It is advisable to assume closest AP resolution.

It is possible to deploy a few 1530 APs (non-CleanAir) with an installation that consists of 1552 APs and 1572 APs (CleanAir). This deployment can work from a client and coverage standpoint as these access points are fully interoperable with each other. The complete CleanAir functionality depends on all access points being CleanAir enabled. Detection can be affected, and mitigation is not recommended.

A CleanAir AP actively serving clients can only monitor the assigned channel that it is serving. In an area where you have multiple access points serving clients in close proximity, the channels being served by CleanAir access points can drive CleanAir features. Legacy non-CleanAir access points rely on RRM, and mitigate interference issues, but not report the type and severity as CleanAir access points do to the system level.


### CleanAir Advisor

If CleanAir is enabled on a backhaul radio, CleanAir Advisor is activated. CleanAir Advisor generates Air Quality Index (AQI) and Interferer Detection Reports (IDR) but the reports are only displayed in the controller. No action is taken through event driven RRM (ED-RRM). CleanAir Advisor is only present on the 5-GHz
backhaul radio of the 1552 access points in Bridge mode. In all other AP modes, the 5-GHz backhaul radio of the 1552 access points operates in CleanAir mode.

**Enabling CleanAir**

To enable CleanAir functionality in the system, you first need to enable CleanAir on the controller through Wireless > 802.11a/b > CleanAir. Although CleanAir is disabled by default, CleanAir is enabled by default on the AP interface.

After you enable CleanAir, it takes 15 minutes to propagate air quality information because the default reporting interval is 15 minutes. However, you can see the results instantly at the CleanAir detail level on the radio by going to Monitor > Access Points > 802.11a/n or 802.11b/n.

**Licensing**

A CleanAir system requires a CleanAir AP and a controller that is running release 7.0 or later releases. Adding the Cisco Prime Infrastructure allows the displays to be enhanced and additional information to be correlated within the system. Adding the MSE further enhances the available features and provides the history and location of specific interference devices. There is no additional license requirement for the CleanAir feature because the CleanAir AP is the license. Adding the Prime Infrastructure can be done with a basic license. Adding the MSE to the system requires a Prime Infrastructure Plus license and a context-aware license selection for the MSE.

For purposes of interference location with the MSE or CMX, each interference device counts as a location target in Context-Aware. One hundred Permanent Interferer licenses are embedded in the MSE. Interferer Licenses open as CleanAir APs are detected, in stages of five licenses per CleanAir AP. This process is applicable to AP1552/1562/1572. An Interference device is the same as a client or a tag from a license quantity standpoint. Only a small percentage of the available licenses are used because there should be far less interference devices than clients or tags to track. Users do have control over what types of interference devices to detect and located from the controller configuration menus.

Cisco context-aware licenses can be managed and limited by the class of target (client, tag, interference), which gives users complete control over how licenses are used.

---

**Note**

Each interference device requires one context-aware service (CAS) license.

If you have too many Bluetooth devices, it is advisable to switch off the tracing of these devices because they might take up too many CAS licenses.

**Wireless Mesh Mobility Groups**

A mobility group allows controllers to peer with each other to support seamless roaming across controller boundaries. APs learn the IP addresses of the other members of the mobility group after the CAPWAP Join process. A controller can be a member of a single mobility group which can contain up to 24 controllers. Mobility is supported across 72 controllers. There can be up to 72 members (WLCs) in the mobility list with up to 24 members in the same mobility group (or domain) participating in client hand-offs. The IP address of a client does not have to be renewed in the same mobility domain. Renewing the IP address is irrelevant in the controller-based architecture when you use this feature.
Multiple Controllers

The consideration in distance of the CAPWAP controllers from other CAPWAP controllers in the mobility group, and the distance of the CAPWAP controllers from the RAP, is similar to the consideration of an CAPWAP WLAN deployment in an enterprise.

There are operational advantages to centralizing CAPWAP controllers, and these advantages need to be traded off against the speed and capacity of the links to the CAPWAP APs and the traffic profile of the WLAN clients using these mesh access points.

If the WLAN client traffic is expected to be focused on particular sites, such as the Internet or a data center, centralizing the controllers at the same sites as these traffic focal points gives the operational advantages without sacrificing traffic efficiency.

If the WLAN client traffic is more peer-to-peer, a distributed controller model might be a better fit. It is likely that a majority of the WLAN traffic are clients in the area, with a smaller amount of traffic going to other locations. Given that many peer-to-peer applications can be sensitive to delay and packet loss, you should ensure that traffic between peers takes the most efficient path.

Given that most deployments see a mix of client-server traffic and peer-to-peer traffic, it is likely that a hybrid model of CAPWAP controller placement is used, where points of presence (PoPs) are created with clusters of controllers placed in strategic locations in the network.

The CAPWAP model used in the wireless mesh network is designed for campus networks; that is, it expects a high-speed, low-latency network between the CAPWAP mesh access points and the CAPWAP controller.

 Increasing Mesh Availability

In the Cell Planning Distance section, a wireless mesh cell of one square mile was created and then built upon. This wireless mesh cell has similar properties to the cells used to create a cellular phone network because the smaller cells (rather than the defined maximum cell size) can be created to cover the same physical area, providing greater availability or capacity. This process is done by adding a RAP to the cell. Similar to the larger mesh deployment, the decision is whether to use RAP on the same channel, as shown in Figure 27: Two RAPs per Cell with the Same Channel, on page 77, or to use RAPs placed on different channels, as
shown in Figure 28: Two RAPs per Cell on Different Channels, on page 77. The addition of RAPs into an area adds capacity and resilience to that area.

**Figure 27: Two RAPs per Cell with the Same Channel**

**Figure 28: Two RAPs per Cell on Different Channels**

**Multiple RAPs**

If multiple RAPs are to be deployed, the purpose for deploying these RAPs needs to be considered. If the RAPs are being deployed to provide hardware diversity, the additional RAP(s) should be deployed on the same channel as the primary RAP to minimize the convergence time in a scenario where the mesh transfers from one RAP to another. When you plan RAP hardware diversity, consider the 32 MAPs per RAP limitation.
If additional RAPs are deployed to primarily provide additional capacity, then the additional RAPs should be deployed on a different channel than its neighboring RAP to minimize the interference on the backhaul channels.

Adding a second RAP on a different channel also reduces the collision domain through channel planning or through RAP cell splitting. Channel planning allocates different nonoverlapping channels to mesh nodes in the same collision domain to minimize the collision probability. RAP cell splitting is a simple, yet effective, way to reduce the collision domain. Instead of deploying one RAP with omnidirectional antennas in a mesh network, two or more RAPs with directional antennas can be deployed. These RAPs collocate with each other and operate on different frequency channels. This process divides a large collision domain into several smaller ones that operate independently.

If the mesh access point bridging features are being used with multiple RAPs, these RAPs should all be on the same subnet to ensure that a consistent subnet is provided for bridge clients.

If you build your mesh with multiple RAPs on different subnets, MAP convergence times increase if a MAP has to fail over to another RAP on a different subnet. One way to limit this process from happening is to use different BGNs for segments in your network that are separated by subnet boundaries.

---

**Indoor Mesh Interoperability with Outdoor Mesh**

Complete interoperability of indoor mesh access points with the outdoor ones is supported. It helps to bring coverage from outdoors to indoors. We recommend indoor mesh access points for indoor use only, and these access points should be deployed outdoors only under limited circumstances as described below.

⚠️ **Caution**

The indoor access points in a third-party outdoor enclosure can be deployed for limited outdoor deployments, such as a simple short haul extension from an indoor WLAN to a hop in a parking lot. The 1260, 1700, 2600, 2700, 3500e, 3600, and 3700 access points in an outdoor enclosure is recommended because of its robust environmental and temperature specifications. Additionally, the indoor access points have connectors to support articulated antennas when the AP is within an outdoor enclosure. Exercise caution with the SNR values as they may not scale and long-term fades may take away the links for these APs when compared to a more optimized outdoor 1500 series access point.

Mobility groups can be shared between outdoor mesh networks and indoor WLAN networks. It is also possible for a single controller to control indoor and outdoor mesh access points simultaneously. The same WLANs are broadcast out of both indoor and outdoor mesh access points.
Connecting the Cisco 1500 Series Mesh Access Points to the Network

This chapter describes how to connect the Cisco 1500 Series mesh access points to the network.

The wireless mesh terminates on two points on the wired network. The first location is where the RAP attaches to the wired network, and where all bridged traffic connects to the wired network. The second location is where the CAPWAP controller connects to the wired network; this location is where the WLAN client traffic from the mesh network connects to the wired network (see Figure 29: Mesh Network Traffic Termination, on page 79). The WLAN client traffic from CAPWAP is tunneled at Layer 2, and matching WLANs should terminate on the same switch VLAN where the controllers are collocated. The security and network configuration for each of the WLANs on the mesh depend on the security capabilities of the network to which the controller is connected.

When an HSRP configuration is in operation on a mesh network, we recommend that the In-Out multicast mode be configured. For more details on multicast configuration, see the Enabling Multicast on the Network (CLI) section.


This chapter contains the following sections:

- Adding Mesh Access Points to the Mesh Network, page 80
- Mesh PSK Key provisioning in release 8.2, page 94
- Configuring Global Mesh Parameters, page 101
- Mesh Backhaul at 5 and 2.4 Ghz in Release 8.2, page 107
- Backhaul Client Access, page 111
- Configuring Local Mesh Parameters, page 113
- Configuring Antenna Gain, page 121
- Configuring Dynamic Channel Assignment, page 122
- Configuring Radio Resource Management on a Bridge Mode Access Point, page 124
- Configuring Advanced Features, page 125

## Adding Mesh Access Points to the Mesh Network

This section assumes that the controller is already active in the network and is operating in Layer 3 mode.

**Note** Controller ports that the mesh access points connect to should be untagged.

Before adding a mesh access point to a network, do the following:

**Step 1** Add the MAC address of the mesh access point to the controller’s MAC filter. See the Adding MAC Addresses of Mesh Access Points to MAC Filter section.

**Step 2** Define the role (RAP or MAP) for the mesh access point. See the Defining Mesh Access Point Role section.

**Step 3** Verify that Layer 3 is configured on the controller. See the Verifying Layer 3 Configuration section.

**Step 4** Configure a primary, secondary, and tertiary controller for each mesh access point. See the Configuring Multiple Controllers Using DHCP 43 and DHCP 60 section.

Configure a backup controller. See the Configuring Backup Controllers section.
Step 5 Configure external authentication of MAC addresses using an external RADIUS server. See the Configuring External Authentication and Authorization Using a RADIUS Server.

Step 6 Configure global mesh parameters. See the Configuring Global Mesh Parameters section.

Step 7 Configure backhaul client access. See the Configuring Advanced Features section.

Step 8 Configure local mesh parameters. See the Configuring Local Mesh Parameters section.

Step 9 Configure antenna parameters. See the Configuring Antenna Gain section.

Step 10 Configure channels for serial backhaul. This step is applicable only to serial backhaul access points. See the Backhaul Channel Deselection on Serial Backhaul Access Point section.

Step 11 Configure the DCA channels for the mesh access points. See the Configuring Dynamic Channel Assignment section.

Step 12 Configure mobility groups (if desired) and assign controllers. See the Configuring Mobility Groups chapter in the Cisco Wireless LAN Controller Configuration Guide.

Step 13 Configure Ethernet bridging (if desired). See the Configuring Ethernet Bridging section.

Step 14 Configure advanced features such as Ethernet VLAN tagging network, video, and voice. See the Configuring Advanced Features section.

---

**Adding MAC Addresses of Mesh Access Points to MAC Filter**

You must enter the radio MAC address for all mesh access points that you want to use in the mesh network into the appropriate controller. A controller only responds to discovery requests from outdoor radios that appear in its authorization list. MAC filtering is enabled by default on the controller, so only the MAC addresses need to be configured. If the access point has an SSC and has been added to the AP Authorization List, then the MAC address of the AP does not need to be added to the MAC Filtering List.

You can add the mesh access point using either the GUI or the CLI.

---

**Note**

You can also download the list of mesh access point MAC addresses and push them to the controller using Cisco Prime Infrastructure.
Adding the MAC Address of the Mesh Access Point to the Controller Filter List (GUI)

To add a MAC filter entry for the mesh access point on the controller using the controller GUI, follow these steps:

Step 1 Choose Security > AAA > MAC Filtering. The MAC Filtering page appears.

Step 2 Click New. The MAC Filters > New page appears.

Step 3 Enter the radio MAC address of the mesh access point.

Note For 1500 series outdoor mesh access points, specify the BVI MAC address of the mesh access point into the controller as a MAC filter. For indoor mesh access points, enter the Ethernet MAC. If the required MAC address does not appear on the exterior of the mesh access point, enter the following command at the access point console to display the BVI and Ethernet MAC addresses: `sh int | i hardware`.

Step 4 From the Profile Name drop-down list, select Any WLAN.

Step 5 In the Description field, specify a description of the mesh access point. The text that you enter identifies the mesh access point on the controller.

Note You might want to include an abbreviation of its name and the last few digits of the MAC address, such as ap1522:62:39:10. You can also note details on its location such as roof top, pole top, or its cross streets.

Step 6 From the Interface Name drop-down list, choose the controller interface to which the mesh access point is to connect.

Step 7 Click Apply to commit your changes. The mesh access point now appears in the list of MAC filters on the MAC Filtering page.

Step 8 Click Save Configuration to save your changes.

Step 9 Repeat this procedure to add the MAC addresses of additional mesh access points to the list.
Adding the MAC Address of the Mesh Access Point to the Controller Filter List (CLI)

To add a MAC filter entry for the mesh access point on the controller using the controller CLI, follow these steps:

**Step 1**
To add the MAC address of the mesh access point to the controller filter list, enter this command:

```
config macfilter add ap_mac wlan_id interface [description]
```

A value of zero (0) for the `wlan_id` parameter specifies any WLAN, and a value of zero (0) for the `interface` parameter specifies none. You can enter up to 32 characters for the optional `description` parameter.

**Step 2**
To save your changes, enter this command:

```
save config
```

Defining Mesh Access Point Role

By default, AP1500s are shipped with a radio role set to MAP. You must reconfigure a mesh access point to act as a RAP.

General Notes about MAP and RAP Association With The Controller

The general notes are as follows:

- A MAP always sets the Ethernet port as the *primary backhaul* if it is UP, and secondarily the 802.11a/n/ac radio. This gives the network administrator time to reconfigure the mesh access point as a RAP, initially. For faster convergence on the network, we recommend that you do not connect any Ethernet device to the MAP until it has joined the mesh network.

- A MAP that fails to connect to a controller on a UP Ethernet port, sets the 802.11a/n/ac radio as the primary backhaul. If a MAP fails to find a neighbor or fails to connect to a controller through a neighbor, the Ethernet port is set as the primary backhaul again.

- A MAP connected to a controller over an Ethernet port does not build a mesh topology (unlike a RAP).

- A RAP always sets the Ethernet port as the primary backhaul.

- If the Ethernet port is DOWN on a RAP, or a RAP fails to connect to a controller on a UP Ethernet port, the 802.11a/n/ac radio is set as the primary backhaul for 15 minutes. Failing to find a neighbor or failing to connect to a controller via any neighbor on the 802.11a/n/ac radio causes the primary backhaul to go into the *scan* state. The primary backhaul begins its scan with the Ethernet port.
Configuring the AP Role (GUI)

To configure the role of a mesh access point using the GUI, follow these steps:

**Step 1**  Click **Wireless** to open the All APs page.

**Step 2**  Click the name of an access point. The All APs > Details (General) page appears.

**Step 3**  Click the **Mesh** tab.

![Figure 31: All APs > Details for (Mesh) Page](image)

**Step 4**  Choose **RootAP** or **MeshAP** from the AP Role drop-down list.

**Step 5**  Click **Apply** to commit your changes and to cause the access point to reboot.

Configuring the AP Role (CLI)

To configure the role of a mesh access point using the CLI, enter the following command:

```
config ap role {rootAP | meshAP} Cisco_AP
```
Configuring Multiple Controllers Using DHCP 43 and DHCP 60

To configure DHCP Option 43 and 60 for mesh access points in the embedded Cisco IOS DHCP server, follow these steps:

**Step 1**
Enter configuration mode at the Cisco IOS CLI.

**Step 2**
Create the DHCP pool, including the necessary parameters such as the default router and name server. The commands used to create a DHCP pool are as follows:

```plaintext
ip dhcp pool pool name
network IP Network Netmask
default-router Default router
dns-server DNS Server
```

where:

- **pool name** is the name of the DHCP pool, such as AP1520
- **IP Network** is the network IP address where the controller resides, such as 10.0.15.1
- **Netmask** is the subnet mask, such as 255.255.255.0
- **Default router** is the IP address of the default router, such as 10.0.0.1
- **DNS Server** is the IP address of the DNS server, such as 10.0.10.2

**Step 3**
Add the option 60 line using the following syntax:

```plaintext
option 60 ascii "VCI string"
```

For the VCI string, use one of the values below. The quotation marks must be included.

- For Cisco 1550 series access points, enter "Cisco AP c1550"
- For Cisco 1520 series access points, enter "Cisco AP c1520"
- For Cisco 1240 series access points, enter "Cisco AP c1240"
- For Cisco 1130 series access points, enter "Cisco AP c1130"

**Step 4**
Add the option 43 line using the following syntax:

```plaintext
option 43 hex hex string
```

The hex string is assembled by concatenating the TLV values shown below:

Type + Length + Value

*Type* is always f1(hex). Length is the number of controller management IP addresses times 4 in hex. Value is the IP address of the controller listed sequentially in hex.

For example, suppose that there are two controllers with management interface IP addresses 10.126.126.2 and 10.127.127.2. The type is f1(hex). The length is 2 * 4 = 8 (08(hex)). The IP addresses translate to 0a7e7e02 and 0a7f7f02. Assembling the string then yields f1080a7e7e020a7f7f02.
The resulting Cisco IOS command added to the DHCP scope is listed below:

```
option 43 hex f1080a7e7e020a7f7f02
```

## Backup Controllers

A single controller at a centralized location can act as a backup for mesh access points when they lose connectivity with the primary controller in the local region. Centralized and regional controllers need not be in the same mobility group. Using the controller GUI or CLI, you can specify the IP addresses of the backup controllers, which allows the mesh access points to fail over to controllers outside of the mobility group.

You can also configure primary and secondary backup controllers (which are used if primary, secondary, or tertiary controllers are not specified or are not responsive) for all access points connected to the controller as well as various timers, including the heartbeat timer and discovery request timers.

### Note

The fast heartbeat timer is not supported on access points in bridge mode. The fast heartbeat timer is configured only on access points in local and FlexConnect modes.

The mesh access point maintains a list of backup controllers and periodically sends primary discovery requests to each entry on the list. When the mesh access point receives a new discovery response from a controller, the backup controller list is updated. Any controller that fails to respond to two consecutive primary discovery requests is removed from the list. If the mesh access point's local controller fails, it chooses an available controller from the backup controller list in this order: primary, secondary, tertiary, primary backup, and secondary backup. The mesh access point waits for a discovery response from the first available controller in the backup list and joins the controller if it receives a response within the time configured for the primary discovery request timer. If the time limit is reached, the mesh access point assumes that the controller cannot be joined and waits for a discovery response from the next available controller in the list.

### Note

When a mesh access point’s primary controller comes back online, the mesh access point disassociates from the backup controller and reconnects to its primary controller. The mesh access point falls back to its primary controller and not to any secondary controller for which it is configured. For example, if a mesh access point is configured with primary, secondary, and tertiary controllers, it falls over to the tertiary controller when the primary and secondary controllers become unresponsive and waits for the primary controller to come back online so that it can fall back to the primary controller. The mesh access point does not fall back from the tertiary controller to the secondary controller if the secondary controller comes back online; it stays connected to the tertiary controller until the primary controller comes back up.
Configuring Backup Controllers (GUI)

Using the controller GUI, follow these steps to configure primary, secondary, and tertiary controllers for a specific mesh access point and to configure primary and secondary backup controllers for all mesh access points:

Step 1  Choose **Wireless > Access Points > Global Configuration** to open the Global Configuration page (see **Figure 32: Global Configuration Page**, on page 87).

![Figure 32: Global Configuration Page](image)

*Note*  The fast heartbeat timer is not supported on mesh access points.

Step 2  In the AP Primary Discovery Timeout field, enter a value between 30 and 3600 seconds (inclusive) to configure the access point primary discovery request timer. The default value is 120 seconds.

Step 3  If you want to specify a primary backup controller for all access points, specify the IP address of the primary backup controller in the Back-up Primary Controller IP Address field and the name of the controller in the Back-up Primary Controller Name field.

*Note*  The default value for the IP address is 0.0.0.0, which disables the primary backup controller.
Step 4 If you want to specify a secondary backup controller for all access points, specify the IP address of the secondary backup controller in the Back-up Secondary Controller IP Address field and the name of the controller in the Back-up Secondary Controller Name field.

*Note* The default value for the IP address is 0.0.0.0, which disables the secondary backup controller.

Step 5 Click *Apply* to commit your changes.

Step 6 If you want to configure primary, secondary, and tertiary backup controllers for a specific point, follow these steps:

a) Choose *Access Points > All APs* to open the All APs page.

b) Click the name of the access point for which you want to configure primary, secondary, and tertiary backup controllers.

c) Click the *High Availability* tab.

d) If desired, specify the name and IP address of the primary backup controller for this access point in the Primary Controller fields.

*Note* Specifying an IP address for the backup controller is optional in this step and the next two steps. If the backup controller is outside the mobility group to which the mesh access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. The controller name and IP address must belong to the same primary, secondary, or tertiary controller. Otherwise, the mesh access point cannot join the backup controller.

e) If desired, specify the name and IP address of the secondary backup controller for this mesh access point in the Secondary Controller fields.

f) If desired, specify the name and IP address of the tertiary backup controller for this mesh access point in the Tertiary Controller fields.

g) No change is required to the AP Failover Priority value. The default value for mesh access points is critical and it cannot be modified.

h) Click *Apply* to commit your changes.

Step 7 Click *Save Configuration* to save your changes.

---

### Configuring Backup Controllers (CLI)

Using the controller CLI, follow these steps to configure primary, secondary, and tertiary controllers for a specific mesh access point and to configure primary and secondary backup controllers for all mesh access points.

---

Step 1 To configure a primary controller for a specific mesh access point, enter this command:

```
config ap primary-base controller_name Cisco_AP [controller_ip_address]
```

*Note* The `controller_ip_address` parameter in this command and the next two commands is optional. If the backup controller is outside the mobility group to which the mesh access point is connected (the primary controller), then you need to provide the IP address of the primary, secondary, or tertiary controller, respectively. In each command, the `controller_name` and `controller_ip_address` must belong to the same primary, secondary, or tertiary controller. Otherwise, the mesh access point cannot join the backup controller.

Step 2 To configure a secondary controller for a specific mesh access point, enter this command:

```
config ap secondary-base controller_name Cisco_AP [controller_ip_address]
```

Step 3 To configure a tertiary controller for a specific mesh access point, enter this command:

```
config ap tertiary-base controller_name Cisco_AP [controller_ip_address]
```
Step 4  To configure a primary backup controller for all mesh access points, enter this command:
`config advanced backup-controller primary backup_controller_name backup_controller_ip_address`

Step 5  To configure a secondary backup controller for all mesh access points, enter this command:
`config advanced backup-controller secondary backup_controller_name backup_controller_ip_address`

Note  To delete a primary or secondary backup controller entry, enter 0.0.0.0 for the controller IP address.

Step 6  To configure the mesh access point primary discovery request timer, enter this command:
`config advanced timers ap-primary-discovery-timeout interval`
where `interval` is a value between 30 and 3600 seconds. The default value is 120 seconds.

Step 7  To configure the mesh access point discovery timer, enter this command:
`config advanced timers ap-discovery-timeout interval`
where `interval` is a value between 1 and 10 seconds (inclusive). The default value is 10 seconds.

Step 8  To configure the 802.11 authentication response timer, enter this command:
`config advanced timers auth-timeout interval`
where `interval` is a value between 10 and 600 seconds (inclusive). The default value is 10 seconds.

Step 9  To save your changes, enter this command:
`save config`

Step 10 To view a mesh access point’s configuration, enter these commands:

- `show ap config general Cisco_AP`
- `show advanced backup-controller`
- `show advanced timers`
- `show mesh config`

Information similar to the following appears for the `show ap config general Cisco_AP` command:

```
Cisco AP Identifier......................... 1
Cisco AP Name................................... AP5
Country code..................................... US - United States
Regulatory Domain allowed by Country........ 802.11bg:-AB  802.11a:-AB
AP Country code.............................. US - United States
AP Regulatory Domain......................... 802.11bg:-A  802.11a:-N
Switch Port Number ............................ 1
MAC Address.................................... 00:13:80:60:48:3e
IP Address Configuration....................... DHCP
IP Address...................................... 1.100.163.133
...
Primary Cisco Switch Name.................... 1-5520
Primary Cisco Switch IP Address............. 2.2.2.2
Secondary Cisco Switch Name................. 2-5520
Secondary Cisco Switch IP Address.......... 2.2.2.2
Tertiary Cisco Switch Name................... 3-5520
Tertiary Cisco Switch IP Address............ 1.1.1.4
```
Information similar to the following appears for the `show advanced backup-controller` command:

AP primary Backup Controller .................... controller1 10.10.10.10
AP secondary Backup Controller ............... 0.0.0.0

Information similar to the following appears for the `show advanced timers` command:

Authentication Response Timeout (seconds)........ 10
Rogue Entry Timeout (seconds).................... 1300
AP Heart Beat Timeout (seconds).................. 30
AP Discovery Timeout (seconds)................... 10
AP Primary Discovery Timeout (seconds).......... 120

Information similar to the following appears for the `show mesh config` command:

Mesh Range....................................... 12000
Backhaul with client access status.............. disabled
Background Scanning State....................... enabled
Mesh Security
Security Mode...................................... EAP
External-Auth..................................... disabled
Use MAC Filter in External AAA server.......... disabled
Force External Authentication.................. disabled
Mesh Alarm Criteria
Max Hop Count................................... 4
Recommended Max Children for MAP............. 10
Recommended Max Children for RAP................ 20
Low Link SNR.................................... 12
High Link SNR.................................... 60
Max Association Number.......................... 10
Association Interval............................. 60 minutes
Parent Change Numbers.......................... 3
Parent Change Interval.......................... 60 minutes
Mesh Multicast Mode............................. In-Out
Mesh Full Sector DFS............................ enabled
Mesh Ethernet Bridging VLAN Transparent Mode.... enabled

**Configuring External Authentication and Authorization Using a RADIUS Server**

External authorization and authentication of mesh access points using a RADIUS server such as Cisco ACS (4.1 and later) is supported in release 5.2 and later releases. The RADIUS server must support the client authentication type of EAP-FAST with certificates.

Before you employ external authentication within the mesh network, ensure that you make these changes:

- The RADIUS server to be used as an AAA server must be configured on the controller.
- The controller must also be configured on the RADIUS server.
• Add the mesh access point configured for external authorization and authentication to the user list of the RADIUS server.
  • For additional details, see the Adding a Username to a RADIUS Server section.

• Configure EAP-FAST on the RADIUS server and install the certificates. EAP-FAST authentication is required if mesh access points are connected to the controller using an 802.11a interface; the external RADIUS servers need to trust Cisco Root CA 2048. For information about installing and trusting the CA certificates, see the Configuring RADIUS Servers section.

  Note
  If mesh access points connect to a controller using a Fast Ethernet or Gigabit Ethernet interface, only MAC authorization is required.

  Note
  This feature also supports local EAP and PSK authentication on the controller.

Configuring RADIUS Servers

To install and trust the CA certificates on the RADIUS server, follow these steps:

---

**Step 1**
Download the CA certificates for Cisco Root CA 2048 from the following locations:

**Step 2**
Install the certificates as follows:
  a) From the CiscoSecure ACS main menu, click **System Configuration > ACS Certificate Setup > ACS Certification Authority Setup**.
  b) In the **CA certificate file** box, type the CA certificate location (path and name). For example: C:\Certs\crca2048.cer.
  c) Click **Submit**.

**Step 3**
Configure the external RADIUS servers to trust the CA certificate as follows:
  a) From the CiscoSecure ACS main menu, choose **System Configuration > ACS Certificate Setup > Edit Certificate Trust List**. The Edit Certificate Trust List appears.
  b) Select the check box next to the **Cisco Root CA 2048 (Cisco Systems)** certificate name.
  c) Click **Submit**.
  d) To restart ACS, choose **System Configuration > Service Control**, and then click **Restart**.

---

For additional configuration details on Cisco ACS servers, see the following:
Enabling External Authentication of Mesh Access Points (GUI)

To enable external authentication for a mesh access point using the GUI, follow these steps:

**Step 1** Choose Wireless > Mesh. The Mesh page appears (see Figure 33: Mesh Page, on page 92).

![Figure 33: Mesh Page](image)

**Step 2** In the security section, select the EAP option from the Security Mode drop-down list.

**Step 3** Select the Enabled check boxes for the External MAC Filter Authorization and Force External Authentication options.

**Step 4** Click Apply.

**Step 5** Click Save Configuration.

Adding a Username to a RADIUS Server

Add MAC addresses of mesh access point that are authorized and authenticated by external RADIUS servers to the user list of that server prior to enabling RADIUS authentication for a mesh access point.

For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as the username for the mesh access point in user validation.

For Cisco IOS-based mesh access points, in addition to adding the MAC address to the user list, you need to enter the `platform_name_string–MAC_address` string to the user list (for example, c1240-001122334455). The controller first sends the MAC address as the username; if this first attempt fails, then the controller sends the `platform_name_string–MAC_address` string as the username.
The Authentication MAC address is different for outdoor versus indoor APs. Outdoor APs use the AP's BVI MAC address, whereas indoor APs use the AP's Gigabit Ethernet MAC address.

**Note**

RADIUS Server Username Entry

For each mesh access point, two entries must be added to the RADIUS server, the platform_name_string-MAC_address string, then a hyphen delimited MAC Address. For example:

- platform_name_string-MAC_address
  
  User: c1570-aabbccddeeff
  
  Password: cisco

- Hyphen Delimited MAC Address
  
  User: aa-bb-cc-dd-ee-ff
  
  Password: aa-bb-cc-dd-ee-ff

**Note**

The AP1552 platform uses a platform name of c1550. The AP1572 uses a platform name of c1570.

Enable External Authentication of Mesh Access Points (CLI)

To enable external authentication for mesh access points using the CLI, enter the following commands:

**Step 1**

```bash
config mesh security eap
```

**Step 2**

```bash
config macfilter mac-delimiter colon
```

**Step 3**

```bash
config mesh security rad-mac-filter enable
```

**Step 4**

```bash
config mesh radius-server index enable
```

**Step 5**

```bash
config mesh security force-ext-auth enable (Optional)
```

View Security Statistics (CLI)

To view security statistics for mesh access points using the CLI, enter the following command:

```bash
show mesh security-stats Cisco_AP
```

Use this command to display packet error statistics and a count of failures, timeouts, and association and authentication successes as well as reassociations and reauthentications for the specified access point and its child.
Mesh PSK Key provisioning in release 8.2

Customers with Cisco Mesh deployment will see their Mesh Access Points (MAP) possibly moving out of their network and joining another Mesh network when both of these Mesh Deployments use AAA with wildcard MAC filtering to allow MAPs association. As Mesh APs security may use EAP-FAST this cannot be controlled since for EAP security combination of MAC address and type of AP is used and there is no controlled configuration is available. PSK option with default passphrase also presents security risk and hijack possibility. This issue will be prominently seen in overlapping deployments of two different SPs when the MAPs are used in a moving vehicle (public transportations, ferry, ship and so on.). This way, there is no restriction on MAPs to ‘stick’ to the SPs mesh network and MAPs can be hijacked / getting used by another SPs network / and cannot serve intended customers of SPs in a deployment.

The new feature introduced in 8.2 release will enable a provision-able PSK functionality from WLC which will help make a controlled mesh deployment and enhance MAPs security beyond default 'cisco' PSK used today. With this new feature the MAPs which are configured with a custom PSK, will use this key to do their authentication with their RAPs and WLC. A special precaution should be taken when upgrading from Controller Software release 8.1 and below or downgrading from release 8.2. Admin needs to understand the implications when MAP software is moving in and out of PSK support.

Wireless Mesh Components Supported

- WiSM-2, 5500, 7500 and 8500 Series Wireless LAN Controller
- Mesh AP 1550, 1530 or 1570 series and all indoor Mesh supported APs.
- Wireless clients (tablets, smartphones and so on.)
Feature Configuration Step-by-Step

Admin shall set security mode as PSK and optionally configure a new PSK. If there is no PSK configured MAPs will be able to join with default PSK key 'cisco'.

- Provisioning shall be local to each WLC
- Need to be in 'enabled' state to allow local provisioning
- Key strength as followed in WLC (Alphanumeric with special characters combination of lower, upper case, length 3-32 characters, special characters supported, redundant passwords not supported.
- Provisioned PSK is encrypted at WLC, stored, and sent to APs in encrypted format.

Mesh PSK GUI Configuration

Step 1

Connect a RAP to the controller as documented in the above sections of this Deployment Guide. As shown in the Configuration illustration example below two 1532 MAPs are connected to the RAP 1572.

As indicated in the deployment guide one of the options for the MAPs initial connection the MAP MAC addresses have to be entered on the controller for them to be connected to the RAP as indicated in the screen shot.
Step 2

From Wireless > Mesh menu, choose Security Mode as PSK and enable PSK provisioning.

Prior to release 8.2 MAC, AAA authentication with wild card character or EAP authentication were the only three methods where EAP was basically used with default internal authentication and MAC address provisioning was not reliable enough in certain installations especially when Mesh installations from different customers were overlapping and there was a strong probability of Mesh APs being accidently hijacked from one Mesh network to another. That could create many issues and coverage holes in the Mesh deployments. For that reason in release 8.2 a PSK MAP provisioning was introduced. As indicated above the PSK key has to be created on the wireless controller.
Step 3

Enter Provisioning Key as shown in the example and hit ADD to apply the entered value. The Key value will not show in the list but only the Index of the key with a time stamp when that key was provisioned on the controller. Up to 5 keys can be entered on the controller for MAPs to be used for provisioning. Any of those 5 keys that are always stored in flash on the controller, can be used by MAP for provisioning. MD5 cryptographic algorithm (128-bit) is used to encrypt a provisioned PSK and sent down to APs during new key configuration.

<table>
<thead>
<tr>
<th>Security</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Mode</td>
</tr>
<tr>
<td>PSK Provisioning</td>
</tr>
<tr>
<td>Default PSK</td>
</tr>
</tbody>
</table>

**ADD New Provisioning Key**

<table>
<thead>
<tr>
<th>Provisioning Key</th>
<th>Mesh123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Description</td>
<td>Mesh123</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key Index</th>
<th>TimeStamp</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Fri Nov 13 09:11:49 2015</td>
<td>Mike123</td>
</tr>
<tr>
<td>2</td>
<td>Fri Nov 13 09:11:03 2015</td>
<td>Cisco123</td>
</tr>
</tbody>
</table>

Step 4

Once the controller has the PSK key configured and enabled the key will be provisioned on the RAP and propagated to all MAPs connected to that RAP. The same key will be also propagated to all other children MAPs in the mesh network. There is no need to do anything on the MAPs in order for them to receive PSK key and authenticate to the RAP/MAP network.

As shown in the example when observing one specific MAP that connected to the RAP, under the Mesh tab - you can see that MAP has been provisioned using PSK key with index 1 and Time Stamp from August 19th.
Step 5  The provisioned PSK key can be deleted from MAP or RAP in case PSK key was compromised or deleted on the controller intentionally.
Step 6  If MAP accidentally connected to the wrong network and obtained Key from there, admin has an option to delete that wrong PSK key. In addition, "Delete PSK" for PSK timestamp in WLC GUI interface can be used to remove a provisioned PSK of AP when it joined via EAP security. This option is sort of Mesh AP recovery option when AP has been stranded with staled or not valid PSK and EAP security was used to rejoin a stranded Mesh AP. When PSK key is deleted from the MAP, it will go back to using its default PSK key "cisco".

Note

- Configuring a PSK with passphrase ‘cisco’ does NOT mean that its equivalent to ‘Default cisco PSK’. Provisioned PSK works independent of ‘Default PSK’
- Deleting PSK key on the RAP does not apply unless RAP becomes a MAP.

However, note that if the PSK key is still configured on the controller and in turn on the RAP/MAP, then the MAP without a matching PSK key will not be able to connect to the Mesh network. For un-provisioned MAP to connect to the PSK enabled mesh network on the controller the Provisioning Window has to be enabled.

As shown in the example when Provisioning Window is manually enabled the MAP will be allowed to connect using default "cisco" PSK key and at the same time obtain new PSK key.
It is important for Mesh administrator to disable default provisioning Window so that MAPs with default PSK key don’t connect to the provisioned Mesh network.

Note the following scenarios can cause Mesh AP to get stranded, make sure avoiding these configuration mistakes:

- Out-of-the-box APs trying to join using default PSK, but default or “PSK Provisioning Window” option is not enabled in WLC
- Forgotten the provisioned PSKs in WLC — always write description of the PSK to remind you later and save provisioned PSK or recovery will have to be performed on AP.
Mesh PSK Provisioning with Controllers In Mobility Group

In case there is a configuration of RAPs in the Mobility Group it is always advised to use the same PSK Keys or one of the 5 allowable PSK keys on all controllers in the Mobility Group; this way when MAPs coming from a different controllers they will be able to authenticate. By looking at the time stamp of the PSK you can find out where the MAP and PSK Key came from.

The following are recommendations when configuring Mesh APs with PSK or EAP security in a multi-controller configuration:

- All Controllers should have the same PSKs. WLCs with different keys will result in unexpected behavior if RAPs and MAPs move between them, and may even cause extended outages.
- All controllers should be set for the same security method – mixed EAP and PSK (with provisioning enabled and PSK(s) created) is not recommended.

CLI Commands for PSK Provisioning

- config mesh security psk provisioning enable/disable
- config mesh security psk provisioning key <pre-shared-key>
- config mesh security psk provision window enable/disable
- config mesh security psk provisioning delete_psk <ap|wlc> <ap_name|psk_index>“

Configuring Global Mesh Parameters

This section provides instructions to configure the mesh access point to establish a connection with the controller including:

- Setting the maximum range between RAP and MAP (not applicable to indoor MAPs).
- Enabling a backhaul to carry client traffic.
- Defining if VLAN tags are forwarded or not.
- Defining the authentication mode (EAP or PSK) and method (local or external) for mesh access points including security settings (local and external authentication).

You can configure the necessary mesh parameters using either the GUI or the CLI. All parameters are applied globally.
Configuring Global Mesh Parameters (GUI)

To configure global mesh parameters using the controller GUI, follow these steps:

**Step 1** Choose Wireless > Mesh.

**Step 2** Modify the mesh parameters as appropriate.

**Table 17: Global Mesh Parameters**

<table>
<thead>
<tr>
<th>Parameter (RootAP to MeshAP)</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>The optimum distance (in feet) that should exist between the root access point (RAP) and the mesh access point (MAP). This global parameter applies to all mesh access points when they join the controller and all existing mesh access points in the network.</td>
<td></td>
</tr>
<tr>
<td><strong>Range:</strong> 150 to 132,000 feet</td>
<td></td>
</tr>
<tr>
<td><strong>Default:</strong> 12,000 feet</td>
<td></td>
</tr>
<tr>
<td><strong>Note</strong> After this feature is enabled, all mesh access points reboot.</td>
<td></td>
</tr>
</tbody>
</table>

**IDS (Rogue and Signature Detection)**

When you enable this feature, IDS reports are generated for all traffic on the client access only and not on the backhaul.

When you disable this feature, no IDS reports are generated, which preserves bandwidth on the backhaul.

You have to use the following command to enable or disable it on the mesh APs:

```
config mesh ids-state {enable | disable}
```

**Note** 2.4GHz IDS is activated with the global IDS settings on the controller.

**Backhaul Client Access**

**Note** This parameter applies to mesh access points with two or more radios (1552, 1240, 1130, and 11n indoor mesh APs).

When Backhaul Client Access is enabled, it allows wireless client association over the backhaul radio. Generally, backhaul radio is a 5 GHz radio for most of the mesh access points. This means that a backhaul radio can carry both backhaul traffic and client traffic.

When Backhaul Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

**Default:** Disabled

**Note** After this feature is enabled, all mesh access points reboot.
## Parameter | Description
--- | ---
VLAN Transparent | This feature determines how a mesh access point handles VLAN tags for Ethernet bridged traffic.  
**Note** See the Configuring Advanced Features section for overview and additional configuration details.  
If VLAN Transparent is enabled, then VLAN tags are not handled and packets are bridged as untagged packets.  
**Note** No configuration of Ethernet ports is required when VLAN transparent is enabled. The Ethernet port passes both tagged and untagged frames without interpreting the frames.  
If VLAN Transparent is disabled, then all packets are handled according to the VLAN configuration on the port (trunk, access, or normal mode).  
**Note** If the Ethernet port is set to Trunk mode, then Ethernet VLAN tagging must be configured. See the Enabling Ethernet Bridging (GUI) section.  
**Note** For an overview of normal, access, and trunk Ethernet port use, see the Ethernet Port Notes section.  
**Note** To use VLAN tagging, you must uncheck the VLAN Transparent check box.  
**Note** VLAN Transparent is enabled as a default to ensure a smooth software upgrade from 4.1.192.xxM releases to release 5.2. Release 4.1.192.xxM does not support VLAN tagging.  
**Default:** Enabled.

Security Mode | Defines the security mode for mesh access points: Pre-Shared Key (PSK) or Extensible Authentication Protocol (EAP).  
**Note** EAP must be selected if external MAC filter authorization using a RADIUS server is configured.  
**Note** Local EAP or PSK authentication is performed within the controller if the External MAC Filter Authorization parameter is disabled (check box unchecked).  
**Options:** PSK or EAP  
**Default:** EAP
MAC filtering uses the local MAC filter on the controller by default. When external MAC filter authorization is enabled, if the MAC address is not found in the local MAC filter, then the MAC address in the external RADIUS server is used. This protects your network against rogue mesh access points by preventing mesh access points that are not defined on the external server from joining.

Before employing external authentication within the mesh network, the following configuration is required:

- The RADIUS server to be used as an AAA server must be configured on the controller.
- The controller must also be configured on the RADIUS server.
- The mesh access point configured for external authorization and authentication must be added to the user list of the RADIUS server.

  - For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as the username for the mesh access point in user validation.
  
  - For IOS-based mesh access points (1130, 1240), the platform name of the mesh access point is located in front of its Ethernet address within the certificate; therefore, their username for external RADIUS servers is `platform_name_string–Ethernet MAC address` such as `c1520-001122334455`.

  - The certificates must be installed and EAP-FAST must be configured on the RADIUS server.

**Note** When this capability is not enabled, by default, the controller authorizes and authenticates mesh access points using the MAC address filter.

**Default:** Disabled.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
</table>
| External MAC Filter Authorization | MAC filtering uses the local MAC filter on the controller by default. When external MAC filter authorization is enabled, if the MAC address is not found in the local MAC filter, then the MAC address in the external RADIUS server is used. This protects your network against rogue mesh access points by preventing mesh access points that are not defined on the external server from joining. Before employing external authentication within the mesh network, the following configuration is required:  
  - The RADIUS server to be used as an AAA server must be configured on the controller.  
  - The controller must also be configured on the RADIUS server.  
  - The mesh access point configured for external authorization and authentication must be added to the user list of the RADIUS server.  
  
  - For remote authorization and authentication, EAP-FAST uses the manufacturer’s certificate (CERT) to authenticate the child mesh access point. Additionally, this manufacturer certificate-based identity serves as the username for the mesh access point in user validation.  
  
  - For IOS-based mesh access points (1130, 1240), the platform name of the mesh access point is located in front of its Ethernet address within the certificate; therefore, their username for external RADIUS servers is `platform_name_string–Ethernet MAC address` such as `c1520-001122334455`.  
  
  - The certificates must be installed and EAP-FAST must be configured on the RADIUS server.  

  **Note** When this capability is not enabled, by default, the controller authorizes and authenticates mesh access points using the MAC address filter.  

**Default:** Disabled. |
| Force External Authorization | When enabled along with EAP and External MAC Filter Authorization parameters, external authorization and authentication of mesh access points is done by default by an external RADIUS server (such as Cisco 4.1 and later). The RADIUS server overrides local authentication of the MAC address by the controller which is the default.  

**Default:** Disabled. |

**Step 3** Click **Apply**.

**Step 4** Click **Save Configuration**.
Configuring Global Mesh Parameters (CLI)

To configure global mesh parameters including authentication methods using the controller CLI, follow these steps:

Note

See the Configuring Global Mesh Parameters (GUI) section for descriptions, valid ranges, and default values of the parameters used in the CLI commands.

---

Step 1
To specify the maximum range (in feet) of all mesh access points in the network, enter this command:
```text
config mesh range feet
```
To see the current range, enter the `show mesh range` command.

Step 2
To enable or disable IDS reports for all traffic on the backhaul, enter this command:
```text
config mesh ids-state {enable | disable}
```

Step 3
To specify the rate (in Mbps) at which data is shared between access points on the backhaul interface, enter this command:
```text
config ap bhrate {rate | auto} Cisco_AP
```

Step 4
To enable or disable client association on the primary backhaul (802.11a) of a mesh access point, enter these commands:
```text
config mesh client-access {enable | disable}
config ap wlan {enable | disable} 802.11a Cisco_AP
config ap wlan {add | delete} 802.11a wlan_id Cisco_AP
```

Step 5
To enable or disable VLAN transparent, enter this command:
```text
config mesh ethernet-bridging VLAN-transparent {enable | disable}
```

Step 6
To define a security mode for the mesh access point, enter one of the following commands:

a) To provide local authentication of the mesh access point by the controller, enter this command:
```text
config mesh security {eap | psk}
```

b) To store the MAC address filter in an external RADIUS server for authentication instead of the controller (local), enter these commands:
```text
config macfilter mac-delimiter colon
config mesh security rad-mac-filter enable
config mesh radius-server index enable
```

c) To provide external authentication on a RADIUS server and define a local MAC filter on the controller, enter these commands:
```text
config mesh security eap
config macfilter mac-delimiter colon
config mesh security rad-mac-filter enable
config mesh radius-server index enable
config mesh security force-ext-auth enable
```
d) To provide external authentication on a RADIUS server using a MAC username (such as c1520-123456) on the RADIUS server, enter these commands:
   
   ```
   config macfilter mac-delimiter colon
   config mesh security rad-mac-filter enable
   config mesh radius-server index enable
   config mesh security force-ext-auth enable
   ```

   **Step 7** To save your changes, enter this command:
   ```
   save config
   ```

---

**Viewing Global Mesh Parameter Settings (CLI)**

Use these commands to obtain information on global mesh settings:

- **show mesh client-access**—When Backhaul Client Access is enabled, it allows wireless client association over the backhaul radio. Generally, backhaul radio is a 5-GHz radio for most of the mesh access points. This means that a backhaul radio can carry both backhaul traffic and client traffic.

  When Backhaul Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

  ```
  (Cisco Controller)> show mesh client-access
  Backhaul with client access status: enabled
  ```

- **show mesh ids-state**—Shows the status of the IDS reports on the backhaul as either enabled or disabled.

  ```
  (Cisco Controller)> show mesh ids-state
  Outdoor Mesh IDS(Rogue/Signature Detect): .... Disabled
  ```

- **show mesh config**—Displays global configuration settings.

  ```
  (Cisco Controller)> show mesh config
  Mesh Range....................................... 12000
  Mesh Statistics update period.................... 3 minutes
  Backhaul with client access status.............. disabled
  Background Scanning State....................... enabled
  Backhaul Amsdu State............................ disabled
  
  Mesh Security
  Security Mode...................................... EAP
  External-Auth...................................... disabled
  Use MAC Filter in External AAA server......... disabled
  Force External Authentication.................. disabled
  
  Mesh Alarm Criteria
  Max Hop Count.................................... 4
  Recommended Max Children for MAP............. 10
  Recommended Max Children for RAP............ 20
  Low Link SNR.................................... 12
  High Link SNR................................. 60
  Max Association Number........................ 10
  Association Interval......................... 60 minutes
  Parent Change Numbers......................... 3
  ```
Mesh Backhaul at 5 and 2.4 Gihz in Release 8.2

Prior to release 8.2 Wireless Mesh Backhaul was supported only at 5GHz. In release 8.2 Wireless Mesh backhaul is supported at 5 and 2.4 GHz.

In certain countries it is not allowed to use Mesh Network with 5 Ghz backhaul network or even in the courtiers when 5Ghz is permitted customer may prefer to use 2.4 Ghz radio frequencies to achieve much larger Mesh or Bridge distances.

When a RAP gets change of the configuration from 5 to 2.4 Ghz that selection gets propagated from RAP to all MAPs and they will disconnect from 5Ghz network and get reconnected at 2.4 Ghz. Please note if configuring 2.4Ghz make sure all Controllers are configured with version 8.2 so that 2.4 Ghz backhaul is recognized.

Note

Only RAPs are configured with the backhaul frequency of 5 or 2.4GHz. Once RAP is configured that frequency selection will propagate down the branch to all MAPs.

Step 1

To configure Mesh Backhaul to 2.4 Ghz one simple step is required on the controller. As illustrated configure the RAP Downlink Backhaul to 2.4 Ghz and hit Enable.

Note

In the example below a Controller Global 2.4 GHz configuration is shown. When it is done on the global configuration it will apply to all Mesh RAPs. Chanel provisioning can be done also on individual RAP in that case the Chanel provisioning will apply only to that specific RAP branch of parents and children.
From the CLI you can issue "show mesh ap tree" and "show mesh backhaul <ap-name>" to see the backhaul connection.
Step 2 On the RAP the channel has to be changed to 2.4GHz and channel has to be custom selected and that selection will be propagated to all MAPs and "children" in the Branch of that RAP.
After Channel is selected under the Custom option that channel will be used for the RAP Backhaul.

**Note**  RAPs can participate in the RRM process with other RAPs in the same RF domain, however MAP only inherit the same channel from RAP and stick with it.

After the Channel change on the RAP as illustrated in the example below, the channel on the MAP has changed to CH11 in 2.4 GHz band.

Example of the MAP CLI command: show mesh backhaul <ap-name>
If for example you would try to change the Backhaul channel on the MAP you will get an error message since this functionality is not supported on the MAPs. MAPs and "map children" receive their Channel assignments from the upstream parent RAP. An example of the error message from the MAP is as shown.

**Backhaul Client Access**

When Backhaul Client Access is enabled, it allows wireless client association over the backhaul radio. The backhaul radio is a 5 GHz radio. This means that a backhaul radio can carry both backhaul traffic and client traffic.
When Backhaul Client Access is disabled, only backhaul traffic is sent over the backhaul radio and client association is only over the second radio(s).

**Note**

Backhaul Client Access is disabled by default. After this feature is enabled, all mesh access points, except slave AP and its child APs in Daisy-chained deployment, reboot.

This feature is applicable to mesh access points with two radios (1552, 1532, 1540, 1560, 1572, and Indoor APs in Bridge mode).

### Configuring Backhaul Client Access (GUI)

This figure shows how to enable Backhaul Client Access using the GUI. You will be prompted that the AP will reboot if you enable Backhaul Client Access.

*Figure 34: Configuring Backhaul Client Access using the GUI*

### Configuring Backhaul Client Access (CLI)

Use the following command to enable Backhaul Client Access:

```
(Cisco Controller)> config mesh client-access enable
```
The following message is displayed:

All Mesh APs will be rebooted
Are you sure you want to start? (y/N)

**Configuring Local Mesh Parameters**

After configuring global mesh parameters, you must configure the following local mesh parameters for these specific features if in use in your network:

- Backhaul Data Rate. See the Configuring Wireless Backhaul Data Rate section.
- Ethernet Bridging. See the Configuring Ethernet Bridging section.
- Bridge Group Name. See the Configuring Ethernet Bridging section.
- Workgroup Bridge. See the Configuring Workgroup Bridges section.
- Power and Channel Setting. See the Configuring Power and Channel Settings section.
- Antenna Gain Settings. See the Configuring Antenna Gain section.
- Dynamic Channel Assignment. See the Configuring Dynamic Channel Assignment section.

**Configuring Wireless Backhaul Data Rate**

Backhaul is used to create only the wireless connection between the access points. The backhaul interface vary between 802.11a/n/ac rates depending upon the access point. The rate selection is important for effective use of the available RF spectrum. The rate can also affect the throughput of client devices, and throughput is an important metric used by industry publications to evaluate vendor devices.

Dynamic Rate Adaptation (DRA) introduces a process to estimate optimal transmission rate for packet transmissions. It is important to select rates correctly. If the rate is too high, packet transmissions fail resulting in communication failure. If the rate is too low, the available channel bandwidth is not used, resulting in inferior products, and the potential for catastrophic network congestion and collapse.

Data rates also affect the RF coverage and network performance. Lower data rates, for example 6 Mbps, can extend farther from the access point than can higher data rates, for example 1300 Mbps. As a result, the data rate affects cell coverage and consequently the number of access points required. Different data rates are achieved by sending a more redundant signal on the wireless link, allowing data to be easily recovered from noise. The number of symbols sent out for a packet at the 1-Mbps data rate is higher than the number of symbols used for the same packet at 11 Mbps. Therefore, sending data at the lower bit rates takes more time than sending the equivalent data at a higher bit rate, resulting in reduced throughput.

In the controller release 5.2, the default data rate for the mesh 5-GHz backhaul is 24 Mbps. It remains the same with 6.0 and 7.0 controller releases.

With the 6.0 controller release, mesh backhaul can be configured for ‘Auto’ data rate. Once configured, the access point picks the highest rate where the next higher rate cannot be used because of conditions not being suitable for that rate and not because of conditions that affect all rates. That is, once configured, each link is free to settle down to the best possible rate for its link quality.

We recommend that you configure the mesh backhaul to Auto.
For example, if mesh backhaul chose 48 Mbps, then this decision is taken after ensuring that we cannot use 54 Mbps as there is not enough SNR for 54 and not because some just turned the microwave oven on which affects all rates.

A lower bit rate might allow a greater distance between MAPs, but there are likely to be gaps in the WLAN client coverage, and the capacity of the backhaul network is reduced. An increased bit rate for the backhaul network either requires more MAPs or results in a reduced SNR between MAPs, limiting mesh reliability and interconnection.

This figure shows the RAP using the "auto" backhaul data rate, and it is currently using 54 Mbps with its child MAP.

Figure 35: Bridge Rate Set to Auto

![Figure 35: Bridge Rate Set to Auto](image)

**Note**

The data rate can be set on the backhaul on a per-AP basis. It is not a global command.

**Related Commands**

Use these commands to obtain information about backhaul:

- **config ap bhrate**—Configures the Cisco Bridge backhaul Tx rate.

  The syntax is as follows:

  ```
  (controller) > config ap bhrate backhaul-rate ap-name
  ```
Preconfigured data rates for each AP (RAP=18 Mbps, MAP1=36 Mbps) are preserved after the upgrade to 6.0 or later software releases. Before you upgrade to the 6.0 release, if you have the backhaul data rate configured to any data rate, then the configuration is preserved.

The following example shows how to configure a backhaul rate of 36000 Kbps on a RAP:

```
(controller) > config ap bhrate 36000 HPRAP1
```

- **show ap bhrate**—Displays the Cisco Bridge backhaul rate.

  The syntax is as follows:

  ```
  (controller) > show ap bhrate ap-name
  ```

- **show mesh neigh summary**—Displays the link rate summary including the current rate being used in backhaul

  Example:

  ```
  (controller) > show mesh neigh summary HPRAP1
  
  AP Name/Radio Channel Rate Link-Snr Flags State
  ------------ ------- ------ ------- ------ -----
  00:0B:85:5C:B9:20 0 auto 4 0x10e8fcb8 BEACON
  00:0B:85:FF:60 0 auto 4 0x10e8fcb8 BEACON DEFAULT
  00:0B:85:62:1E:00 165 auto 4 0x10e8fcb8 BEACON
  00:0B:85:7C:A0 0 auto 1 0x10e8fcb8 BEACON
  HPMAP1 165 54 40 0x36 CHILD BEACON
  HJMAP2 0 auto 4 0x10e8fcb8 BEACON
  
  Backhaul capacity and throughput depends upon the type of the AP, that is, if it is 802.11a/n or only 802.11a, number of backhaul radios it has, and so on.

**Configuring Ethernet Bridging**

For security reasons, the Ethernet port on all MAPs is disabled by default. It can be enabled only by configuring Ethernet bridging on the root and its respective MAP.
Exceptions are allowed for a few protocols even though Ethernet bridging is disabled. For example, the following protocols are allowed:

- Spanning Tree Protocol (STP)
- Address Resolution Protocol (ARP)
- Control and Provisioning of Wireless Access Points (CAPWAP)
- Bootstrap Protocol (BOOTP) packets

Enable Spanning Tree Protocol (STP) on all connected switch ports to avoid Layer 2 looping.

Ethernet bridging has to be enabled for two scenarios:

1. When you want to use the mesh nodes as bridges (see Figure 36: Point-to-Multipoint Bridging, on page 116).

   Note

   You do not need to configure VLAN tagging to use Ethernet bridging for point-to-point and point-to-multipoint bridging deployments.

2. When you want to connect any Ethernet device such as a video camera on the MAP using its Ethernet port. This is the first step to enable VLAN tagging.

*Figure 36: Point-to-Multipoint Bridging*
Enabling Ethernet Bridging (GUI)

To enable Ethernet bridging on a RAP or MAP using the GUI, follow these steps:

**Step 1** Choose Wireless > All APs.

**Step 2** Click the AP name link of the mesh access point on which you want to enable Ethernet bridging.

**Step 3** At the details page, select the Mesh tab (see Figure 37: All APs > Details for (Mesh) Page, on page 117).

**Step 4** Select either RootAP or MeshAP from the AP Role drop-down list, if not already selected.

**Step 5** Select the Ethernet Bridging check box to enable Ethernet bridging or deselect it to disable this feature.

**Step 6** Click Apply to commit your changes. An Ethernet Bridging section appears at the bottom of the page listing each of the Ethernet ports of the mesh access point.

**Step 7** Ensure that you enable Ethernet bridging for every parent mesh AP taking the path from the mesh AP in question to the controller. For example, if you enable Ethernet bridging on MAP2 in Hop 2, then you must also enable Ethernet bridging on MAP1 (parent MAP), and on the RAP connecting to the controller.
Configuring Native VLAN (GUI)

Prior to 8.0, the Native VLAN on the wired backhaul was set as VLAN 1. Starting with the 8.0 release, the Native VLAN can be set.

Step 1  Choose Wireless > All APs.
Step 2  Choose the mesh access point on which you would like to configure the Native VLAN.
Step 3  Check the VLAN Support checkbox on the AP.
Step 4  Assign a Native VLAN.
Note  It is important that this Native VLAN matches the Native VLAN configured on the switch port of the connected switch.
Step 5  Click Apply to commit your changes.

Configuring Native VLAN (CLI)

Prior to 8.0, the Native VLAN on the wired backhaul was set as VLAN 1. Starting with the 8.0 release, the Native VLAN can be set.

Set the Native VLAN on the wired backhaul port using the command `config ap vlan-trunking native vlan-id ap-name`. 
This applies the Native VLAN configuration to the access point.

**Configuring Bridge Group Names**

Bridge group names (BGNs) control the association of mesh access points. BGNs can logically group radios to avoid two networks on the same channel from communicating with each other. The setting is also useful if you have more than one RAP in your network in the same sector (area). BGN is a string of 10 characters maximum.

A BGN of **NULL VALUE** is assigned by default by manufacturing. Although not visible to you, it allows a mesh access point to join the network prior to your assignment of your network-specific BGN.

If you have two RAPs in your network in the same sector (for more capacity), we recommend that you configure the two RAPs with the same BGN, but on different channels.

**Configuring Bridge Group Names (CLI)**

**Step 1**
To set a bridge group name (BGN), enter this command:
```
config ap bridgegroupname set group-name ap-name
```

*Note* The mesh access point reboots after a BGN configuration.

*Caution* Exercise caution when you configure a BGN on a live network. Always start a BGN assignment from the farthest-most node (last node, bottom of mesh tree) and move up toward the RAP to ensure that no mesh access points are dropped due to mixed BGNs (old and new BGNs) within the same network.

**Step 2**
To verify the BGN, enter the following command:
```
show ap config general ap-name
```

**Verifying Bridge Group Names (GUI)**

**Step 1**
Click **Wireless > Access Points > AP Name**. The details page for the selected mesh access point appears.

**Step 2**
Click the **Mesh** tab. Details for the mesh access point including the BGN appears.

**Configuring Interoperability with Cisco 3200**

Cisco AP1522 and AP1524PS can interoperate with the Cisco 3200 on the public safety channel (4.9-GHz) as well as the 2.4-GHz access and 5.8-GHz backhaul.
The Cisco 3200 creates an in-vehicle network in which devices such as PCs, surveillance cameras, digital video recorders, printers, PDAs, and scanners can share wireless networks such as cellular or WLAN based services back to the main infrastructure. This feature allows data collected from in-vehicle deployments such as a police cars to be integrated into the overall wireless infrastructure.

This section provides configuration guidelines and step-by-step instructions for configuring interoperability between the Cisco 3200 and the AP1522 and the AP1524PS.

For specific interoperability details between series 1130, 1240, and 1520 (1522, 1524PS) mesh access points and Cisco 3200, see Table 18: Mesh Access Points and Cisco 3200 Interoperability, on page 120.

### Table 18: Mesh Access Points and Cisco 3200 Interoperability

<table>
<thead>
<tr>
<th>Mesh Access Point Model</th>
<th>Cisco 3200 Model</th>
</tr>
</thead>
<tbody>
<tr>
<td>1552, 1522^6</td>
<td>c3201^7, c3202^8, c3205^9</td>
</tr>
<tr>
<td>1524PS</td>
<td>c3201, c3202</td>
</tr>
<tr>
<td>1524SB, 1130, 1240, Indoor 802.11n mesh access points</td>
<td>c3201, c3205</td>
</tr>
</tbody>
</table>

^6 Universal access must be enabled on the AP1522 if connecting to a Cisco 3200 on the 802.11a radio or 4.9-GHz band.
^7 Model c3201 is a Cisco 3200 with a 802.11b/g radio (2.4-GHz).
^8 Model c3202 is a Cisco 3200 with a 4-9-GHz subband radio.
^9 Model c3205 is a Cisco 3200 with a 802.11a radio (5.8-GHz subband).

### Configuration Guidelines for Public Safety 4.9-GHz Band

For the AP1522 or AP1524PS and Cisco 3200 to interoperate on the public safety network, the following configuration guidelines must be met:

- Client access must be enabled on the backhaul (mesh global parameter). This feature is not supported on the AP1524PS.
- Public safety must be enabled globally on all mesh access points (MAPs) in the mesh network.
- The channel number assignment on the AP1522 or AP1524PS must match those on the Cisco 3200 radio interfaces:
  - Channels 20 (4950 GHz) through 26 (4980 GHz) and subband channels 1 through 19 (5 and 10 MHz) are used for Cisco 3200 interoperability. This configuration change is made on the controller. No changes are made to the mesh access point configuration.
  - Channel assignments are only made to the RAP. Updates to the MAP are propagated by the RAP.

The default channel width for Cisco 3200s is 5 MHz. You must *either* change the channel width to 10 or 20 MHz to enable WGBs to associate with the AP1522 and AP1524PS or change the channel on the AP1522 or AP1524PS to a channel in the 5-MHz band (channels 1 to 10) or 10-MHz band (channels 11 to 19).

- Radio (802.11a) must be disabled when configuring channels and then reenabled when using the CLI. When using the GUI, enabling and disabling of the 802.11a radio for channel configuration is not required.
- Cisco 3200s can scan channels *within* but not across the 5, 10 or 20-MHz bands.
Configuring Power and Channel Settings

The backhaul channel (802.11a/n) can be configured on a RAP. MAPs tune to the RAP channel. The local access can be configured independently for MAP.

Configuring Power and Channel Settings (GUI)

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Wireless &gt; Access Points &gt; 802.11a/n.</td>
</tr>
<tr>
<td>Note</td>
<td>Radio slots are displayed for each radio.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Select configure from the Antenna drop-down list for the 802.11a/n radio.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Assign a channel (assignment methods of global and custom) for the radio.</td>
</tr>
<tr>
<td>Step 4</td>
<td>Assign Tx power levels (global and custom) for the radio.</td>
</tr>
<tr>
<td>Note</td>
<td>The default Tx power level on the backhaul is the highest power level (Level 1).</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Apply when power and channel assignment are complete.</td>
</tr>
<tr>
<td>Step 6</td>
<td>From the 802.11a/n Radios page, verify that channel assignments were made correctly.</td>
</tr>
</tbody>
</table>

Configuring Antenna Gain

You must configure the antenna gain for the mesh access point to match that of the antenna installed using the controller GUI or controller CLI.

Configuring Antenna Gain (GUI)

To configure antenna parameters using the controller GUI, follow these steps:

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Choose Wireless &gt; Access Points &gt; Radio &gt; 802.11a/n to open the 802.11a/n Radios page.</td>
</tr>
<tr>
<td>Step 2</td>
<td>For the mesh access point antenna you want to configure, hover the mouse over the blue arrow (far right) to display antenna options. Choose Configure.</td>
</tr>
<tr>
<td>Note</td>
<td>Only external antennas have configurable gain settings.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Antenna Parameters section, enter the antenna gain.</td>
</tr>
<tr>
<td>Note</td>
<td>The gain is entered in 0.5 dBm units. For example, 2.5 dBm = 5.</td>
</tr>
<tr>
<td>Note</td>
<td>The entered gain value must match that value specified by the vendor for that antenna.</td>
</tr>
</tbody>
</table>
Configuring Antenna Gain (CLI)

Enter this command to configure the antenna gain for the 802.11a backhaul radio using the controller CLI:

```
config 802.11a antenna extAntGain antenna_gain AP_name
```

where gain is entered in 0.5-dBm units (for example, 2.5 dBm = 5).

Configuring Dynamic Channel Assignment

Using the controller GUI, follow these steps to specify the channels that the dynamic channel assignment (DCA) algorithm considers when selecting the channels to be used for RRM scanning. This functionality is helpful when you know that the clients do not support certain channels because they are legacy devices or they have certain regulatory restrictions.

The steps outlined in this section are only relevant to mesh networks.

Step 1  To disable the 802.11a/n or 802.11b/g/n network, follow these steps:

a) Choose Wireless > 802.11a/n or 802.11b/g/n > Network to open the 802.11a (or 802.11b/g) Global Parameters page.

b) Deselect the 802.11a (or 802.11b/g) Network Status check box.

c) Click Apply to commit your changes.

Step 2  Choose Wireless > 802.11a/n or 802.11b/g/n > RRM > DCA to open the 802.11a (or 802.11b/g) > RRM > Dynamic Channel Assignment (DCA) page.

Step 3  Choose one of the following options from the Channel Assignment Method drop-down list to specify the controller’s DCA mode:

- **Automatic**—Causes the controller to periodically evaluate and, if necessary, update the channel assignment for all joined mesh access points. This is the default value.

- **Freeze**—Causes the controller to evaluate and update the channel assignment for all joined mesh access points, if necessary, but only when you click Invoke Channel Update Once.

**Note**  The controller does not evaluate and update the channel assignment immediately after you click Invoke Channel Update Once. It waits for the next interval to elapse.
• **OFF**—Turns off DCA and sets all mesh access point radios to the first channel of the band, which is the default value. If you choose this option, you must manually assign channels on all radios.

**Step 4**  
From the Interval drop-down list, choose one of the following options to specify how often the DCA algorithm is allowed to run: 10 minutes, 1 hour, 2 hours, 3 hours, 4 hours, 6 hours, 8 hours, 12 hours, or 24 hours. The default value is 10 minutes.

**Step 5**  
From the AnchorTime drop-down list, choose a number to specify the time of day when the DCA algorithm is to start. The options are numbers between 0 and 23 (inclusive) representing the hour of the day from 12:00 a.m. to 11:00 p.m.

**Step 6**  
Select the **Avoid Foreign AP Interference** check box to cause the controller’s RRM algorithms to consider 802.11 traffic from foreign access points (those access points not included in your wireless network) when assigning channels to lightweight access points, or deselect it to disable this feature. For example, RRM may adjust the channel assignment to have access points avoid channels close to foreign access points. The default value is checked.

**Step 7**  
Select the **Avoid Cisco AP Load** check box to cause the controller’s RRM algorithms to consider 802.11 traffic from Cisco lightweight access points in your wireless network when assigning channels, or deselect it to disable this feature. For example, RRM can assign better reuse patterns to access points that carry a heavier traffic load. The default value is deselected.

**Step 8**  
Select the **Avoid Non-802.11a (802.11b) Noise** check box to cause the controller’s RRM algorithms to consider noise (non-802.11 traffic) in the channel when assigning channels to lightweight access points, or deselect it to disable this feature. For example, RRM may have access points avoid channels with significant interference from nonaccess point sources, such as microwave ovens. The default value is checked.

**Step 9**  
From the DCA Channel Sensitivity drop-down list, choose one of the following options to specify how sensitive the DCA algorithm is to environmental changes such as signal, load, noise, and interference when determining whether to change channels:

- **Low**—The DCA algorithm is not particularly sensitive to environmental changes.
- **Medium**—The DCA algorithm is moderately sensitive to environmental changes.
- **High**—The DCA algorithm is highly sensitive to environmental changes.

The default value is **Medium**.

**Table 19: DCA Sensitivity Thresholds**

<table>
<thead>
<tr>
<th>Option</th>
<th>2.4-GHz DCA Sensitivity Threshold</th>
<th>5-GHz DCA Sensitivity Threshold</th>
</tr>
</thead>
<tbody>
<tr>
<td>High</td>
<td>5 dB</td>
<td>5 dB</td>
</tr>
<tr>
<td>Medium</td>
<td>15 dB</td>
<td>20 dB</td>
</tr>
<tr>
<td>Low</td>
<td>30 dB</td>
<td>35 dB</td>
</tr>
</tbody>
</table>

**Step 10**  
For 802.11a/n networks only, choose one of the following Channel Width options to specify the channel bandwidth supported for all 802.11 n/a/ac radios in the 5-GHz band:

- **20 MHz**—The 20-MHz channel bandwidth (default)
To override the globally configured DCA channel width setting, you can statically configure an access point’s radio for 20-MHz mode on the 802.11a/n Cisco APs > Configure page. If you ever change the static RF channel assignment method to Global on the access point radio, the global DCA configuration overrides the channel width configuration that the access point was previously using.

This page also shows the following nonconfigurable channel parameter settings:

- **Channel Assignment Leader**—The MAC address of the RF group leader, which is responsible for channel assignment.
- **Last Auto Channel Assignment**—The last time RRM evaluated the current channel assignments.

### Step 11
In the DCA Channel List section, the DCA Channels field shows the channels that are currently selected. To choose a channel, select its check box in the Select column. To exclude a channel, deselect its check box.

**Range:** 802.11a—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161, 165, 190, 196
802.11b/g—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11

**Default:** 802.11a—36, 40, 44, 48, 52, 56, 60, 64, 100, 104, 108, 112, 116, 132, 136, 140, 149, 153, 157, 161
802.11b/g—1, 6, 11

**Note** These extended UNII-2 channels in the 802.11a band do not appear in the channel list: 100, 104, 108, 112, 116, 132, 136, and 140. If you have Cisco Aironet 1500 series mesh access points in the -E regulatory domain, you must include these channels in the DCA channel list before you start operation. If you are upgrading from a previous release, verify that these channels are included in the DCA channel list. To include these channels in the channel list, select the Extended UNII-2 Channels check box.

### Step 12
If you are using AP1500s in your network, you must set the 4.9-GHz channels in the 802.11a band on which they are to operate. The 4.9-GHz band is for public safety client access traffic only. To choose a 4.9-GHz channel, select its check box in the Select column. To exclude a channel, deselect its check box.

**Range:** 7802.11a—1, 2, 3, 4, 5, 6, 7, 8, 9, 10, 11, 12, 13, 14, 15, 16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26

**Default:** 7802.11a—20, 26

### Step 13
Click **Apply** to commit your changes.

### Step 14
To reenable the 802.11a or 802.11b/g network, follow these steps:

a) Click **Wireless > 802.11a/n** or **802.11b/g/n > Network** to open the 802.11a (or 802.11b/g) Global Parameters page.

b) Select the **802.11a** (or **802.11b/g**) **Network Status** check box.

c) Click **Apply** to commit your changes.

### Step 15
Click **Save Configuration** to save your changes.

**Note** To see why the DCA algorithm changed channels, click **Monitor** and then **View All** under Most Recent Traps. The trap provides the MAC address of the radio that changed channels, the previous channel and the new channel, the reason why the change occurred, the energy before and after the change, the noise before and after the change, and the interference before and after the change. Dynamic Channel Assignment on 5 GHz radio is supported only on outdoor access points in local or flexconnect mode.

---

### Configuring Radio Resource Management on a Bridge Mode Access Point

Radio Resource Management (RRM) can be enabled on the backhaul radio of a bridge mode access point if:
• AP is a root AP (RAP)
• RAP has a wired Ethernet link to a WLC
• RAP has no child Mesh APs connected to it

Once these conditions are met, full RRM will be established, including transmit power control (TPC), Dynamic Channel Assignment (DCA), and Coverage Hole Detection and Mitigation (CHDM). If a Mesh AP needs to re-join a RAP participating in RRM, the RAP will immediately stop all RRM functionality.

The following commands enable RRM:

• `config mesh backhaul rrm <enable|disable>` — To enable RRM on the mesh backhaul radio
• `Config mesh backhaul rrm <auto-rf global|off>` — To enable/disable dynamic channel assignment only

---

**Configuring Advanced Features**

This section includes the following topics:

• Configuring Ethernet VLAN Tagging
• Client Roaming
• Configuring Voice Parameters in Indoor Mesh Networks
• Enabling Mesh Multicast Containment for Video
Configuring Ethernet VLAN Tagging

Ethernet VLAN tagging allows specific application traffic to be segmented within a wireless mesh network and then forwarded (bridged) to a wired LAN (access mode) or bridged to another wireless mesh network (trunk mode).

A typical public safety access application that uses Ethernet VLAN tagging is the placement of video surveillance cameras at various outdoor locations within a city. Each of these video cameras has a wired connection to a MAP. The video of all these cameras is then streamed across the wireless backhaul to a central command station on a wired network.

*Figure 38: Ethernet VLAN Tagging*
Ethernet Port Notes

Ethetnet VLAN tagging allows Ethernet ports to be configured as normal, access, or trunk in both indoor and outdoor implementations:

- **Normal mode**—In this mode, the Ethernet port does not accept or send any tagged packets. Tagged frames from clients are dropped.
  Use the normal mode in applications when only a single VLAN is in use or there is no need to segment traffic in the network across multiple VLANs.

- **Access Mode**—In this mode, only untagged packets are accepted. All incoming packets are tagged with user-configured VLANs called access-VLANs.
  Use the access mode for applications in which information is collected from devices connected to the MAP, such as cameras or PCs, and then forwarded to the RAP. The RAP then applies tags and forwards traffic to a switch on the wired network.

- **Trunk mode**—This mode requires the user to configure a native VLAN and an allowed VLAN list (no defaults). In this mode, both tagged and untagged packets are accepted. Untagged packets are accepted and are tagged with the user-specified native VLAN. Tagged packets are accepted if they are tagged with a VLAN in the allowed VLAN list.
  Use the trunk mode for bridging applications such as forwarding traffic between two MAPs that reside on separate buildings within a campus.

Ethernet VLAN tagging operates on Ethernet ports that are not used as backhauls.

**Note**

In the controller releases prior to 7.2, the Root Access Point (RAP) native VLAN is forwarded out of Mesh Access Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled.

In the 7.2 and 7.4 releases, the Root Access Point (RAP) native VLAN is not forwarded out of Mesh Access Point (MAP) Ethernet ports with Mesh Ethernet Bridging and VLAN Transparent enabled. This behavior is changed starting 7.6, where the native VLAN is forwarded by the MAP when VLAN transparent is enabled.

This change in behavior increases reliability and minimizes the possibility of forwarding loops on Mesh Backhauls.

VLAN Registration

To support a VLAN on a mesh access point, all the uplink mesh access points must also support the same VLAN to allow segregation of traffic that belongs to different VLANs. The activity by which an mesh access point communicates its requirements for a VLAN and gets response from a parent is known as VLAN registration.
VLAN registration occurs automatically. No user intervention is required.

VLAN registration is summarized below:

1. Whenever an Ethernet port on a mesh access point is configured with a VLAN, the port requests its parent to support that VLAN.

2. If the parent is able to support the request, it creates a bridge group for the VLAN and propagates the request to its parent. This propagation continues until the RAP is reached.

3. When the request reaches the RAP, it checks whether it is able to support the VLAN request. If yes, the RAP creates a bridge group and a subinterface on its uplink Ethernet interface to support the VLAN request.

4. If the mesh access point is not able to support the VLAN request by its child, at any point, the mesh access point replies with a negative response. This response is propagated to downstream mesh access points until the mesh access point that requested the VLAN is reached.

5. Upon receiving negative response from its parent, the requesting mesh access point defers the configuration of the VLAN. However, the configuration is stored for future attempts. Given the dynamic nature of mesh, another parent and its uplink mesh access points might be able to support it in the case of roaming or a CAPWAP reconnect.

Ethernet VLAN Tagging Guidelines

Follow these guidelines for Ethernet tagging:

- For security reasons, the Ethernet port on a mesh access point (RAP and MAP) is disabled by default. It is enabled by configuring Ethernet bridging on the mesh access point port.

- Ethernet bridging must be enabled on all the mesh access points in the mesh network to allow Ethernet VLAN tagging to operate.

- VLAN mode must be set as non-VLAN transparent (global mesh parameter). See the Configuring Global Mesh Parameters (CLI) section. VLAN transparent is enabled by default. To set as non-VLAN transparent, you must unselect the VLAN transparent option on the Wireless > Mesh page.

- VLAN tagging can only be configured on Ethernet interfaces as follows:
  - On AP1500s, three of the four ports can be used as secondary Ethernet interfaces: port 0-PoE in, port 1-PoE out, and port 3- fiber. Port 2 - cable cannot be configured as a secondary Ethernet interface.
  - In Ethernet VLAN tagging, port 0-PoE in on the RAP is used to connect to the trunk port of the switch of the wired network. Port 1-PoE out on the MAP is used to connect to external devices such as video cameras.

- Backhaul interfaces (802.11a radios) act as primary Ethernet interfaces. Backhauls function as trunks in the network and carry all VLAN traffic between the wireless and wired network. No configuration of primary Ethernet interfaces is required.

- For indoor mesh networks, the VLAN tagging feature functions as it does for outdoor mesh networks. Any access port that is not acting as a backhaul is secondary and can be used for VLAN tagging.
• VLAN tagging cannot be implemented on RAPs because the RAPs do not have a secondary Ethernet port, and the primary port is used as a backhaul. However, VLAN tagging can be enabled on MAPs with a single Ethernet port because the Ethernet port on a MAP does not function as a backhaul and is therefore a secondary port.

• No configuration changes are applied to any Ethernet interface acting as a backhaul. A warning displays if you attempt to modify the backhaul’s configuration. The configuration is only applied after the interface is no longer acting as a backhaul.

• No configuration is required to support VLAN tagging on any 802.11a backhaul Ethernet interface within the mesh network as follows:
  ◦ This includes the RAP uplink Ethernet port. The required configuration occurs automatically using a registration mechanism.
  ◦ Any configuration changes to an 802.11a Ethernet link acting as a backhaul are ignored and a warning results. When the Ethernet link no longer functions as a backhaul, the modified configuration is applied.

• VLAN configuration is not allowed on port-02-cable modem port of AP1500s (wherever applicable). VLANs can be configured on ports 0 (PoE-in), 1 (PoE-out), and 3 (fiber).

• Up to 16 VLANs are supported on each sector. The cumulative number of VLANs supported by a RAP’s children (MAP) cannot exceed 16.

• The switch port connected to the RAP must be a trunk:
  ◦ The trunk port on the switch and the RAP trunk port must match.
  ◦ The RAP must always connect to the native VLAN ID 1 on a switch. The RAP’s primary Ethernet interface is by default the native VLAN of 1.
  ◦ The switch port in the wired network that is attached to the RAP (port 0–PoE in) must be configured to accept tagged packets on its trunk port. The RAP forwards all tagged packets received from the mesh network to the wired network.
  ◦ No VLANs, other than those destined for the mesh sector, should be configured on the switch trunk port.

• A configured VLAN on a MAP Ethernet port cannot function as a Management VLAN.

• Configuration is effective only when a mesh access point is in the CAPWAP RUN state and VLAN-Transparent mode is disabled.

• Whenever there roaming or a CAPWAP restart, an attempt is made to apply configuration again.

Enabling Ethernet VLAN Tagging (GUI)

You must enable Ethernet bridging before you can configure VLAN tagging.
To enable VLAN tagging on a RAP or MAP using the GUI, follow these steps:

**Step 1**
After enabling Ethernet bridging, choose **Wireless > All APs**.

**Step 2**
Click the AP name link of the mesh access point on which you want to enable VLAN tagging.

**Step 3**
On the details page, select the **Mesh** tab.

**Step 4**
Select the **Ethernet Bridging** check box to enable the feature and click **Apply**. An Ethernet Bridging section appears at the bottom of the page listing each of the four Ethernet ports of the mesh access point.

- If configuring a MAP **access** port, click, for example, **gigabitEthernet1** (port 1-PoE out).
  
  Select **access** from the mode drop-down list.

  Enter a VLAN ID. The VLAN ID can be any value between 1 and 4095.

  Click **Apply**.

  **Note** VLAN ID 1 is not reserved as the default VLAN.

  **Note** A maximum of 16 VLANs are supported across all of a RAP’s subordinate MAP.

- If configuring a RAP or MAP **trunk** port, click **gigabitEthernet0** (port 0-PoE in).
  
  Select **trunk** from the mode drop-down list.

  Specify a native VLAN ID for **incoming** traffic. The native VLAN ID can be any value between 1 and 4095. Do not assign any value assigned to a user-VLAN (access).

  Click **Apply**.

  A trunk VLAN ID field and a summary of configured VLANs appears at the bottom of the screen. The trunk VLAN ID field is for outgoing packets.

  Specify a trunk VLAN ID for **outgoing** packets:

  If forwarding **untagged** packets, do not change the default trunk VLAN ID value of zero. (MAP-to-MAP bridging, campus environment)

  If forwarding **tagged** packets, enter a VLAN ID (1 to 4095) that is not already assigned. (RAP to switch on wired network).

  Click **Add** to add the trunk VLAN ID to the allowed VLAN list. The newly added VLAN displays under the Configured VLANs section on the page.

  **Note** To remove a VLAN from the list, select the Remove option from the arrow drop-down list to the right of the desired VLAN.

**Step 5**
Click **Apply**.

**Step 6**
Click **Save Configuration** to save your changes.

---

**Configuring Ethernet VLAN Tagging (CLI)**

To configure a MAP **access** port, enter this command:
config ap ethernet 1 mode access enable AP1500-MAP 50
where AP1500-MAP is the variable AP_name and 50 is the variable access_vlan ID
To configure a RAP or MAP trunk port, enter this command:
config ap ethernet 0 mode trunk enable AP1500-MAP 60
where AP1500-MAP is the variable AP_name and 60 is the variable native_vlan ID
To add a VLAN to the VLAN allowed list of the native VLAN, enter this command:
config ap ethernet 0 mode trunk add AP1500-MAP3 65
where AP1500-MAP 3 is the variable AP_name and 65 is the variable VLAN ID

Viewing Ethernet VLAN Tagging Configuration Details (CLI)

- To view VLAN configuration details for Ethernet interfaces on a specific mesh access point (AP Name) or all mesh access points (summary), enter this command:
  show ap config ethernet ap-name
- To see if VLAN transparent mode is enabled or disabled, enter this command:
  show mesh config

Workgroup Bridge Interoperability with Mesh Infrastructure

A workgroup bridge (WGB) is a small standalone unit that can provide a wireless infrastructure connection for Ethernet-enabled devices. Devices that do not have a wireless client adapter to connect to the wireless network can be connected to the WGB through the Ethernet port. The WGB is associated with the root AP through the wireless interface, which means that wired clients get access to the wireless network.

A WGB is used to connect wired networks over a single wireless segment by informing the mesh access point of all the clients that the WGB has on its wired segment via IAPP messages. The data packets for WGB clients contain an additional MAC address in the 802.11 header (4 MAC headers, versus the normal 3 MAC data headers). The additional MAC in the header is the address of the WGB itself. This additional MAC address is used to route the packet to and from the clients.
WGB association is supported on all radios of every mesh access point.

**Figure 39: WGB Example**

In the current architecture, while an autonomous AP functions as a workgroup bridge, only one radio interface is used for controller connectivity, Ethernet interface for wired client connectivity, and other radio interface for wireless client connectivity. dot11radio 1 (5 GHz) can be used to connect to a controller (using the mesh infrastructure) and Ethernet interface for wired clients. dot11radio 0 (2.4 GHz) can be used for wireless client connectivity. Depending on the requirement, dot11radio 1 or dot11radio 0 can be used for client association or controller connectivity.

With the 7.0 release, a wireless client on the second radio of the WGB is not dissociated by the WGB upon losing its uplink to a wireless infrastructure or in a roaming scenario.

With two radios, one radio can be used for client access and the other radio can be used for accessing the access points. Having two independent radios performing two independent functions provides you better control and lowers the latency. Also, wireless clients on the second radio for the WGB do not get disassociated by the WGB when an uplink is lost or in a roaming scenario. One radio has to be configured as a Root AP (radio role) and the second radio has to be configured as a WGB (radio role).

---

**Note**

If one radio is configured as a WGB, then the second radio cannot be a WGB or a repeater.

The following features are not supported for use with a WGB:

- Idle timeout
- Web authentication—If a WGB associates to a web-authentication WLAN, the WGB is added to the exclusion list, and all of the WGB-wired clients are deleted (web-authentication WLAN is another name for a guest WLAN).
- For wired clients behind the WGB, MAC filtering, link tests, and idle timeout
Configuring Workgroup Bridges

A workgroup bridge (WGB) is used to connect wired networks over a single wireless segment by informing the mesh access point of all the clients that the WGB has on its wired segment via IAPP messages. In addition to the IAPP control messages, the data packets for WGB clients contain an extra MAC address in the 802.11 header (4 MAC headers, versus the normal 3 MAC data headers). The extra MAC in the header is the address of the workgroup bridge itself. This extra MAC address is used to route the packet to and from the clients.

WGB association is supported on both the 2.4-GHz (802.11b/g) and 5-GHz (802.11a) radios on all Cisco APs.

Supported platforms are autonomous 1600, 1700, 2600, 2700, 3600, 3700, 1530, 1550, and 1570, which are configured as WGBs can associate with a mesh access point. See the "Cisco Workgroup Bridges" section in Cisco Wireless LAN Controller Configuration Guide for configuration steps at https://www.cisco.com/c/en/us/support/wireless/8500-series-wireless-controllers/products-installation-and-configuration-guides-list.html

The supported WGB modes and capacities are as follows:

• The autonomous access points configured as WGBs must be running Cisco IOS release 12.4.25d-JA or later.

  Note если ваш мостовая точка доступа имеет два радио, вы можете настроить WGB mode на одном из них. Мы рекомендуем отключить второе радио. Workgroup bridge mode is not supported on access points with three radios.

• Client mode WGB (BSS) is supported; however, infrastructure WGB is not supported. The client mode WGB is not able to trunk VLAN as in an infrastructure WGB.

• Multicast traffic is not reliably transmitted to WGB because no ACKs are returned by the client. Multicast traffic is unicast to infrastructure WGB, and ACKs are received back.

• If one radio is configured as a WGB in a Cisco IOS access point, then the second radio cannot be a WGB or a repeater.

• Mesh access points can support up to 200 clients including wireless clients, WGB, and wired clients behind the associated WGB.
- A WGB cannot associate with mesh access points if the WLAN is configured with WPA1 (TKIP) + WPA2 (AES), and the corresponding WGB interface is configured with only one of these encryptions (either WPA1 or WPA2):

*Figure 40: WPA Security Settings for a WGB

*Figure 41: WPA-2 Security Settings for a WGB*
To view the status of a WGB client, follow these steps:

**Step 1** Choose Monitor > Clients.

**Step 2** On the client summary page, click on the MAC address of the client or search for the client using its MAC address.

**Step 3** In the page that appears, note that the client type is identified as a WGB (far right).

*Figure 42: Clients are Identified as a WGB*

**Step 4** Click on the MAC address of the client to view configuration details:

- For a wireless client, the page seen in *Figure 43: Monitor > Clients > Detail Page (Wireless WGB Client)*, on page 136 appears.
• For a wired client, the page seen in Figure 44: Monitor > Clients > Detail Page (Wired WGB Client), on page 136 appears.

**Figure 43: Monitor > Clients > Detail Page (Wireless WGB Client)**

**Figure 44: Monitor > Clients > Detail Page (Wired WGB Client)**

---

**Guidelines for Configuration**

Follow these guidelines when you configure:
• We recommend using a 5-GHz radio for the uplink to Mesh AP infrastructure so you can take advantage of a strong client access on two 5-GHz radios available on mesh access points. A 5-GHz band allows more Effective Isotropic Radiated Power (EIRP) and is less polluted. In a two-radio WGB, configure 5-GHz radio (radio 1) mode as WGB. This radio will be used to access the mesh infrastructure. Configure the second radio 2.4-GHz (radio 0) mode as Root for client access.

• On the Autonomous access points, only one SSID can be assigned to the native VLAN. You cannot have multiple VLANs in one SSID on the autonomous side. SSID to VLAN mapping should be unique because this is the way to segregate traffic on different VLANs. In a unified architecture, multiple VLANs can be assigned to one WLAN (SSID).

• Only one WLAN (SSID) for wireless association of the WGB to the access point infrastructure is supported. This SSID should be configured as an infrastructure SSID and should be mapped to the native VLAN.

• A dynamic interface should be created in the controller for each VLAN configured in the WGB.

• A second radio (2.4-GHz) on the access point should be configured for client access. You have to use the same SSID on both radios and map to the native VLAN. If you create a separate SSID, then it is not possible to map it to a native VLAN, due to the unique VLAN/SSID mapping requirements. If you try to map the SSID to another VLAN, then you do not have multiple VLAN support for wireless clients.

• All Layer 2 security types are supported for the WLANs (SSIDs) for wireless client association in WGB.

• This feature does not depend on the AP platform. On the controller side, both mesh and nonmesh APs are supported.

• There is a limitation of 20 clients in the WGB. The 20-client limitation includes both wired and wireless clients. If the WGB is talking to autonomous access points, then the client limit is very high.

• The controller treats the wireless and wired clients behind a WGB in the same manner. Features such as MAC filtering and link test are not supported for wireless WGB clients from the controller.

• If required, you can run link tests for a WGB wireless client from an autonomous AP.

• Multiple VLANs for wireless clients associated to a WGB are not supported.

• Up to 16 multiple VLANs are supported for wired clients behind a WGB from the 7.0 release and later releases.

• Roaming is supported for wireless and wired clients behind a WGB. The wireless clients on the other radio will not be dissociated by the WGB when an uplink is lost or in a roaming scenario.

We recommend that you configure radio 0 (2.4 GHz) as a Root (one of the mode of operations for Autonomous AP) and radio 1 (5 GHz) as a WGB.

**Configuration Example**

When you configure from the CLI, the following are mandatory:

• dot11 SSID (security for a WLAN can be decided based on the requirement).

• Map the subinterfaces in both the radios to a single bridge group.
A native VLAN is always mapped to bridge group 1 by default. For other VLANs, the bridge group number matches the VLAN number; for example, for VLAN 46, the bridge group is 46.

- Map the SSID to the radio interfaces and define the role of the radio interfaces.

In the following example, one SSID (WGBTEST) is used in both radios, and the SSID is the infrastructure SSID mapped to NATIVE VLAN 51. All radio interfaces are mapped to bridge group -1.

```
WGB1# config t
WGB1(config)# interface Dot11Radio1.51
WGB1(config-subif)# encapsulation dot1q 51 native
WGB1(config-subif)# bridge-group 1
WGB1(config-subif)# exit
WGB1(config)# interface Dot11Radio0.51
WGB1(config-subif)# encapsulation dot1q 51 native
WGB1(config-subif)# bridge-group 1
WGB1(config-subif)# exit
WGB1(config)# dot11 ssid WGBTEST
WGB1(config-ssid)# VLAN 51
WGB1(config-ssid)# authentication open
WGB1(config-ssid)# infrastructure-ssid
WGB1(config-ssid)# exit
WGB1(config)# interface Dot11Radio1
WGB1(config-if)# ssid WGBTEST
WGB1(config-if)# station-role workgroup-bridge
WGB1(config-if)# exit
WGB1(config)# interface Dot11Radio0
WGB1(config-if)# ssid WGBTEST
WGB1(config-if)# station-role root
WGB1(config-if)# exit
```
You can also use the GUI of an autonomous AP for configuration. From the GUI, subinterfaces are automatically created after the VLAN is defined.

**Figure 45: SSID Configuration Page**

![SSID Configuration Page](image)

**WGB Association Check**

Both the WGB association to the controller and the wireless client association to WGB can be verified by entering the `show dot11 associations client` command in autonomous AP.

```
WGB# show dot11 associations client
802.11 Client Stations on Dot11Radio1:
SSID [WGBTEST] :

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>Device</th>
<th>Name</th>
<th>Parent</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>0024.130f.920e</td>
<td>209.165.200.225</td>
<td>LWAPP-Parent</td>
<td>RAPSB</td>
<td>-</td>
<td>Assoc</td>
</tr>
</tbody>
</table>
```
From the controller, choose **Monitor > Clients**. The WGB and the wireless/wired client behind the WGB are updated and the wireless/wired client are shown as the WGB client.

**Figure 46: Updated WGB Clients**

![Figure 46: Updated WGB Clients](image1)

**Figure 47: Updated WGB Clients**

![Figure 47: Updated WGB Clients](image2)

**Figure 48: Updated WGB Clients**

![Figure 48: Updated WGB Clients](image3)
A link test can also be run from the controller CLI using the following command:

```
(Cisco Controller) > linktest client mac-address
```

Link tests from the controller are only limited to the WGB, and they cannot be run beyond the WGB from the controller to a wired or wireless client connected to the WGB. You can run link tests for the wireless client connected to the WGB from the WGB itself using the following command:

```
ap# dot11 dot11Radio @ linktest target client-mac-address
Start linktest to 0040.96b8.d462, 100 512 byte packets
ap#
```

<table>
<thead>
<tr>
<th>Packet rate</th>
<th>1M</th>
<th>2M</th>
<th>5.5M</th>
<th>6M</th>
<th>9M</th>
<th>11M</th>
<th>12M</th>
<th>18M</th>
<th>24M</th>
<th>36M</th>
<th>48M</th>
<th>54M</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sent count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Receive count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Packet rate (max)</th>
<th>0</th>
<th>1</th>
<th>2</th>
<th>3</th>
<th>4</th>
<th>5</th>
<th>6</th>
<th>7</th>
<th>8</th>
<th>9</th>
<th>10</th>
<th>11</th>
<th>12</th>
<th>13</th>
<th>14</th>
<th>15</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sent count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Receive count</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>POOR (4% lost)</th>
<th>Time (msec)</th>
<th>Strength (dBm)</th>
<th>SNR Quality</th>
<th>Retries</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>In</td>
<td>Out</td>
<td>In</td>
<td>Out</td>
</tr>
<tr>
<td>Sent: 100</td>
<td>Avg. 22</td>
<td>-37</td>
<td>-83</td>
<td>48</td>
</tr>
<tr>
<td>Lost to Tgt: 4</td>
<td>Max. 112</td>
<td>-34</td>
<td>-78</td>
<td>61</td>
</tr>
<tr>
<td>Lost to Src: 4</td>
<td>Min. 0</td>
<td>-40</td>
<td>-87</td>
<td>15</td>
</tr>
</tbody>
</table>

Rates (Src/Tgt) 24Mb 0/5 36Mb 25/0 48Mb 73/0 54Mb 2/91
Linktest Done in 24.464 msec
WGB Wired/Wireless Client

You can also use the following commands to know the summary of WGBs and clients associated with a Cisco lightweight access point:

(Cisco Controller) > `show wgb summary`
Number of WGBs.................. 2

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN</th>
<th>Auth</th>
<th>Protocol</th>
<th>Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:1d:70:97:bd:e8</td>
<td>209.165.200.225</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>2</td>
</tr>
<tr>
<td>00:1e:be:27:5f:e2</td>
<td>209.165.200.226</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>5</td>
</tr>
</tbody>
</table>

(Cisco Controller) > `show client summary`
Number of Clients............. 7

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN/Guest-Lan</th>
<th>Auth</th>
<th>Protocol</th>
<th>Port</th>
<th>Wired</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:24:ca:a9:b4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>N/A</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:3a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f8</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:0a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:42</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:71:d2</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
</tbody>
</table>

(Cisco Controller) > `show wgb detail 00:1e:be:27:5f:e2`
Number of wired client(s): 5

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Mobility</th>
<th>WLAN</th>
<th>Auth</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:16:c7:5d:b4:8f</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>00:21:91:f8:e9:ae</td>
<td>209.165.200.232</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:21:55:04:07:b5</td>
<td>209.165.200.234</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:1e:58:31:c7:4a</td>
<td>209.165.200.236</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:23:04:9a:0b:12</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
</tbody>
</table>

**Client Roaming**

High-speed roaming of Cisco Compatible Extension (CX), version 4 (v4) clients is supported at speeds up to 70 miles per hour in outdoor mesh deployments. An example application might be maintaining communication with a terminal in an emergency vehicle as it moves within a mesh public network.

Three Cisco CX v4 Layer 2 client roaming enhancements are supported:

- **Access point assisted roaming**—Helps clients save scanning time. When a Cisco CX v4 client associates to an access point, it sends an information packet to the new access point listing the characteristics of its previous access point. Roaming time decreases when the client recognizes and uses an access point list built by compiling all previous access points to which each client was associated and sent (unicast) to the client immediately after association. The access point list contains the channels, BSSIDs of neighbor access points that support the client’s current SSID(s), and time elapsed since disassociation.

- **Enhanced neighbor list**—Focuses on improving a Cisco CX v4 client’s roam experience and network edge performance, especially when servicing voice applications. The access point provides its associated client information about its neighbors using a neighbor-list update unicast message.

- **Roam reason report**—Enables Cisco CX v4 clients to report the reason why they roamed to a new access point. It also allows network administrators to build and monitor a roam history.

**Note**


**WGB Roaming Guidelines**

Follow these guidelines for WGB roaming:

- **Configuring a WGB for roaming**—If a WGB is mobile, you can configure it to scan for a better radio connection to a parent access point or bridge. Use the `ap(config-if)#mobile station period 3 threshold 50` command to configure the workgroup bridge as a mobile station.
When you enable this setting, the WGB scans for a new parent association when it encounters a poor Received Signal Strength Indicator (RSSI), excessive radio interference, or a high frame-loss percentage. Using these criteria, a WGB configured as a mobile station searches for a new parent association and roams to a new parent before it loses its current association. When the mobile station setting is disabled (the default setting), a WGB does not search for a new association until it loses its current association.

• Configuring a WGB for Limited Channel Scanning—In mobile environments such as railroads, a WGB instead of scanning all the channels is restricted to scan only a set of limited channels to reduce the hand-off delay when the WGB roams from one access point to another. By limiting the number of channels, the WGB scans only those required channels; the mobile WGB achieves and maintains a continuous wireless LAN connection with fast and smooth roaming. This limited channel set is configured using the `ap(config-if)#mobile station scan set of channels`.

This command invokes scanning to all or specified channels. There is no limitation on the maximum number of channels that can be configured. The maximum number of channels that can be configured is restricted only by the number of channels that a radio can support. When executed, the WGB scans only this limited channel set. This limited channel feature also affects the known channel list that the WGB receives from the access point to which it is currently associated. Channels are added to the known channel list only if they are also part of the limited channel set.

**Configuration Example**

The following example shows how to configure a roaming configuration:

```
ap(config)#interface dot11radio 1
ap(config-if)#ssid outside
ap(config-if)#packet retries 16
ap(config-if)#station role workgroup-bridge
ap(config-if)#mobile station
ap(config-if)#mobile station period 3 threshold 50
ap(config-if)#mobile station scan 5745 5765
```

Use the `no mobile station scan` command to restore scanning to all the channels.

**Troubleshooting Tips**

If a wireless client is not associated with a WGB, use the following steps to troubleshoot the problem:

1. Verify the client configuration and ensure that the client configuration is correct.
2. Check the `show bridge` command output in autonomous AP, and confirm that the AP is reading the client MAC address from the right interface.
3. Confirm that the subinterfaces corresponding to specific VLANs in different interfaces are mapped to the same bridge group.
4. If required, clear the bridge entry using the `clear bridge` command (remember that this command will remove all wired and wireless clients associated in a WGB and make them associate again).
5. Check the `show dot11 association` command output and confirm that the WGB is associated with the controller.
6. Ensure that the WGB has not exceeded its 20-client limitation.
In a normal scenario, if the `show bridge` and `show dot11 association` command outputs are as expected, wireless client association should be successful.

**Configuring Voice Parameters in Indoor Mesh Networks**

You can configure call admission control (CAC) and QoS on the controller to manage voice and video quality on the mesh network.

The indoor mesh access points are 802.11e capable, and QoS is supported on the local 2.4 and 5-GHz access radio and the 2.4 and 5-GHz access radio and the 2.4 and 5-GHz backhaul radio. CAC is supported on the backhaul and the CCXv4 clients (which provides CAC between the mesh access point and the client)

---

**Note**

Voice is supported only on indoor mesh networks. Voice is supported on a best-effort basis in the outdoors in a mesh network.

---

**Call Admission Control**

Call Admission Control (CAC) enables a mesh access point to maintain controlled quality of service (QoS) when the wireless LAN is experiencing congestion. The Wi-Fi Multimedia (WMM) protocol deployed in CCXv3 ensures sufficient QoS as long as the wireless LAN is not congested. However, to maintain QoS under differing network loads, CAC in CCXv4 or later is required.

---

**Note**


Two types of CAC are available for access points: bandwidth-based CAC and load-based CAC. All calls on a mesh network are bandwidth-based, so mesh access points use only bandwidth-based CAC.

Bandwidth-based, or static CAC enables the client to specify how much bandwidth or shared medium time is required to accept a new call. Each access point determines whether it is capable of accommodating a particular call by looking at the bandwidth available and compares it against the bandwidth required for the call. If there is not enough bandwidth available to maintain the maximum allowed number of calls with acceptable quality, the mesh access point rejects the call.

**Quality of Service and Differentiated Services Code Point Marking**

Cisco supports 802.11e on the local access and on the backhaul. Mesh access points prioritize user traffic based on classification, and therefore all user traffic is treated on a best-effort basis.

Resources available to users of the mesh vary, according to the location within the mesh, and a configuration that provides a bandwidth limitation in one point of the network can result in an oversubscription in other parts of the network.

Similarly, limiting clients on their percentage of RF is not suitable for mesh clients. The limiting resource is not the client WLAN, but the resources available on the mesh backhaul.
Similar to wired Ethernet networks, 802.11 WLANs employ Carrier Sense Multiple Access (CSMA), but instead of using collision detection (CD), WLANs use collision avoidance (CA), which means that instead of each station trying to transmit as soon as the medium is free, WLAN devices will use a collision avoidance mechanism to prevent multiple stations from transmitting at the same time.

The collision avoidance mechanism uses two values called CWmin and CWmax. CW stands for contention window. The CW determines what additional amount of time an endpoint should wait, after the interframe space (IFS), to attend to transmit a packet. Enhanced distributed coordination function (EDCF) is a model that allows end devices that have delay-sensitive multimedia traffic to modify their CWmin and CWmax values to allow for statically greater (and more frequent) access to the medium.

Cisco access points support EDCF-like QoS. This provides up to eight queues for QoS. These queues can be allocated in several different ways, as follows:

- Based on TOS / DiffServ settings of packets
- Based on Layer 2 or Layer 3 access lists
- Based on VLAN
- Based on dynamic registration of devices (IP phones)

AP1500s, with Cisco controllers, provide a minimal integrated services capability at the controller, in which client streams have maximum bandwidth limits, and a more robust differentiated services (diffServ) capability based on the IP DSCP values and QoS WLAN overrides.

When the queue capacity has been reached, additional frames are dropped (tail drop).

**Encapsulations**

Several encapsulations are used by the mesh system. These encapsulations include CAPWAP control and data between the controller and RAP, over the mesh backhaul, and between the mesh access point and its client(s). The encapsulation of bridging traffic (noncontroller traffic from a LAN) over the backhaul is the same as the encapsulation of CAPWAP data.

There are two encapsulations between the controller and the RAP. The first is for CAPWAP control, and the second is for CAPWAP data. In the control instance, CAPWAP is used as a container for control information.
and directives. In the instance of CAPWAP data, the entire packet, including the Ethernet and IP headers, is sent in the CAPWAP container.

**Figure 50: Encapsulations**

For the backhaul, there is only one type of encapsulation, encapsulating mesh traffic. However, two types of traffic are encapsulated: bridging traffic and CAPWAP control and data traffic. Both types of traffic are encapsulated in a proprietary mesh header.

In the case of bridging traffic, the entire packet Ethernet frame is encapsulated in the mesh header.

All backhaul frames are treated identically, regardless of whether they are MAP to MAP, RAP to MAP, or MAP to RAP.

**Figure 51: Encapsulating Mesh Traffic**

Mesh Data DTLS encryption is only supported on the wave 2 Mesh AP such as 1540 and 1560 models only.
Queuing on the Mesh Access Point

The mesh access point uses a high speed CPU to process ingress frames, Ethernet, and wireless on a first-come, first-serve basis. These frames are queued for transmission to the appropriate output device, either Ethernet or wireless. Egress frames can be destined for either the 802.11 client network, the 802.11 backhaul network, or Ethernet.

AP1500s support four FIFOs for wireless client transmissions. These FIFOs correspond to the 802.11e platinum, gold, silver, and bronze queues, and obey the 802.11e transmission rules for those queues. The FIFOs have a user configurable queue depth.

The backhaul (frames destined for another outdoor mesh access point) uses four FIFOs, although user traffic is limited to gold, silver, and bronze. The platinum queue is used exclusively for CAPWAP control traffic and voice, and has been reworked from the standard 802.11e parameters for CWmin, CWmax, and so on, to provide more robust transmission but higher latencies.

The 802.11e parameters for CWmin, CWmax, and so on, for the gold queue have been reworked to provide lower latency at the expense of slightly higher error rate and aggressiveness. The purpose of these changes is to provide a channel that is more conducive to video applications.

Frames that are destined for Ethernet are queued as FIFO, up to the maximum available transmit buffer pool (256 frames). There is support for a Layer 3 IP Differentiated Services Code Point (DSCP), so marking of the packets is there as well.

In the controller to RAP path for the data traffic, the outer DSCP value is set to the DSCP value of the incoming IP frame. If the interface is in tagged mode, the controller sets the 802.1Q VLAN ID and derives the 802.1p UP (outer) from 802.1p UP incoming and the WLAN default priority ceiling. Frames with VLAN ID 0 are not tagged.

![Figure 52: Controller to RAP Path](image)

For CAPWAP control traffic the IP DSCP value is set to 46, and the 802.1p user priority is set to 7. Prior to transmission of a wireless frame over the backhaul, regardless of node pairing (RAP/MAP) or direction, the DSCP value in the outer header is used to determine a backhaul priority. The following sections describe the mapping between the four backhaul queues the mesh access point uses and the DSCP values shown in Backhaul Path QoS.

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>Backhaul Queue</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 4, 6, 8 to 23</td>
<td>Bronze</td>
</tr>
<tr>
<td>26, 32 to 63</td>
<td>Gold</td>
</tr>
</tbody>
</table>
The platinum backhaul queue is reserved for CAPWAP control traffic, IP control traffic, and voice packets. DHCP, DNS, and ARP requests are also transmitted at the platinum QoS level. The mesh software inspects each frame to determine whether it is a CAPWAP control or IP control frame in order to protect the platinum queue from use by non-CAPWAP applications.

For a MAP to the client path, there are two different procedures, depending on whether the client is a WMM client or a normal client. If the client is a WMM client, the DSCP value in the outer frame is examined, and the 802.11e priority queue is used.

### Table 21: MAP to Client Path QoS

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>Backhaul Queue</th>
</tr>
</thead>
<tbody>
<tr>
<td>46 to 56</td>
<td>Platinum</td>
</tr>
<tr>
<td>All others including 0</td>
<td>Silver</td>
</tr>
</tbody>
</table>

If the client is not a WMM client, the WLAN override (as configured at the controller) determines the 802.11e queue (bronze, gold, platinum, or silver), on which the packet is transmitted.

For a client of a mesh access point, there are modifications made to incoming client frames in preparation for transmission on the mesh backhaul or Ethernet. For WMM clients, a MAP illustrates the way in which the outer DSCP value is set from an incoming WMM client frame.

### Figure 53: MAP to RAP Path

The minimum value of the incoming 802.11e user priority and the WLAN override priority is translated using the information listed in Table 22: DSCP to Backhaul Queue Mapping, on page 150 to determine the DSCP value of the IP frame. For example, if the incoming frame has as its value a priority indicating the gold priority,
but the WLAN is configured for the silver priority, the minimum priority of silver is used to determine the DSCP value.

**Table 22: DSCP to Backhaul Queue Mapping**

<table>
<thead>
<tr>
<th>DSCP Value</th>
<th>802.11e UP</th>
<th>Backhaul Queue</th>
<th>Packet Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>2, 4, 6, 8 to 23</td>
<td>1, 2</td>
<td>Bronze</td>
<td>Lowest priority packets, if any</td>
</tr>
<tr>
<td>26, 32 to 34</td>
<td>4, 5</td>
<td>Gold</td>
<td>Video packets</td>
</tr>
<tr>
<td>46 to 56</td>
<td>6, 7</td>
<td>Platinum</td>
<td>CAPWAP control, AWPP, DHCP/DNS, ARP packets, voice packets</td>
</tr>
<tr>
<td>All others including 0</td>
<td>0, 3</td>
<td>Silver</td>
<td>Best effort, CAPWAP data packets</td>
</tr>
</tbody>
</table>

If there is no incoming WMM priority, the default WLAN priority is used to generate the DSCP value in the outer header. If the frame is an originated CAPWAP control frame, the DSCP value of 46 is placed in the outer header.

With the 5.2 code enhancements, DSCP information is preserved in an AWPP header.

All wired client traffic is restricted to a maximum 802.1p UP value of 5, except DHCP/DNS and ARP packets, which go through the platinum queue.

The non-WMM wireless client traffic gets the default QoS priority of its WLAN. The WMM wireless client traffic may have a maximum 802.11e value of 6, but it must be below the QoS profile configured for its WLAN. If admission control is configured, WMM clients must use TSPEC signaling and get admitted by CAC.

The CAPWAPP data traffic carries wireless client traffic and has the same priority and treatment as wireless client traffic.

Now that the DSCP value is determined, the rules described earlier for the backhaul path from the RAP to the MAP are used to further determine the backhaul queue on which the frame is transmitted. Frames transmitted from the RAP to the controller are not tagged. The outer DSCP values are left intact, as they were first constructed.

**Bridging Backhaul Packets**

Bridging services are treated a little differently from regular controller-based services. There is no outer DSCP value in bridging packets because they are not CAPWAP encapsulated. Therefore, the DSCP value in the IP header as it was received by the mesh access point is used to index into the table as described in the path from the mesh access point to the mesh access point (backhaul).

**Bridging Packets from and to a LAN**

Packets received from a station on a LAN are not modified in any way. There is no override value for the LAN priority. Therefore, the LAN must be properly secured in bridging mode. The only protection offered to the mesh backhaul is that non-CAPWAP control frames that map to the platinum queue are demoted to the gold queue.

Packets are transmitted to the LAN precisely as they are received on the Ethernet ingress at entry to the mesh.
The only way to integrate QoS between Ethernet ports on AP1500 and 802.11a is by tagging Ethernet packets with DSCP. AP1500s take the Ethernet packet with DSCP and places it in the appropriate 802.11e queue. AP1500s do not tag DSCP itself:

- On the ingress port, the AP1500 sees a DSCP tag, encapsulates the Ethernet frame, and applies the corresponding 802.11e priority.
- On the egress port, the AP1500 decapsulates the Ethernet frame, and places it on the wire with an untouched DSCP field.

Ethernet devices, such as video cameras, should have the capability to mark the bits with DSCP value to take advantage of QoS.

---

**Note**

QoS only is relevant when there is congestion on the network.

---

**Guidelines For Using Voice on the Mesh Network**

Follow these guidelines when you use voice on the mesh network:

- Voice is supported only on indoor mesh networks. For outdoors, voice is supported on a best-effort basis on a mesh infrastructure.
- When voice is operating on a mesh network, calls must not traverse more than two hops. Each sector must be configured to require no more than two hops for voice.
- RF considerations for voice networks are as follows:
  - Coverage hole of 2 to 10 percent
  - Cell coverage overlap of 15 to 20 percent
  - Voice needs RSSI and SNR values that are at least 15 dB higher than data requirements
  - RSSI of -67 dBm for all data rates should be the goal for 11b/g/n and 11a/n
  - SNR should be 25 dB for the data rate used by client to connect to the AP
  - Packet error rate (PER) should be configured for a value of one percent or less
  - Channel with the lowest utilization (CU) must be used
- On the **802.11a/n/ac or 802.11b/g/n > Global** parameters page, do the following:
  - Enable dynamic target power control (DTPC).
  - Disable all data rates less than 11 Mbps.
- On the **802.11a/n/ac or 802.11b/g/n > Voice** parameters page, do the following:
  - Load-based CAC must be disabled.
  - Enable admission control (ACM) for CCXv4 or v5 clients that have WMM enabled. Otherwise, bandwidth-based CAC does not operate properly.
  - Set the maximum RF bandwidth to 50 percent.
• Set the reserved roaming bandwidth to 6 percent.
• Enable traffic stream metrics.

• On the 802.11a/n/ac or 802.11b/g/n > EDCA parameters page, you should do the following:
  • Set the EDCA profile for the interface as voice optimized.
  • Disable low latency MAC.

• On the QoS > Profile page, you should do the following:
  • Create a voice profile and select 802.1Q as the wired QoS protocol type.

• On the WLANs > Edit > QoS page, you should do the following:
  • Select a QoS of platinum for voice and gold for video on the backhaul.
  • Select allowed as the WMM policy.

• On the WLANs > Edit > QoS page, you should do the following:
  • Select CCKM for authorization (auth) key management (mgmt) if you want to support fast roaming.

• On the x > y page, you should do the following:
  • Disable voice active detection (VAD).

Voice Call Support in a Mesh Network

Table 23: Calls Possible with 1550 Series in 802.11a/n 802.11b/g/n Radios, on page 152 shows the actual calls in a clean, ideal environment.

Table 23: Calls Possible with 1550 Series in 802.11a/n 802.11b/g/n Radios

<table>
<thead>
<tr>
<th>No. of Calls</th>
<th>802.11a/n Radio 20 MHz</th>
<th>802.11a/n Radio 40 MHz</th>
<th>802.11b/g/n Backhaul Radio 20 MHz</th>
<th>802.11b/g/n Backhaul Radio 40 MHz</th>
</tr>
</thead>
<tbody>
<tr>
<td>RAP</td>
<td>20</td>
<td>35</td>
<td>20</td>
<td>20</td>
</tr>
<tr>
<td>MAP1 (First Hop)</td>
<td>10</td>
<td>20</td>
<td>15</td>
<td>20</td>
</tr>
<tr>
<td>MAP2 (Second Hop)</td>
<td>8</td>
<td>15</td>
<td>10</td>
<td>15</td>
</tr>
</tbody>
</table>

Traffic was bidirectional 64K voice flows. VoCoder type: G.711, PER <= 1%. Network setup was daisy-chained with no calls traversing more than 2 hops. No external interference.

While making a call, observe the MOS score of the call on the 7921 phone. A MOS score between 3.5 and 4 is acceptable.
Table 24: MOS Ratings

<table>
<thead>
<tr>
<th>MOS rating</th>
<th>User satisfaction</th>
</tr>
</thead>
<tbody>
<tr>
<td>&gt; 4.3</td>
<td>Very satisfied</td>
</tr>
<tr>
<td>4.0</td>
<td>Satisfied</td>
</tr>
<tr>
<td>3.6</td>
<td>Some users dissatisfied</td>
</tr>
<tr>
<td>3.1</td>
<td>Many users dissatisfied</td>
</tr>
<tr>
<td>&lt; 2.58</td>
<td></td>
</tr>
</tbody>
</table>

Enabling Mesh Multicast Containment for Video

You can use the controller CLI to configure three mesh multicast modes to manage video camera broadcasts on all mesh access points. When enabled, these modes reduce unnecessary multicast transmissions within the mesh network and conserve backhaul bandwidth.

Mesh multicast modes determine how bridging-enabled access points MAP and RAP send multicasts among Ethernet LANs within a mesh network. Mesh multicast modes manage non-CAPWAP multicast traffic only. CAPWAP multicast traffic is governed by a different mechanism.

The three mesh multicast modes are as follows:

- **Regular mode**—Data is multicast across the entire mesh network and all its segments by bridging-enabled RAP and MAP.

- **In-only mode**—Multicast packets received from the Ethernet by a MAP are forwarded to the RAP’s Ethernet network. No additional forwarding occurs, which ensures that non-CAPWAP multicasts received by the RAP are not sent back to the MAP Ethernet networks within the mesh network (their point of origin), and MAP to MAP multicasts do not occur because they are filtered out.

  **Note** When an HSRP configuration is in operation on a mesh network, we recommend the In-Out multicast mode be configured.

- **In-out mode**—The RAP and MAP both multicast but in a different manner:
  - In-out mode is the default mode.
  - If multicast packets are received at a MAP over Ethernet, they are sent to the RAP; however, they are not sent to other MAP over Ethernet, and the MAP to MAP packets are filtered out of the multicast.
  - If multicast packets are received at a RAP over Ethernet, they are sent to all the MAPs and their respective Ethernet networks. When the in-out mode is in operation, it is important to properly partition your network to ensure that a multicast sent by one RAP is not received by another RAP on the same Ethernet segment and then sent back into the network.
If 802.11b clients need to receive CAPWAP multicasts, then multicast must be enabled globally on the controller as well as on the mesh network (using the `config network multicast global enable` CLI command). If multicast does not need to extend to 802.11b clients beyond the mesh network, the global multicast parameter should be disabled (using the `config network multicast global disable` CLI command).

### Viewing the Voice Details for Mesh Networks (CLI)

Use the commands in this section to view details on voice and video calls on the mesh network:

**Figure 54: Mesh Network Example**

- To view the total number of voice calls and the bandwidth used for voice calls on each RAP, enter this command:

  `show mesh cac summary`

  Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>BW Used/Max</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
<td>2</td>
</tr>
</tbody>
</table>
• To view the mesh tree topology for the network and the bandwidth utilization (used/maximum available) of voice calls and video links for each mesh access point and radio, enter this command:

```bash
show mesh cac bwused {voice | video} AP_name
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>BW Used/Max</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>2032/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>3048/23437</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0/23437</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0/23437</td>
</tr>
</tbody>
</table>

The bars (|) to the left of the AP Name field indicate the number of hops that the MAP is from its RAP.

Note

When the radio type is the same, the backhaul bandwidth utilization (bw used/max) at each hop is identical. For example, mesh access points map1, map2, map3, and rap1 are all on the same radio backhaul (802.11a) and are using the same bandwidth (3048). All of the calls are in the same interference domain. A call placed anywhere in that domain affects the others.

• To view the mesh tree topology for the network and display the number of voice calls that are in progress by mesh access point radio, enter this command:

```bash
show mesh cac access AP_name
```

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
</tbody>
</table>
Each call received by a mesh access point radio causes the appropriate calls summary column to increment by one. For example, if a call is received on the 802.11b/g radio on map2, then a value of one is added to the existing value in that radio’s calls column. In this case, the new call is the only active call on the 802.11b/g radio of map2. If one call is active when a new call is received, the resulting value is two.

- To view the mesh tree topology for the network and display the voice calls that are in progress, enter this command:

\[ \text{show mesh cac callpath } \text{AP\_name} \]

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>1</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>1</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>1</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
</tbody>
</table>

- To view the mesh tree topology of the network, the voice calls that are rejected at the mesh access point radio due to insufficient bandwidth, and the corresponding mesh access point radio where the rejection occurred, enter this command:

\[ \text{show mesh cac rejected } \text{AP\_name} \]

Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Slot#</th>
<th>Radio</th>
<th>Calls</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>0</td>
<td>11b/g</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>0</td>
<td>11b/g</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>1</td>
<td>11a</td>
<td>0</td>
</tr>
</tbody>
</table>

- The calls column for each mesh access point radio in a call path increments by one. For example, for a call that initiates at map2 (show mesh cac callpath SB\_MAP2) and terminates at rap1 by way of map1, one call is added to the map2 802.11b/g and 802.11a radio calls column, one call to the map1 802.11a backhaul radio calls column, and one call to the rap1 802.11a backhaul radio calls column.

- If a call is rejected at the map2 802.11b/g radio, its calls column increments by one.
To view the number of bronze, silver, gold, platinum, and management queues active on the specified access point, enter this command. The peak and average length of each queue are shown as well as the overflow count.

**show mesh queue-stats AP_name**

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Queue Type</th>
<th>Overflows</th>
<th>Peak length</th>
<th>Average length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
<td>0</td>
<td>1</td>
<td>0.000</td>
</tr>
<tr>
<td>Gold</td>
<td>0</td>
<td>4</td>
<td>0.004</td>
</tr>
<tr>
<td>Platinum</td>
<td>0</td>
<td>4</td>
<td>0.001</td>
</tr>
<tr>
<td>Bronze</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Management</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
</tbody>
</table>

**Overflows**—The total number of packets dropped due to queue overflow.

**Peak Length**—The peak number of packets waiting in the queue during the defined statistics time interval.

**Average Length**—The average number of packets waiting in the queue during the defined statistics time interval.

### Enabling Multicast on the Mesh Network (CLI)

To enable multicast mode on the mesh network to receive multicasts from beyond the mesh networks, enter these commands:

```
config network multicast global enable
config mesh multicast {regular | in | in-out}
```

To enable multicast mode only the mesh network (multicasts do not need to extend to 802.11b clients beyond the mesh network), enter these commands:

```
config network multicast global disable
config mesh multicast {regular | in | in-out}
```

**Note**

Multicast for mesh networks cannot be enabled using the controller GUI.

### IGMP Snooping

IGMP snooping delivers improved RF usage through selective multicast forwarding and optimizes packet forwarding in voice and video applications.

A mesh access point transmits multicast packets only if a client is associated with the mesh access point that is subscribed to the multicast group. So, when IGMP snooping is enabled, only that multicast traffic relevant to given hosts is forwarded.

To enable IGMP snooping on the controller, enter the following command:

```
configure network multicast igmp snooping enable
```

A client sends an IGMP *join* that travels through the mesh access point to the controller. The controller intercepts the *join* and creates a table entry for the client in the multicast group. The controller then proxies the IGMP *join* through the upstream switch or router.
You can query the status of the IGMP groups on a router by entering the following command:

```
router# show ip gmp groups
IGMP Connected Group Membership

<table>
<thead>
<tr>
<th>Group Address</th>
<th>Interface</th>
<th>Uptime</th>
<th>Expires</th>
<th>Last Reporter</th>
</tr>
</thead>
<tbody>
<tr>
<td>233.0.0.1</td>
<td>Vlan119</td>
<td>3w1d</td>
<td>00:01:52</td>
<td>10.1.1.130</td>
</tr>
</tbody>
</table>
```

For Layer 3 roaming, an IGMP query is sent to the client’s WLAN. The controller modifies the client’s response before forwarding and changes the source IP address to the controller’s dynamic interface IP address.

The network hears the controller’s request for the multicast group and forwards the multicast to the new controller.

For more information about video, see the following:


### Locally Significant Certificates for Mesh APs

Until the 7.0 release, mesh APs supported only the Manufactured Installed Certificate (MIC) to authenticate and get authenticated by controllers to join the controller. You might have had to have your own public key infrastructure (PKI) to control CAs, to define policies, to define validity periods, to define restrictions and usages on the certificates that are generated, and get these certificates installed on the APs and controllers. After these customer-generated or locally significant certificates (LSCs) are present on the APs and controllers, the devices start using these LSCs, to join, authenticate, and derive a session key. Cisco supported normal APs from the 5.2 release and later releases and extended the support for mesh APs as well from the 7.0 release.

- Graceful fallback to MIC if APs are unable to join the controller with LSC certificates—Local APs try to join a controller with an LSC for the number of times that are configured on the controller (the default value is 3). After these trials, the AP deletes the LSC and tries to join a controller with an MIC.

Mesh APs try to join a controller with an LSC until its lonely timer expires and the AP reboots. The lonely timer is set for 40 minutes. After the reboot, the AP tries to join a controller with an MIC. If the AP is again not able to join a controller with an MIC in 40 minutes, the AP reboots and then tries to join a controller with an LSC.

**Note**

An LSC in mesh APs is not deleted. An LSC is deleted in mesh APs only when the LSC is disabled on the controller, which causes the APs to reboot.

- Over the air provisioning of MAPs.

### Guidelines for Configuration

Follow these guidelines when using LSCs for mesh APs:

- This feature does not remove any preexisting certificates from an AP. It is possible for an AP to have both LSC and MIC certificates.
• After an AP is provisioned with an LSC, it does not read in its MIC certificate on boot-up. A change from an LSC to an MIC will require the AP to reboot. APs do it for a fallback if they cannot be joined with an LSC.

• Provisioning an LSC on an AP does not require an AP to turn off its radios, which is vital for mesh APs, which may get provisioned over-the-air.

• Because mesh APs need a dot1x authentication, a CA and ID certificate is required to be installed on the server in the controller.

• LSC provisioning can happen over Ethernet and over-the-air in case of MAPs. You have to connect the mesh AP to the controller through Ethernet and get the LSC certificate provisioned. After the LSC becomes the default, an AP can be connected over-the-air to the controller using the LSC certificate.

Differences Between LSCs for Mesh APs and Normal APs

CAPWAP APs use LSC for DTLS setup during a JOIN irrespective of the AP mode. Mesh APs also use the certificate for mesh security, which involves a dot1x authentication with the controller through the parent AP. After the mesh APs are provisioned with an LSC, they need to use the LSC for this purpose because MIC will not be read in.

Mesh APs use a statically configured dot1x profile to authenticate. This profile is hardcoded to use "cisco" as the certificate issuer. This profile needs to be made configurable so that vendor certificates can be used for mesh authentication (enter the `config local-auth eap-profile cert-issuer vendor "prfMaP1500LlEAuth93"` command).

You must enter the `config mesh lsc enable/disable` command to enable or disable an LSC for mesh APs. This command will cause all the mesh APs to reboot.

Note

An LSC on mesh is open for very specific Oil and Gas customers with the 7.0 release. Initially, it is a hidden feature. The `config mesh lsc enable/disable` is a hidden command. Also, the `config local-auth eap-profile cert-issuer vendor "prfMaP1500LlEAuth93"` command is a normal command, but the "prfMaP1500LlEAuth93" profile is a hidden profile, and is not stored on the controller and is lost after the controller reboot.

Certificate Verification Process in LSC AP

LSC-provisioned APs have both LSC and MIC certificates, but the LSC certificate will be the default one. The verification process consists of the following two steps:

1. The controller sends the AP the MIC device certificate, which the AP verifies with the MIC CA.
2. The AP sends the LSC device certificate to the controller, which the controller verifies with the LSC CA.

Getting Certificates for LSC Feature

To configure LSC, you must first gather and install the appropriate certificates on the controller. The following steps show how to accomplish this using Microsoft 2003 Server as the CA server.
To get the certificates for LSC, follow these steps:

**Step 1**
Go to the CA server (http://<ip address of caserver/crtsrv) and login.

**Step 2**
Get the CA certificate as follows:
- a) Click the Download a CA certificate link, certificate chain, or CRF.
- b) Choose the encoding method as DER.
- c) Click the Download CA certificate link and use the save option to download the CA certificate on to your local machine.

**Step 3**
To use the certificate on the controller, convert the downloaded certificate to PEM format. You can convert this in a Linux machine using the following command:
```
# openssl x509 -in <input.cer> -inform DER -out <output.cer> -outform PEM
```

**Step 4**
Configure the CA certificate on the controller as follows:
- a) Choose COMMANDS > Download File.
- b) Choose the file type as Vendor CA Certificate from the File Type drop-down list.
- c) Update the rest of the fields with the information of the TFTP server where the certificate is located.
- d) Click Download.

**Step 5**
To install the Device certificate on the WLC, login to the CA server as mentioned in Step 1 and do the following:
- a) Click the Request a certificate link.
- b) Click the advanced certificate request link.
- c) Click Create and submit a request to this CA link.
- d) Go to the next screen and choose the Server Authentication Certificate from the Certificate Template drop-down list.
- e) Enter a valid name, email, company, department, city, state, and country/region. (Remember it in case you want the cap method to check the username against its database of user credentials).
  - **Note** The e-mail is not used.
- f) Enable Mark keys as exportable.
- g) Click Submit.
- h) Install the certificate on your laptop.

**Step 6**
Convert the device certificate obtained in the Step 5. To get the certificate, go to your internet browser options and choose exporting to a file. Follow the options from your browser to do this. You need to remember the password that you set here.
To convert the certificate, use the following command in a Linux machine:
```
# openssl pkcs12 -in <input.pfx> -out <output.cer>
```

**Step 7**
On the controller GUI, choose Command > Download File. Choose Vendor Device Certificate from the File Type drop-down list. Update the rest of the fields with the information of the TFTP server where the certificate is located and the password you set in the previous step and click Download.

**Step 8**
Reboot the controller so that the certificates can then be used.

**Step 9**
You can check that the certificates were successfully installed on the controller using this command:
```
show local-auth certificates
```

---


Locally Significant Certificates for Mesh APs
Configuring a Locally Significant Certificate (CLI)

To configure a locally significant certificate (LSC), follow these steps:

**Step 1**  
Enable LSC and provision the LSC CA certificate in the controller.

**Step 2**  
Enter the following command:  
`config local-auth eap-profile cert-issuer vendor prfMaP1500LiEAuth93`

**Step 3**  
Turn on the feature by entering the following command:  
`config mesh lsc {enable | disable}`
Step 4 Connect the mesh AP through Ethernet and provision for an LSC certificate.
Step 5 Let the mesh AP get a certificate and join the controller using the LSC certificate.

Figure 55: Local Significant Certificate Page

Figure 56: AP Policy Configuration
LSC-Related Commands

The following commands are related to LSCs:

- **config certificate lsc {enable | disable}**
  - `enable`—To enable an LSC on the system.
  - `disable`—To disable an LSC on the system. Use this keyword to remove the LSC device certificate and send a message to an AP, to do the same and disable an LSC, so that subsequent joins could be made using the MIC/SSC. The removal of the LSC CA cert on the WLC should be done explicitly by using the CLI to accommodate any AP that has not transitioned back to the MIC/SSC.

- **config certificate lsc ca-server url-path ip-address**
  Following is the example of the URL when using Microsoft 2003 server:
  
  http:<ip address of CA>/sertsrv/mscep/mscep.dll
  
  This command configures the URL to the CA server for getting the certificates. The URL contains either the domain name or the IP address, port number (typically=80), and the CGI-PATH:
  
  http://ipaddr:port/cgi-path
  
  Only one CA server is allowed to be configured. The CA server has to be configured to provision an LSC.

- **config certificate lsc ca-server delete**
  This command deletes the CA server configured on the controller.

- **config certificate lsc ca-cert {add | delete}**
  This command adds or deletes the LSC CA certificate into/from the controller's CA certificate database as follows:
  
  - `add`—Queries the configured CA server for a CA certificate using the SSCEP getca operation, and gets into the WLC and installs it permanently into the WLC database. If installed, this CA certificate is used to validate the incoming LSC device certificate from the AP.
  
  - `delete`—Deletes the LSC CA certificate from the WLC database.

- **config certificate lsc subject-params Country State City Orgn Dept Email**
  This command configures the parameters for the device certificate that will be created and installed on the controller and the AP.
  
  All of these strings have 64 bytes, except for the Country that has a maximum of 3 bytes. The Common Name is automatically generated using its Ethernet MAC address. This should be given prior to the creation of the controller device certificate request.
  
  The above parameters are sent as an LWAPP payload to the AP, so that the AP can use these parameters to generate the certReq. The CN is automatically generated on the AP using the current MIC/SSC “Cxxxx-MacAddr” format, where xxxx is the product number.

- **config certificate lsc other-params keysize**
  The default keysize value is 2048 bits.

- **config certificate lsc ap-provision {enable | disable}**
This command enables or disables the provisioning of the LSCs on the APs if the APs just joined using the SSC/MIC. If enabled, all APs that join and do not have the LSC will get provisioned. If disabled, no more automatic provisioning will be done. This command does not affect the APs, which already have LSCs in them.

• `config certificate lsc ra-cert {add | delete}`
  
  We recommend this command when the CA server is a Cisco IOS CA server. The controller can use the RA to encrypt the certificate requests and make communication more secure. RA certificates are not currently supported by other external CA servers, such as MSFT.
  
  * `add`—Queries the configured CA server for an RA certificate using the SCEP operation and installs it into the controller database. This keyword is used to get the certReq signed by the CA.
  
  * `delete`—Deletes the LSC RA certificate from the WLC database.

• `config auth-list ap-policy lsc {enable | disable}`
  
  After getting the LSC, an AP tries to join the controller. Before the AP tries to join the controller, you must mandatorily enter this command on the controller console. By default, the `config auth-list ap-policy lsc` command is in the disabled state, and the APs are not allowed to join the controller using the LSC.

• `config auth-list ap-policy mic {enable | disable}`
  
  After getting the MIC, an AP tries to join the controller. Before the AP tries to join the controller, you must mandatorily enter this command on the controller console. By default, the `config auth-list ap-policy mic` command is in the enabled state. If an AP cannot join because of the enabled state, this log message on the controller side is displayed: LSC/MIC AP is not allowed to join.

• `show certificate lsc summary`
  
  This command displays the LSC certificates installed on the WLC. It would be the CA certificate, device certificate, and optionally, an RA certificate if the RA certificate has also been installed. It also indicates if an LSC is enabled or not.

• `show certificate lsc ap-provision`
  
  This command displays the status of the provisioning of the AP, whether it is enabled or disabled, and whether a provision list is present or not.

• `show certificate lsc ap-provision details`
  
  This command displays the list of MAC addresses present in the AP provisioning lists.

**Controller GUI Security Settings**

Although the settings are not directly related to the feature, it might help you in achieving the desired behavior with respect to APs provisioned with an LSC.

• Case 1—Local MAC Authorization and Local EAP Authentication
  
  Add the MAC address of RAP/MAP to the controller MAC filter list.
  
  Example:

  ```
  (Cisco Controller) > config macfilter mac-delimiter colon
  (Cisco Controller) > config macfilter add 00:0b:85:60:92:30 0 management
  ```
Case 2—External MAC Authorization and Local EAP authentication

Enter the following command on the WLC:

(Cisco Controller) > \textbf{config mesh security rad-mac-filter enable}

or

Check only the external MAC filter authorization on the GUI page and follow these guidelines:

- Do not add the MAC address of the RAP/MAP to the controller MAC filter list.
- Configure the external radius server details on the WLC.
- Enter the \texttt{config macfilter mac-delimiter colon} command configuration on the WLC.
- Add the MAC address of the RAP/MAP in the external radius server in the following format:


\textbf{Deployment Guidelines}

- When using local authorization, the controller should be installed with the vendor's CA and device certificate.
- When using an external AAA server, the controller should be installed with the vendor's CA and device certificate.
- Mesh security should be configured to use 'vendor' as the cert-issuer.
- MAPs cannot move from an LSC to an MIC when they fall back to a backup controller.

The \texttt{config mesh lsc \{enable | disable\}} command is required to enable or disable an LSC for mesh APs. This command causes all the mesh APs to reboot.
CHAPTER 7

Checking the Health of the Network

This chapter describes how to check the health of a mesh network and contains the following sections:

- Show Mesh Commands, page 167
- Viewing Mesh Statistics for a Mesh Access Point, page 173
- Viewing Neighbor Statistics for a Mesh Access Point, page 177

Show Mesh Commands

The show mesh commands are grouped under the following sections:

- Viewing General Mesh Network Details
- Viewing Mesh Access Point Details
- Viewing Global Mesh Parameter Settings
- Viewing Bridge Group Settings
- Viewing VLAN Tagging Settings
- Viewing DFS Details
- Viewing Security Settings and Statistics
- Viewing GPS Status

Viewing General Mesh Network Details

To view general mesh network details, enter these commands:

- show mesh env {summary | AP_name}—Shows the temperature, heater status, and Ethernet status for either all access points (summary) or a specific access point (AP_name). The access point name, role (RootAP or MeshAP), and model are also shown.
  - The temperature is shown in both Fahrenheit and Celsius.
  - The heater status is ON or OFF.
The Ethernet status is UP or DOWN.

Note: The battery status appears as N/A (not applicable) in the `show mesh env AP_name` status display because it is not provided for access points.

(Cisco Controller) > `show mesh env summary`

<table>
<thead>
<tr>
<th>AP Name</th>
<th>Temperature(C/F)</th>
<th>Heater</th>
<th>Ethernet</th>
<th>Battery</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>39/102</td>
<td>OFF</td>
<td>UpDnNANA</td>
<td>N/A</td>
</tr>
<tr>
<td>SB_MAP1</td>
<td>37/98</td>
<td>OFF</td>
<td>DnDnNANA</td>
<td>N/A</td>
</tr>
<tr>
<td>SB_MAP2</td>
<td>42/107</td>
<td>OFF</td>
<td>DnDnNANA</td>
<td>N/A</td>
</tr>
<tr>
<td>SB_MAP3</td>
<td>36/96</td>
<td>OFF</td>
<td>DnDnNANA</td>
<td>N/A</td>
</tr>
</tbody>
</table>

(Cisco Controller) > `show mesh env SB_RAP1`

<table>
<thead>
<tr>
<th>AP Name</th>
<th>AP Model</th>
<th>AP Role</th>
<th>Temperature</th>
<th>Heater</th>
<th>Backhaul</th>
<th>GigabitEthernet0 Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>SB_RAP1</td>
<td>AIR-LAP1522AG-A-K9</td>
<td>RootAP</td>
<td>39 C, 102 F</td>
<td>OFF</td>
<td></td>
<td>UP</td>
</tr>
</tbody>
</table>

• `show mesh ap summary`—Revised to show the CERT MAC field that shows a MAC address within an AP certificate that can be used to assign a username for external authentication.

(Cisco Controller) > `show mesh ap summary`

<table>
<thead>
<tr>
<th>AP Name</th>
<th>AP Model</th>
<th>BVI MAC</th>
<th>CERT MAC</th>
<th>Hop Bridge Group Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>R1</td>
<td>LAP1520</td>
<td>00:0b:85:63:8a:10 00:0b:85:63:8a:10 0</td>
<td>y1</td>
<td></td>
</tr>
<tr>
<td>R2</td>
<td>LAP1520</td>
<td>00:0b:85:7b:c1:e0 00:0b:85:7b:c1:e0 1</td>
<td>y1</td>
<td></td>
</tr>
<tr>
<td>H2</td>
<td>AIR-LAP1522AG-A-K9 00:1a:a2:ff:f9:00 00:1b:d4:a6:f4:60 1</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Number of Mesh APs............................... 3
Number of RAP................................... 2
Number of MAP................................... 1

• `show mesh path`—Displays MAC addresses, access point roles, SNR ratios (dBs) for uplink and downlink (SNRUp, SNRDown) and link SNR for a particular path.

(Cisco Controller) > `show mesh path mesh-45-rap1`

<table>
<thead>
<tr>
<th>AP Name/Radio Mac Channel</th>
<th>Snr-Up</th>
<th>Snr-Down</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>mesh-45-rap1</td>
<td>165</td>
<td>15</td>
<td>10</td>
<td>16</td>
<td>0x86b UPDATED NEIGH PARENT BEACON</td>
</tr>
</tbody>
</table>

mesh-45-rap1 is a Root AP.
• **show mesh neighbor summary**—Displays summary information about mesh neighbors. Neighbor information includes MAC addresses, parent-child relationships, and uplink and downlink (SNRUp, SNRDown).

```
(Cisco Controller) > show mesh neighbor summary
ap1500:62:39:70
AP Name/Radio Mac Channel Snr-Up Snr-Down Link-Snr Flags State
mesh-45-rap1 165 15 18 16 0x86b UPDATED NEIGH PARENT BEACON
00:0B:85:80:ED:D0 149 5 6 5 0x1a60 NEED UPDATE BEACON DEFAULT
00:17:94:FE:C3:5F 149 7 0 0 0x860 BEACON
```

**Note**
After review of the **show mesh** commands above, you should be able to see the relationships between the nodes of your network and verify the RF connectivity by seeing the SNR values for every link.

• **show mesh ap tree**—Displays mesh access points within a tree structure (hierarchy).

```
(R1(0,y1)|-R2(1,y1)|-R6(2,y1)|-H2(1,default)
Number of Mesh APs............................... 4
Number of RAP................................... 1
Number of MAP................................... 3
```

### Viewing Mesh Access Point Details

To view a mesh access point’s configuration, enter these commands:

• **show ap config general [Cisco_AP]**—Displays system specifications for a mesh access point.

```
(Cisco Controller) > show ap config general aps
Cisco AP Identifier.............................. 1
Cisco AP Name.................................... AP5
Country code..................................... US - United States
Regulatory Domain allowed by Country......... 802.11bg:-AB 802.11a:-AB
AP Country code.................................. US - United States
AP Regulatory Domain............................. 802.11bg:-A 802.11a:-N
Switch Port Number .............................. 1
MAC Address...................................... 00:13:80:60:48:3e
IP Address Configuration......................... DHCP
IP Address....................................... 1.100.163.133
...
Primary Cisco Switch Name....................... 1-4404
Primary Cisco Switch IP Address................ 2.2.2.2
Secondary Cisco Switch Name.................... 1-4404
Secondary Cisco Switch IP Address............. 2.2.2.2
Tertiary Cisco Switch Name...................... 2-4404
Tertiary Cisco Switch IP Address.............. 1.1.1.4
```

• **show mesh astools stats [Cisco_AP]**—Displays anti-stranding statistics for all outdoor mesh access points or a specific mesh access point.

```
(Cisco Controller) > show mesh astools stats
Total No of Aps stranded : 0
> (Cisco Controller) > show mesh astools stats sb_map1
```

---

Total No of Aps stranded : 0

• **show advanced backup-controller**—Displays configured primary and secondary backup controllers.

(Cisco Controller) > show advanced backup-controller
AP primary Backup Controller .................... controller1 10.10.10.10
AP secondary Backup Controller ............... 0.0.0.0

• **show advanced timer**—Displays settings for system timers.

(Cisco Controller) > show advanced timer
Authentication Response Timeout (seconds)........ 10
Rogue Entry Timeout (seconds).................... 1300
AP Heart Beat Timeout (seconds).................. 30
AP Discovery Timeout (seconds)................... 10
AP Primary Discovery Timeout (seconds)......... 120

• **show ap slots**—Displays slot information for mesh access points.

(Cisco Controller) > show ap slots
Number of APs.................................... 3
AP Name Slots AP Model Slot0 Slot1 Slot2 Slot3
-------------------------------- ------ ------- ------ -----
R1 2 LAP1520 802.11A 802.11BG
H1 3 AIR-LAP1521AG-A-K9 802.11BG 802.11A 802.11A
H2 4 AIR-LAP1521AG-A-K9 802.11BG 802.11A 802.11A 802.11BG

**Viewing Global Mesh Parameter Settings**

Use this command to obtain information on global mesh settings:

• **show mesh config**—Displays global mesh configuration settings.

(Cisco Controller) > show mesh config
Mesh Range....................................... 12000
Backhaul with client access status................. disabled
Background Scanning State......................... enabled
Mesh Security
Security Mode..................................... EAP
External-Auth.................................... disabled
Use MAC Filter in External AAA server............. disabled
Force External Authentication..................... disabled
Mesh Alarm Criteria
Max Hop Count.................................... 4
Recommended Max Children for MAP............... 10
Recommended Max Children for RAP............... 20
Low Link SNR.................................... 12
High Link SNR................................... 60
Max Association Number.......................... 10
Association Interval............................ 60 minutes
Parent Change Numbers.......................... 3
Parent Change Interval.......................... 60 minutes
Mesh Multicast Mode............................. In-Out
Mesh Full Sector DFS............................ enabled
Mesh Ethernet Bridging VLAN Transparent Mode.... enabled
Viewing Bridge Group Settings

Use these commands to view bridge group settings:

- `show mesh forwarding table`—Shows all configured bridges and their MAC table entries.
- `show mesh forwarding interfaces`—Displays bridge groups and the interfaces within each bridge group. This command is useful for troubleshooting bridge group membership.

Viewing VLAN Tagging Settings

Use these commands to view VLAN tagging settings:

- `show mesh forwarding VLAN mode`—Shows the configured VLAN Transparent mode (enabled or disabled).
- `show mesh forwarding VLAN statistics`—Displays statistics for the VLAN and the path.
- `show mesh forwarding vlans`—Displays supported VLANs.
- `show mesh ethernet VLAN statistics`—Displays statistics for the Ethernet interface.

Viewing DFS Details

Use this command to view DFS details:

- `show mesh dfs history`—Displays a history of radar detections by channels and resulting outages.

```plaintext
(Cisco Controller) > show mesh dfs history
ap1520#show mesh dfs history
Channel 100 detects radar and is unusable (Time Elapsed: 18 day(s), 22 hour(s), 10 minute(s), 24 second(s)).
Channel is set to 136 (Time Elapsed: 18 day(s), 22 hour(s), 10 minute(s), 24 second(s)).
Channel 136 detects radar and is unusable (Time Elapsed: 18 day(s), 22 hour(s), 9 minute(s), 14 second(s)).
Channel is set to 161 (Time Elapsed: 18 day(s), 22 hour(s), 9 minute(s), 14 second(s)).
Channel 100 becomes usable (Time Elapsed: 18 day(s), 21 hour(s), 40 minute(s), 24 second(s)).
Channel 136 becomes usable (Time Elapsed: 18 day(s), 21 hour(s), 39 minute(s), 14 second(s)).
Channel 64 detects radar and is unusable (Time Elapsed: 0 day(s), 1 hour(s), 20 minute(s), 52 second(s)).
Channel 104 detects radar and is unusable (Time Elapsed: 0 day(s), 0 hour(s), 47 minute(s), 6 second(s)).
Channel is set to 120 (Time Elapsed: 0 day(s), 0 hour(s), 47 minute(s), 6 second(s)).
```

- `show mesh dfs channel channel number`—Displays a history of radar detections and outages for a specified channel.

```plaintext
(Cisco Controller) > show mesh dfs channel 104
ap1520#show mesh dfs channel 104
Channel 104 is available
Time elapsed since radar last detected: 0 day(s), 0 hour(s), 48 minute(s), 11 second(s).
```
Viewing Security Settings and Statistics

Use this command to view security settings and statistics:

- **show mesh security-stats AP_name**—Shows packet error statistics and a count of failures, timeouts, and successes with respect to associations and authentications as well as reassociations and re authentications for the specified access point and its child.

(Cisco Controller) > **show mesh security-stats ap417**

AP MAC : 00:0B:85:5F:FA:F0
Packet/Error Statistics:
-------------------------------
Tx Packets 14, Rx Packets 19, Rx Error Packets 0
Parent-Side Statistics:
-------------------------
Unknown Association Requests 0
Invalid Association Requests 0
Unknown Re-Authentication Requests 0
Invalid Re-Authentication Requests 0
Unknown Re-Association Requests 0
Unknown Re-Association Requests 0
Unknown Re-Association Requests 0
Invalid Re-Association Requests 0
Child-Side Statistics:
----------------------
Association Failures 0
Association Timeouts 0
Association Successes 0
Authentication Failures 0
Authentication Timeouts 0
Authentication Successes 0
Re-Association Failures 0
Re-Association Timeouts 0
Re-Association Successes 0
Re-Authentication Failures 0
Re-Authentication Timeouts 0
Re-Authentication Successes 0

Viewing GPS Status

- See location summary of all APs by entering this command:
  **show ap gps location summary**
See a location summary of all mesh APs by entering this command:

```
show mesh gps location summary
```

See the location information for a particular mesh AP by entering this command:

```
show mesh gps location ap-name
```

### Viewing Mesh Statistics for a Mesh Access Point

This section describes how to use the controller GUI or CLI to view mesh statistics for specific mesh access points.

#### Note

You can modify the Statistics Timer interval setting on the All APs > Details page of the controller GUI.

#### Viewing Mesh Statistics for a Mesh Access Point (GUI)

1. **Step 1**
   
   Choose **Wireless > Access Points > All APs** to open the All APs page.

2. **Step 2**
   
   To view statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the desired mesh access point and choose **Statistics**. The **All APs > AP Name > Statistics** page for the selected mesh access point appears. This page shows the role of the mesh access point in the mesh network, the name of the bridge group to which the mesh access point belongs, the backhaul interface on which the access point operates, and the number of the physical switch port. It also displays a variety of mesh statistics for this mesh access point.
Table 25: Mesh Access Point Statistics

<table>
<thead>
<tr>
<th>Statistics</th>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Mesh Node Stats</strong></td>
<td>Malformed Neighbor Packets</td>
<td>The number of malformed packets received from the neighbor. Examples of malformed packets include malicious floods of traffic such as malformed or short DNS packets and malformed DNS replies.</td>
</tr>
<tr>
<td></td>
<td>Poor Neighbor SNR Reporting</td>
<td>The number of times the signal-to-noise ratio falls below 12 dB on the backhaul link.</td>
</tr>
<tr>
<td></td>
<td>Excluded Packets</td>
<td>The number of packets received from excluded neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Insufficient Memory Reporting</td>
<td>The number of insufficient memory conditions.</td>
</tr>
<tr>
<td></td>
<td>Rx Neighbor Requests</td>
<td>The number of broadcast and unicast requests received from the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Rx Neighbor Responses</td>
<td>The number of responses received from the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Tx Neighbor Requests</td>
<td>The number of unicast and broadcast requests sent to the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Tx Neighbor Responses</td>
<td>The number of responses sent to the neighbor mesh access points.</td>
</tr>
<tr>
<td></td>
<td>Parent Changes Count</td>
<td>The number of times a mesh access point (child) moves to another parent.</td>
</tr>
<tr>
<td></td>
<td>Neighbor Timeouts Count</td>
<td>The number of neighbor timeouts.</td>
</tr>
<tr>
<td><strong>Queue Stats</strong></td>
<td>Gold Queue</td>
<td>The average and peak number of packets waiting in the gold (video) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Silver Queue</td>
<td>The average and peak number of packets waiting in the silver (best effort) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Platinum Queue</td>
<td>The average and peak number of packets waiting in the platinum (voice) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Bronze Queue</td>
<td>The average and peak number of packets waiting in the bronze (background) queue during the defined statistics time interval.</td>
</tr>
<tr>
<td></td>
<td>Management Queue</td>
<td>The average and peak number of packets waiting in the management queue during the defined statistics time interval.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Mesh Node Security</strong></td>
<td><strong>Stats</strong></td>
<td></td>
</tr>
<tr>
<td>Transmitted Packets</td>
<td></td>
<td>The number of packets transmitted during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td>Received Packets</td>
<td></td>
<td>The number of packets received during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td>Association Request</td>
<td>Failures</td>
<td>The number of association request failures that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Association Request</td>
<td>Timeouts</td>
<td>The number of association request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Association Requests</td>
<td>Successful</td>
<td>The number of successful association requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Authentication Request</td>
<td>Failures</td>
<td>The number of failed authentication requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Authentication Request</td>
<td>Timeouts</td>
<td>The number of authentication request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Authentication Requests</td>
<td>Successful</td>
<td>The number of successful authentication requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reassociation Request</td>
<td>Failures</td>
<td>The number of failed reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reassociation Request</td>
<td>Timeouts</td>
<td>The number of reassociation request timeouts between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reassociation Requests</td>
<td>Successful</td>
<td>The number of successful reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Request</td>
<td>Failures</td>
<td>The number of failed reauthentication requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Request</td>
<td>Timeouts</td>
<td>The number of reauthentication request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Requests</td>
<td>Successful</td>
<td>The number of successful reauthentication requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Unknown Association</td>
<td>Requests</td>
<td>The number of unknown association requests received by the parent mesh access point from its child. The unknown association requests often occur when a child is an unknown neighbor mesh access point.</td>
</tr>
<tr>
<td>Statistics</td>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Association Requests</td>
<td>Invalid Association Requests</td>
<td>The number of invalid association requests received by the parent mesh access point from the selected child mesh access point. This state may occur when the selected child is a valid neighbor but is not in a state that allows association.</td>
</tr>
<tr>
<td>Mesh Node Security Stats (continued)</td>
<td>Unknown Reauthentication Requests</td>
<td>The number of unknown reauthentication requests received by the parent mesh access point node from its child. This state may occur when a child mesh access point is an unknown neighbor.</td>
</tr>
<tr>
<td></td>
<td>Invalid Reauthentication Requests</td>
<td>The number of invalid reauthentication requests received by the parent mesh access point from a child. This state may occur when a child is a valid neighbor but is not in a proper state for reauthentication.</td>
</tr>
<tr>
<td></td>
<td>Unknown Reassociation Requests</td>
<td>The number of unknown reassociation requests received by the parent mesh access point from a child. This state may occur when a child mesh access point is an unknown neighbor.</td>
</tr>
<tr>
<td></td>
<td>Invalid Reassociation Requests</td>
<td>The number of invalid reassociation requests received by the parent mesh access point from a child. This state may occur when a child is a valid neighbor but is not in a proper state for reassociation.</td>
</tr>
</tbody>
</table>

### Viewing Mesh Statistics for an Mesh Access Point (CLI)

Use these commands to view mesh statistics for a specific mesh access point using the controller CLI:

- To view packet error statistics, a count of failures, timeouts, and successes with respect to associations and authentications, and reassociations and reauthentications for a specific mesh access point, enter this command:

  ```
  show mesh security-stats AP_name
  ```

  Information similar to the following appears:

  ```
  AP MAC : 00:0B:85:5F:FA:F0
  Packet/Error Statistics:
  --------------------------
  x Packets 14, Rx Packets 19, Rx Error Packets 0
  Parent-Side Statistics:
  --------------------------
  Unknown Association Requests 0
  Invalid Association Requests 0
  Unknown Re-Authentication Requests 0
  Invalid Re-Authentication Requests 0
  Unknown Re-Association Requests 0
  Invalid Re-Association Requests 0
  Unknown Re-Assocation Requests 0
  ```
Invalid Re-Association Requests 0

Child-Side Statistics:
--------------------------
Association Failures 0
Association Timeouts 0
Association Successes 0
Authentication Failures 0
Authentication Timeouts 0
Authentication Successes 0
Re-Association Failures 0
Re-Association Timeouts 0
Re-Association Successes 0
Re-Authentication Failures 0
Re-Authentication Timeouts 0
Re-Authentication Successes 0

• To view the number of packets in the queue by type, enter this command:

    show mesh queue-stats AP_name

Information similar to the following appears:

<table>
<thead>
<tr>
<th>Queue Type</th>
<th>Overflows</th>
<th>Peak length</th>
<th>Average length</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver</td>
<td>0</td>
<td>1</td>
<td>0.000</td>
</tr>
<tr>
<td>Gold</td>
<td>0</td>
<td>4</td>
<td>0.004</td>
</tr>
<tr>
<td>Platinum</td>
<td>0</td>
<td>4</td>
<td>0.001</td>
</tr>
<tr>
<td>Bronze</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
<tr>
<td>Management</td>
<td>0</td>
<td>0</td>
<td>0.000</td>
</tr>
</tbody>
</table>

Overflows—The total number of packets dropped due to queue overflow.

Peak Length—The peak number of packets waiting in the queue during the defined statistics time interval.

Average Length—The average number of packets waiting in the queue during the defined statistics time interval.

**Viewing Neighbor Statistics for a Mesh Access Point**

This section describes how to use the controller GUI or CLI to view neighbor statistics for a selected mesh access point. It also describes how to run a link test between the selected mesh access point and its parent.

**Viewing Neighbor Statistics for a Mesh Access Point (GUI)**

**Step 1** Choose **Wireless > Access Points > All APs** to open the All APs page.

**Step 2** To view neighbor statistics for a specific mesh access point, hover the mouse over the blue drop-down arrow for the desired mesh access point and choose **Neighbor Information**. The All APs > **Access Point Name** > Neighbor Info page for the selected mesh access point appears. This page lists the parent, children, and neighbors of the mesh access point. It provides each mesh access point’s name and radio MAC address.

**Step 3** To perform a link test between the mesh access point and its parent or children, follow these steps:
Viewing the Neighbor Statistics for a Mesh Access Point (CLI)

Use these commands to view neighbor statistics for a specific mesh access point using the controller CLI.

- To view the mesh neighbors for a specific mesh access point, enter this command:

  \[\text{show mesh neigh \{detail | summary\} AP\_Name}\]

  Information similar to the following appears when you request a summary display:

<table>
<thead>
<tr>
<th>AP Name/Radio Mac</th>
<th>Channel</th>
<th>Snr-Up</th>
<th>Snr-Down</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>mesh-45-rap1</td>
<td>165</td>
<td>15</td>
<td>18</td>
<td>16</td>
<td>0x86b</td>
<td>UPDATED NEIGH PARENT BEACON</td>
</tr>
<tr>
<td>00:0B:85:80:ED:D0</td>
<td>149</td>
<td>5</td>
<td>6</td>
<td>5</td>
<td>0x1a60</td>
<td>NEED UPDATE BEACON DEFAULT</td>
</tr>
<tr>
<td>00:17:94:FE:C3:5F</td>
<td>149</td>
<td>7</td>
<td>0</td>
<td>0</td>
<td>0x860</td>
<td>BEACON</td>
</tr>
</tbody>
</table>

- To view the channel and signal-to-noise ratio (SNR) details for a link between a mesh access point and its neighbor, enter this command:

  \[\text{show mesh path AP\_Name}\]

  Information similar to the following appears:

<table>
<thead>
<tr>
<th>AP Name/Radio Mac</th>
<th>Channel</th>
<th>Snr-Up</th>
<th>Snr-Down</th>
<th>Link-Snr</th>
<th>Flags</th>
<th>State</th>
</tr>
</thead>
<tbody>
<tr>
<td>mesh-45-rap1</td>
<td>165</td>
<td>15</td>
<td>18</td>
<td>16</td>
<td>0x86b</td>
<td>UPDATED NEIGH PARENT BEACON</td>
</tr>
<tr>
<td>mesh-45-rap1</td>
<td>is a Root AP.</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

- To view the percentage of packet errors for packets transmitted by the neighbor mesh access point, enter this command:

  \[\text{show mesh per-stats AP\_Name}\]

  Information similar to the following appears:

  Neighbor MAC Address 00:0B:85:5F:FA:F0
  Total Packets transmitted: 104833
  Total Packets transmitted successfully: 104833
Total Packets retried for transmission: 33028
Neighbor MAC Address 00:0B:85:80:ED:D0
Total Packets transmitted: 0
Total Packets transmitted successfully: 0
Total Packets retried for transmission: 0

Neighbor MAC Address 00:17:94:FE:C3:5F
Total Packets transmitted: 0
Total Packets transmitted successfully: 0
Total Packets retried for transmission: 0

Note
Packet error rate percentage = 1 – (number of successfully transmitted packets/number of total packets transmitted).
Viewing the Neighbor Statistics for a Mesh Access Point (CLI)
Troubleshooting

This chapter describes troubleshooting information and contains the following section:

- Installation and Connections, page 181

Installation and Connections

**Step 1**
Connect the mesh access point that you want to be the RAP to the controller.

**Step 2**
Deploy the radios (MAP) at the desired locations.

**Step 3**
On the controller CLI, enter the `show mesh ap summary` command to see all MAPs and RAPs on the controller.

*Figure 57: Show Mesh AP Summary Page*
Step 4  On the controller GUI, click **Wireless** to see the mesh access point (RAP and MAP) summary.

*Figure 58: All APs Summary Page*

<table>
<thead>
<tr>
<th>All APs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search by AP MAC [ ] Search</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>AP Name</th>
<th>AP MAC</th>
<th>AP Up Time</th>
<th>Admin Status</th>
<th>Operational Status</th>
<th>AP Node</th>
<th>Certific</th>
</tr>
</thead>
</table>

Step 5  Click **AP Name** to see the details page and then select the **Interfaces** tab to see the active radio interfaces. The radio slot in use, radio type, subband in use, and operational status (UP or DOWN) are summarized.

- All APs supports 2 radio slots: slot 0—2.4 GHz and slot 1—5 GHz.

  If you have more than one controller connected to the same mesh network, then you must specify the name of the primary controller using global configuration for every mesh access point or specify the primary controller on every node, otherwise the least loaded controller is the preferred controller. If the mesh access points were previously connected to a controller, they already have learned a controller’s name.

  After configuring the controller name, the mesh access point reboots.

Step 6  Click **Wireless > AP Name** to check the mesh access point’s primary controller on the AP details page.

---

**Debug Commands**

The following two commands are very helpful to see the messages being exchanged between mesh access points and the controller.

\[(Cisco\ Controller)\ >\ \texttt{debug capwap events enable}\]
\[(Cisco\ Controller)\ >\ \texttt{debug disable-all}\]

You can use the **debug** command to see the flow of packet exchanges that occur between the mesh access point and the controller. The mesh access point initiates the discovery process. An exchange of credentials takes place during the join phase to authenticate that the mesh access point is allowed to join the mesh network.

Upon a successful join completion, the mesh access point sends a CAPWAP configuration request. The controller responds with a configuration response. When a Configure Response is received from the controller, the mesh access point evaluates each configuration element and then implements them.
Remote Debug Commands

You can log on to the mesh access point console for debugging either through a direct connection to the AP console port or through the remote debug feature on the controller.

To invoke remote debug on the controller, enter the following commands:

(Cisco Controller) > debug ap enable ap-name
(Cisco Controller) > debug ap command command ap-name

AP Console Access

AP1500s have a console port. A console cable is not shipped with the mesh access point. For the 1550 series access points, console ports are easily accessible and you need not open the access point box.

The AP1500s have console access security embedded in the code to prevent unauthorized access on the console port and provide enhanced security.

The **login ID** and **password** for console access are configured from the controller. You can use the following commands to push the username/password combination to the specified mesh access point or all access points:

```
<Cisco Controller> config ap username cisco password cisco ?
```

- **all**: Configures the Username/Password for all connected APs.
- **<Cisco AP>**: Enter the name of the Cisco AP.

```
<Cisco Controller> config ap username cisco password cisco all
```

You must verify whether the username/password pushed from the controller is used as **user-id** and **password** on the mesh access point. It is a nonvolatile setting. Once set, a **login ID** and **password** are saved in the private configuration of the mesh access point.

Once you have a successful login, the trap is sent to the Cisco Prime Infrastructure. If a user fails to log on three times consecutively, login failure traps are sent to the controller and Cisco Prime Infrastructure.

---

**Caution**

A mesh access point must be reset to the factory default settings before moving from one location to another.

<table>
<thead>
<tr>
<th>Hardware Reset</th>
<th>Set to Factory Defaults</th>
</tr>
</thead>
<tbody>
<tr>
<td>Perform a hardware reset on this AP</td>
<td>Clear configuration on this AP and reset it to factory defaults</td>
</tr>
</tbody>
</table>

---

Cable Modem Serial Port Access From an AP

Commands can be sent to the cable modem from the privileged mode of the CLI. Use the command to take a text string and send it to the cable modem UART interface. The cable modem interprets the text string as one of its own commands. The cable modem response is captured and displayed on the Cisco IOS console.
Up to 9600 characters are displayed from the cable modem. Any text that is greater than 4800 characters is truncated.

The modem commands are only operational on mesh APs that have devices connected to the UART port originally intended for the cable modem. If the commands are used on a mesh AP that does not have a cable modem (or any other device connected to the UART), the commands are accepted, however, but they do not produce any returned output. No errors are explicitly flagged.

**Configuration**

Enter the following command from the privileged mode of the MAP:

```
AP# send cmodem timeout-value modem-command
```
The modem command is any command or text to send to the cable modem. The range of timeout value is 1 to 300 seconds. However, if the captured data equals 9600 characters, any text beyond that is truncated and the response, irrespective of the timeout value and is immediately displayed on the AP console.

Figure 59: Cable Modem Console Access Command

```
RAP-CM-N1# send ?
* All tty lines
<0-15> Send a message to a specific line
cmodem Enter cable modem command
core Console Primary terminal line
log Logging destinations
vty Virtual terminal

RAP-CM-N1# send cmodem ?
LINE Enter modem command string
<cr>
```

Figure 60: Cable Modem Console Access Command

```
RAP-CM-N1# send cmodem ls
ls
CM>
CM> ls

find command help history instances ls
man pwd sleep syntax system_time
usage
--
rm
rmShow memShow mutex_debug ping read_memory
reset routeShow run_app shell stackShow
start_idle_profiling stop_idle_profiling taskDelete
taskInfo taskPrioritySet taskResume taskShow taskSuspend
taskTrace ufsmShow version write_memory zone

[loopback] [8A] [cm_hal] [dcsis_ctl] [embedded_target] [enct_hal]
[event_log] [flash] [forwarder] [ip_hal] [msg_log] [non-vol] [ping_helper]
[snap] [snoop] [usb_hal]

CM>
RAP-CM-N1# send cmodem cd docsis
cd
CM>
CM> cd docsis
CM> cd docsis

Active Command Table: CM DOCISIS Control Thread Commands (docsis_ctl)

CM -> docsis_ctl
CM/docsisCtl>
RAP-CM-N1#
```
Enabling the Cable Modem Console Port

By default, the Cable Modem console port is disabled. This is to prevent users from accessing the console through their residential cable modem. In the AP1572IC, AP1572EC, and AP1552C model, the cable modem console is connected directly to the access point. The console port is required for signaling between the AP and the cable modem. There are two methods to enable the cable modem console port, either through SNMP or by adding the command to the configuration .cm file on the CMTS.

Note: For the AP1572EC, AP1572IC, AP1552C, and AP1552CU, the cable modem must be enabled.

- Enable the cable modem console port through SNMP by entering this command to the IP address of the cable modem:
  
  \[ \text{snmpset} \ -c \ \text{private} \ \text{IPADDRESS} \ \text{cmConsoleMode}.0 \ \text{i} \ \text{N} \]

  Using the OID, enter this command:
  
  \[ \text{snmpset} \ -c \ \text{private} \ \text{IPADDRESS} \ 1.3.6.1.4.1.1429.77.1.4.7.0 \ \text{i} \ \text{N} \]

  Where IP_ADDRESS is any IPv4 address and N is an integer, 2 to enable read-write, 1 for read-only, or 0 to disable.

  Example:
  
  \[ \text{snmpset} \ -c \ \text{private} \ 209.165.200.224 \ \text{cmConsoleMode}.0 \ \text{i} \ 2 \]

- Enable the cable modem console port through the configuration file. The configuration file (with a .cm extension) is loaded into the cable modem head end. It is pushed to the cable modem as part of the join process. Enter the following line to the cable modem configuration file:
  
  \[ \text{SA-CM-MIB::cmConsoleMode}.0 = \text{INTEGER}: \text{readWrite}(2) \]

  Using the OID, enter this line:
  
  \[ \text{SA-CM-MIB::cmConsoleMode}.0 = \text{INTEGER}: \text{readWrite}(2) \]

Resetting the AP1572xC/AP1552C Through the Cable Modem

An AP can be reset by entering an SNMP command to the Cable Modem, which resides inside the access point. For this feature to work, you must enable the cable modem console port.

Reset the AP by entering this snmpset command:

\[ \text{snmpset} \ -v2c \ -c \ \text{public} \ \text{IP ADDRESS} \ 1.3.6.1.4.1.1429.77.1.3.17.0 \ \text{i} \ 1 \]

Where the IP ADDRESS is the IPv4 address of the cable modem.

Mesh Access Point CLI Commands

You can enter these commands directly on the mesh access point using the AP console port or you can use the remote debug feature from the controller:
Troubleshooting

Mesh Access Point CLI Commands

H1 • show llbsh?
adjacency  l'ESH Adjacency
astools    l'ESH Anti-strand tools
backhaul   l'ESH backhaul
channel    l'ESH channel
canfig     l'ESH config parameter
dfs        l'ESH dfs information
ethernet   sllou nesh Ethernet bridging
forwarding l'ESH Forwarding
inventory  platform inventory
linktest   l'ESH linktest stats
module     l'ESH module detail
npnrf      l'ESH SN tool
security   l'ESH Security show
simulation f111SH simulated configuration
status     l'ESH status

HJRAP1lleliou nesh config
rtshresholdl1a 0,eHo 0,a.1lin 0, col lex 0
trshresholdl1bg 0,aifs 0,a.1Hin 0,a.1lax 0
huRetries 0.1iri<Rate 0 qOepth 0
802.11MAtient Statistics Push Int. al: 3
range parameter: 12000
nesh security node: 0
Universal Client Access: disabled
public global state: enabled
Battery backup state: enabled
multicast node: in-out
Full Sector DFS: enabled
Troubleshooting

Mesh Access Point CLI Commands

```
HJRAP11lehou caploBP client m0
AdminState         ADHIN ENABLED
Server             S.2.98.0
NumPl1 ledSlots    2
Name               HJRAP1
Location           default location
Username           209.165.200.227
Huart.Net          0.0.0.0
ApHole             Brl!JE!
ApSub:1ode         Not configured
OperationState     UP
CAPllN'Path MlU   1485
Link:Util:igting   disabled
ApRole             RootAP
ApBac:khaul        802.11a
ApBac:khaul:channel 5805
ApBac:khaul:Slot   1
ApBac:khaul:1igEnabled 0
ApBac:<khaul:1xRate 24000
Ethernet Brldq1rg State enabled
Public Safety State
```

```
HJRAP11lehou. I mesh adjacency ?
        all       MESH Adjacency all
   child    MESH Adjacency child
      parent MESH Adjacency Parent
```

```
HJRAP11lehou mesh status ?
  mesh MESH Status
MeshAP in status Point
Up/Link Backbone: Virtual-Dot11Radio0
Down/Link Backbone: Dot11Radio1
Configured RSSI NULL:
  received 127500 delivered 66370 broadcast 127530
  received 1142575 delivered 202800
  nochannels 0 client 0 downstream 0 downstream 0 parent 0
  nextPower 1, and-forward 1 packets 1, packet ignored 1
  blacklisted 0, insufficient inventory 0, authentication failures 0
  Parent Changes 3, Neighbor Timeout 0
  Vector through 0017.9ffe.03bf
      Vector case 1-1, MAC: 0017.9ffe.03bf
```
Mesh Access Point Debug Commands

You can enter these commands directly on the mesh access point using the AP console port or you can use the remote debug feature from the controller.

- **debug mesh ethernet bridging**—Debugs Ethernet bridging.
- **debug mesh ethernet config**—Debugs access and trunk port configuration associated with VLAN tagging.
- **debug mesh ethernet registration**—Debugs the VLAN registration protocol. This command is associated with VLAN tagging.
- **debug mesh forwarding table**—Debugs the forwarding table containing bridge groups.
- **debugs mesh forwarding packet bridge-group**—Debugs the bridge group configuration.

Defining Mesh Access Point Role

By default, AP1500s are shipped with a radio role set to MAP. You must reconfigure a mesh access point to act as a RAP.

Backhaul Algorithm

A **backhaul** is used to create only the wireless connection between mesh access points.

The backhaul interface by default is 802.11a. You cannot change the backhaul interface to 802.11b/g.

The "auto" data rate is selected by default for AP1500s.

The backhaul algorithm has been designed to fight against stranded mesh access point conditions. This algorithm also adds a high-level of resiliency for each mesh node.

The algorithm can be summarized as follows:

- A MAP always sets the Ethernet port as the **primary backhaul** if it is UP; otherwise, it is the 802.11a radio (this feature gives the network administrator the ability to configure it as a RAP the first time and recover it in-house). For fast convergence of the network, we recommend that you do not connect any Ethernet device to the MAP for its initial joining to the mesh network.
- A MAP failing to connect to a WLAN controller on an Ethernet port that is UP, sets the 802.11a radio as the **primary backhaul**. Failing to find a neighbor or failing to connect to a WLAN controller via any
neighbor on the 802.11a radio causes the primary backhaul to be UP on the Ethernet port again. A MAP gives preference to the parent which has the same BGN.

- A MAP connected to a controller over an Ethernet port does not build a mesh topology (unlike a RAP).
- A RAP always sets the Ethernet port as the primary backhaul.
- If the Ethernet port on a RAP is DOWN, or a RAP fails to connect to a controller on an Ethernet port that is UP, the 802.11a radio is set as the primary backhaul. Failing to find a neighbor or failing to connect to a controller via any neighbor on the 802.11a radio makes the RAP go to the SCAN state after 15 minutes and starts with the Ethernet port first.

Keeping the roles of mesh nodes distinct using the above algorithm greatly helps to avoid a mesh access point from being in an unknown state and becoming stranded in a live network.

**Passive Beaconing (Anti-Stranding)**

When enabled, passive beaconing allows a stranded mesh access point to broadcast its debug messages over-the-air using a 802.11b/g radio. A neighboring mesh access point that is listening to the stranded mesh access point and has a connection to a controller, can pass those messages to the controller over CAPWAP. Passive beaconing prevents a mesh access point that has no wired connection from being stranded.

Debug logs can also be sent as distress beacons on a nonbackhaul radio so that a neighboring mesh access point can be dedicated to listen for the beacons.

The following steps are automatically initiated at the controller when a mesh access point loses its connection to the controller:

- Identifies the MAC address of a stranded mesh access point
- Finds a nearby neighbor that is CAPWAP connected
- Sends commands through remote debug
- Cycles channels to follow the mesh access point

You only have to know the MAC address of the stranded AP to make use of this feature.

A mesh access point is considered stranded if it goes through a lonely timer reboot. When the lonely timer reboot is triggered, the mesh access point, which is now stranded, enables passive beaconing, the anti-stranding feature.

This feature can be divided into three parts:

- Strand detection by stranded mesh access point
- Beacons sent out by stranded mesh access point
  - Latch the 802.11b radio to a channel (1,6,11)
  - Enable debugs
  - Broadcast the standard debug messages as distress beacons
  - Send Latest Crash info file
- Receive beacons (neighboring mesh access point with remote debugging enabled)
Deployed mesh access points constantly look for stranded mesh access points. Periodically, mesh access points send a list of stranded mesh access points and SNR information to the controller. The controller maintains a list of the stranded mesh access points within its network.

When the `debug mesh astools troubleshoot mac-addr start` command is entered, the controller runs through the list to find the MAC address of the stranded mesh access point.

A message is sent to the best neighbor to start listening to the stranded access point. The listening mesh access point gets the distress beacons from the stranded mesh access point and sends it to the controller.

Once a mesh access point takes the role of a listener, it does not purge the stranded mesh access point from its internal list until it stops listening to the stranded mesh access point. While a stranded mesh access point is being debugged, if a neighbor of that mesh access point reports a better SNR to the controller than the current listener by some percentage, then the listener of the stranded mesh access point is changed to the new listener (with better SNR) immediately.

End-user commands are as follows:

- `config mesh astools [enable | disable]`—Enables or disables the astools on the mesh access points. If disabled, APs no longer sends a stranded AP list to the controller.
- `show mesh astools stats`—Shows the list of stranded APs and their listeners if they have any.
- `debug mesh astools troubleshoot mac-addr start`—Sends a message to the best neighbor of the `mac-addr` to start listening.
- `debug mesh astools troubleshoot mac-addr stop`—Sends a message to the best neighbor of the `mac-addr` to stop listening.
- `clear mesh stranded [all | mac of b/g radio]`—Clears stranded AP entries.

The controller console is swamped with debug messages from stranded APs for 30 minutes.

**Dynamic Frequency Selection**

Previously, devices employing radar operated in frequency subbands without other competing services. However, controlling regulatory bodies are attempting to open and share these bands with new services like wireless mesh LANs (IEEE 802.11).

To protect existing radar services, the regulatory bodies require that devices wishing to share the newly opened frequency subband behave in accordance with the Dynamic Frequency Selection (DFS) protocol. DFS dictates that to be compliant, a radio device must be capable of detecting the presence of radar signals. When a radio detects a radar signal, it is required to stop transmitting to for at least 30 minutes to protect that service. The radio then selects a different channel to transmit on but only after monitoring it. If no radar is detected on the projected channel for at least one minute, then the new radio service device may begin transmissions on that channel.

The AP performs a DFS scan on the new DFS channel for 60 seconds. However, if a neighboring AP is already using that new DFS channel, the AP does not perform the DFS scan.

The process for a radio to detect and identify a radar signal is a complicated task that sometimes leads to incorrect detects. Incorrect radar detections can occur due to a large number of factors, including due to uncertainties of the RF environment and the ability of the access point to reliably detect actual on-channel radar.

The 802.11h standard addresses DFS and Transmit Power Control (TPC) as it relates to the 5-GHz band. Use DFS to avoid interference with radar and TPC to avoid interference with satellite feeder links.
DFS is mandatory in the USA for 5250 to 5350 and 5470 to 5725 frequency bands. DFS and TPC are mandatory for these same bands in Europe.

**Figure 61: DFS and TPC Band Requirements**

<table>
<thead>
<tr>
<th>Frequency (MHz)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
</tr>
<tr>
<td>2</td>
</tr>
<tr>
<td>3</td>
</tr>
<tr>
<td>4</td>
</tr>
</tbody>
</table>

**DFS in RAP**

The RAP performs the following steps as a response to radar detection:

1. The RAP sends a message to the controller that the channel is infected with radar. The channel is marked as infected on the RAP and on the controller.
2. The RAP blocks the channel for 30 minutes. This 30-minute period is called the non-occupancy period.
3. The controller sends a TRAP, which indicates that the radar has been detected on the channel. A TRAP remains until the non-occupancy period expires.
4. The RAP has 10 seconds to move away from the channel. This period is called the channel move time, which is defined as the time for the system to clear the channel and is measured from the end of the radar burst to the end of the final transmission on the channel.
5. The RAP enters the quiet mode. In the quiet mode, the RAP stops data transmissions. Beacons are still generated and probe responses are still delivered. The quiet mode exists until the channel move time is over (10 seconds).
6. The controller picks up a new random channel and sends the channel information to the RAP.
7. The RAP receives the new channel information and sends channel change frames (unicast, encrypted) to the MAP, and each MAP sends the same information to its lower children down the sector. Each mesh access point sends the channel change frames once every 100 msecs for a total of five times.
8. The RAP tunes to the new channel and enters into the silent mode. During the silent mode, only the receiver is ON. The RAP keeps scanning the new channel for any radar presence for 60 seconds. This process is called channel availability check (CAC).
9. The MAP tunes to the new channel and enters into the silent mode. During the silent mode, only the receiver is ON. The MAP keeps scanning the new channel for any radar presence for 60 seconds.
10 If radar is not detected, the RAP resumes full functionality on this new channel and the whole sector tunes to this new channel.

**DFS in MAP**

The MAP performs the following steps as a response to radar detection:

1. The MAP sends a radar seen indication to the parent and ultimately to the RAP indicating that the channel is infected. The RAP sends this message to the controller. The message appears to be coming from the RAP. The MAP, RAP, and controller mark the channel as infected for 30 minutes.

2. The MAP blocks the channel for 30 minutes. This 30-minute period is called the nonoccupancy period.

3. The controller sends a TRAP, which indicates that the radar has been detected on the channel. The TRAP remains until the nonoccupancy period expires.

4. The MAP has 10 seconds to move away from the channel. This is called the channel move time, which is defined as the time for the system to clear the channel and is measured from the end of the radar burst to the end of the final transmission on the channel.

5. The MAP enters the quiet mode. In the quiet mode, the MAP stops data transmissions. Beacons are still generated and probe responses are still delivered. The quiet mode exists until the channel move time is over (10 seconds).

6. The controller picks up a new random channel and sends the channel to the RAP.

7. The RAP receives the new channel information and sends channel change frames (unicast, encrypted) to a MAP, and each MAP sends the same information to its lower children down the sector. Each mesh access point sends the channel change frames once every 100 msecs for a total of five times.

8. Each mesh access point tunes to the new channel and enters into the silent mode. During the silent mode, only the receiver is ON. There is no packet transmission. An AP keeps scanning the new channel for any radar presence for 60 seconds. This process is called the channel availability check (CAC). The MAP should not disconnect from the controller. The network should remain stable during this one-minute period.

DFS functionality allows a MAP that detects a radar signal to transmit that up to the RAP, which then acts as if it has experienced radar and moves the sector. This process is called the coordinated channel change. This functionally can be turned on or off on the controller. The coordinated channel change is enabled by default.

To enable DFS, enter the following command:

```
(Cisco Controller) > config mesh full-sector-dfs enable
```

To verify that DFS is enabled on the network, enter the following command:

```
(Cisco Controller) > show network summary
```

---

**Note**

A MAP that detects radar should send a message to the RAP, unless the parent has a different BGN, in which case it does not send messages for a coordinated sector change. Instead, the MAP reenters the SCAN state and searches on nonradar seen channels for a new parent.
Ensure that none of your mesh access points are using a default BGN.

A repeated radar event on the MAP (radar triggers once, and then almost immediately again), causes the MAP to disconnect.

### Preparation in a DFS Environment

This section describes how to prepare in a DFS environment:

- To verify that your controller is set to the correct country domain, enter the following command:

  
  ```
  (Cisco Controller) > show country
  ```

- To check the mesh access point country and the channel setting on the controller, enter the following command:

  
  ```
  (Cisco Controller) > show ap config 802.11a ap-name
  ```

- To identify channels available for mesh, enter the following command:

  
  ```
  (Cisco Controller) > show ap config 802.11a ap-name
  ```

  Look for the allowed channel list.

  ```
  Allowed Channel List....................... 100,104,108,112,116,120,124,
  ......................................... 128,132,136,140
  ```

- To identify channels available for mesh on the AP console (or use remote debug from the controller, enter the following command:

  ```
  ap1520-rap # show mesh channels
  ```

  HW: Dot11Radio1, Channels:

  An asterisk next to a channel indicates that radar has been seen on the channel.

- To invoke remote debug, enter the following commands:

  ```
  (Cisco Controller) > debug ap enable ap-name
  (Cisco Controller) > debug ap command command ap-name
  ```

- Debug commands to see radar detection and past radar detections on the DFS channel are as follows:

  ```
  show mesh dfs channel channel-number
  show mesh dfs history
  ```

  Information similar to the following appears.
The RAP should be run through the channels to determine whether there is active radar on each of the channels.

```
ap1520-rap # show mesh dfs channel 132
Channel 132 is available
Time elapsed since radar last detected: 0 day(s), 7 hour(s), 6 minute(s), 51 second(s).
```

```
ap1520-rap # show mesh dfs channel 132
Radar detected on channel 132, channel becomes unusable (Time Elapsed: 0 day(s), 7 hour(s), 7 minute(s), 11 second(s)).
Channel is set to 100 (Time Elapsed: 0 day(s), 7 hour(s), 6 minute(s), 42 second(s)).
```

```
ap1520-rap # show mesh dfs channel 132
Radar detected on channel 116, channel becomes unusable (Time Elapsed: 0 day(s), 7 hour(s), 6 minute(s), 42 second(s)).
Channel is set to 64 (Time Elapsed: 0 day(s), 7 hour(s), 6 minute(s), 42 second(s)).
```

```
ap1520-rap # show mesh dfs channel 132
Channel 132 becomes usable (Time Elapsed: 0 day(s), 6 hour(s), 37 minute(s), 10 second(s)).
Channel 116 becomes usable (Time Elapsed: 0 day(s), 6 hour(s), 36 minute(s), 42 second(s)).
```

### Monitoring DFS

The DFS history should be run every morning or more frequently to detect the radar. This information does not get erased and is stored on the mesh access point flash. Therefore, you only need to match the times.

```
ap1520-rap # show controller dot11Radio /
```

Information similar to the following appears:

```
interface Dot11Radio1
Radio Hammer 5, Base Address 001c.0e6c.9c00, BBlock version 0.00, Software version 0.05.30
Serial number: FOC11174XCW
Number of supported simultaneous BSSID on Dot11Radio1: 16
Carrier Set: ETSI (OFDM) (EU) (-E)
Uniform Spreading Required: Yes
Current Frequency: 5540 MHz Channel 108 (DFS enabled)
Allowed Frequencies: *5500(100) *5520(104) *5540(108) *5560(112) *5580(116) *5600(120) *5620(124) *5640(128) *5660(132) *5680(136) *5700(140)
* = May only be selected by Dynamic Frequency Selection (DFS)
Listen Frequencies: 5180(36) 5200(40) 5220(44) 5240(48) 5260(52) 5280(56) 5300(60) 5320(64) 5500(100) 5520(104) 5540(108) 5560(112) 5580(116) 5580(116) 5600(120) 5620(124) 5640(128) 5660(132) 5680(136) 5700(140) 5745(149) 5775(153) 5785(157) 5805(161) 5825(165) 4950(20) 4955(21) 4960(22) 4965(23) 4990(24) 4970(24) 4975(25) 4980(26)
```

**Note**

An asterisk indicates that this channel has DFS enabled.

### Frequency Planning

Use alternate adjacent channels in adjacent sectors. If you have two RAPs deployed at the same location, you must leave one channel in between.

Weather radars operate within the 5600- to 5650-MHz band, which means that channels 124 and 128 might be affected, but also channels 120 and 132 might suffer from weather radar activity.
If the mesh access point does detect radar, the controller and the mesh access point both will retain the channel as the configured channel. The controller retains it in volatile memory associated with the mesh access point, and the mesh access point has it stored in its flash as configuration. After the 30 minute quiet period, the controller returns the mesh access point to the static value, regardless of whether the mesh access point has been configured with a new channel or not. In order to overcome this, configure the mesh access point with a new channel, and reboot the mesh access point.

Once radar is reliably detected on a channel, that channel, and the two surrounding channels, should be added to the RRM exclusion list, as follows:

```
(Cisco Controller) > config advanced 802.11a channel delete channel
```

A mesh access point goes to a new channel that is picked by RRM, and it does not consider excluded channels. If a radar is detected on channel 124, for instance, channels 120, 124, and 128 should be added to the exclusion list. In addition, do not configure RAP to operate on those channels.

### Good Signal-to-Noise Ratios

For European installations, the minimum recommendation is increased to 20 dB of signal-to-noise ratio (SNR). The extra dBs are used to mitigate the effects of radar interference with packet reception, which is not observed in non-DFS environments.

### Access Point Placement

Collocated mesh access points should have a minimum of 10 feet (3.048 meters) of vertical separation or 100 (30.48 meters) feet of horizontal separation.

### Check Packet Error Rate

Mesh access points that have an high error rate, greater than 1 percent, should have mitigation applied to them, by changing the channels for noise and interference, adding additional mesh access points in the transmission path, moving the mesh access points to different sectors, or adding additional mesh access points.

### Bridge Group Name Misconfiguration

A mesh access point can be wrongly provisioned with a `bridgegroupname` and placed in a group other than it was intended. Depending on the network design, this mesh access point might or might not be able to reach out and find its correct sector or tree. If it cannot reach a compatible sector, the mesh access point can become stranded.

To recover a stranded mesh access point, the concept of default bridgegroupname has been introduced in the software. When a mesh access point is unable to connect to any other mesh access point with its configured bridgegroupname, it attempts to connect with the bridgegroupname of `default`.

The algorithm of detecting this strand condition and recovery is as follows:

1. Passively scans and finds all neighbor nodes regardless of their bridgegroupname.
2. The mesh access point attempts to connect to the neighbors heard with their `own bridgegroupname` using AWPP.
3 If Step 2 fails, attempts to connect with default bridgegroupname using AWPP.

4 For each failed attempt in Step 3, it adds the neighbor to an exclusion list and attempts to connect the next best neighbor.

5 If the AP fails to connect with all neighbors in Step 4, it reboots the mesh access point.

6 If connected with a default bridgegroupname for 15 minutes, the mesh access point goes into a scan state.

When a mesh access point is able to connect with the default bridgegroupname, the parent node reports the mesh access point as a default child/node/neighbor entry on the controller, so that a network administrator is Cisco Prime Infrastructure. Such a mesh access point behaves as a normal (nonmesh) access point and accepts any client, other mesh nodes as its children, and it passes any data traffic through.

---

**Note**

Do not confuse an unassigned BGN (null value) with DEFAULT, which is a mode that the access point uses to connect when it cannot find its own BGN.

To check the current state of a mesh access point’s BGN, enter the following command:

```
(Cisco Controller)> show mesh path Map3:5f:ff:60
00:0B:85:5F:FA:60 state UPDATED NEIGH PARENT DEFAULT (106B), snrUp 48, snrDown 48, linkSnr 49
00:0B:85:5F:FB:10 state UPDATED NEIGH PARENT BEACON (86B) snrUp 72, snrDown 63, linkSnr 57
00:0B:85:5F:FA:60 is RAP
```

To check the current state of a mesh access point’s BGN, check the neighbor information for the mesh access point (GUI) as follows:
Choose **Wireless > All APs > AP Name > Neighbor info**.

*Figure 62: Neighbor Information for a Child*

*Figure 63: Neighbor Information for a Parent*

**Misconfiguration of the Mesh Access Point IP Address**

Although most Layer 3 networks are deployed using DHCP IP address management, some network administrators might prefer the manual IP address management and allocating IP addresses statically to each mesh node. Manual mesh access point IP address management can be a nightmare for large networks, but it might make sense in small to medium size networks (such as 10 to 100 mesh nodes) because the number of mesh nodes are relatively small compared to client hosts.

Statically configuring the IP address on a mesh node has the possibility of putting a MAP on a wrong network, such as a subnet or VLAN. This mistake could prevent a mesh access point from successfully resolving the IP gateway and failing to discover a WLAN controller. In such a scenario, the mesh access point falls back to its DHCP mechanism and automatically attempts to find a DHCP server and obtains an IP address from it. This fallback mechanism prevents a mesh node from being potentially stranded from a wrongly configured static IP address and allows it to obtain a correct address from a DHCP server on the network.

When you are manually allocating IP addresses, we recommend that you make IP addressing changes from the furthest mesh access point child first and then work your way back to the RAP.

---

applies if you relocate equipment. For example, if you uninstall a mesh access point and redeploy it in another physical location of the mesh network that has a different addressed subnet.

Another option is to take a controller in Layer 2 mode with a RAP to the location with the misconfigured MAP. Set the bridge group name on the RAP to match the MAP that needs the configuration change. Add the MAP’s MAC address to the controller. When the misconfigured MAP comes up in the mesh access point summary detail, configure it with an IP address.

**Misconfiguration of DHCP**

Despite the DHCP fallback mechanism, there is still a possibility that a mesh access point can become stranded, if any of the following conditions exist:

- There is no DHCP server on the network.
- There is a DHCP server on the network, but it does not offer an IP address to the AP, or if it gives a wrong IP address to the AP (for example, on a wrong VLAN or subnet).

These conditions can strand a mesh access point that is configured with or without a wrong static IP address or with DHCP. Therefore, you must ensure that when a mesh access point is unable to connect after exhausting all DHCP discovery attempts or DHCP retry counts or IP gateway resolution retry counts, it attempts to find a controller in Layer 2 mode. In other words, a mesh access point attempts to discover a controller in Layer 3 mode first and in this mode, attempts with both static IP (if configured) or DHCP (if possible). The AP then attempts to discover a controller in Layer 2 mode. After finishing a number of Layer 3 and Layer 2 mode attempts, the mesh access point changes its parent node and re-attempts DHCP discovery. Additionally, the software exclusion-lists notes the parent node through which it was unable to obtain the correct IP address.

**Identifying the Node Exclusion Algorithm**

Depending on the mesh network design, a node might find another node “best” according to its routing metric (even recursively true), yet it is unable to provide the node with a connection to the correct controller or correct network. It is the typical honeypot access point scenario caused by either misplacement, provisioning, design of the network, or by the dynamic nature of an RF environment exhibiting conditions that optimize the AWPP routing metric for a particular link in a persistent or transient manner. Such conditions are generally difficult to recover from in most networks and could blackhole or sinkhole a node completely, taking it out from the network. Possible symptoms include, but are not limited to the following:

- A node connects to the honeypot but cannot resolve the IP gateway when configured with the static IP address, or cannot obtain the correct IP address from the DHCP server, or cannot connect to a WLAN controller.
- A node ping-pongs between a few honeypots or circles between many honeypots (in worst-case scenarios).

Cisco mesh software resolves this difficult scenario by using a sophisticated node exclusion-listing algorithm. This node exclusion-listing algorithm uses an exponential backoff and advance technique much like the TCP sliding window or 802.11 MAC.

The basic idea relies on the following five steps:

1. **Honeypot detection**—The honeypots are first detected via the following steps:
   - A parent node is set by the AWPP module by:
A static IP attempt in CAPWAP module.

A DHCP attempt in the DHCP module.

A CAPWAP attempt to find and connect to a controller fails.

2 Honeypot conviction—When a honeypot is detected, it is placed in a exclusion-list database with its conviction period to remain on the list. The default is 32 minutes. Other nodes are then attempted as parents in the following order, falling back to the next, upon failing the current mechanism:

- On the same channel.
- Across different channels (first with its own bridgegroupname and then with default).
- Another cycle, by clearing conviction of all current exclusion-list entries.
- Rebooting the AP.

3 Nonhoneypot credit—It is often possible that a node is not a really a honeypot, but appears to be due to some transient back-end condition, such as the following:

- The DHCP server is either not up-and-running yet, has failed temporarily, or requires a reboot.
- The WLAN controller is either not up-and-running yet, has failed temporarily, or requires a reboot.
- The Ethernet cable on the RAP was accidentally disconnected.

Such nonhoneypots must be credited properly from their serving times so that a node can come back to them as soon as possible.

4 Honeypot expiration—Upon expiration, an exclusion-list node must be removed from the exclusion-list database and return to a normal state for future consideration by AWPP.

5 Honeypot reporting—Honeypots are reported to the controller via an LWAPP mesh neighbor message to the controller, which shows these on the Bridging Information page. A message is also displayed the first-time an exclusion-listed neighbor is seen. In a subsequent software release, an SNMP trap is generated on the controller for this condition so that Cisco Prime Infrastructure can record the occurrence.
Because many nodes might be attempting to join or rejoin the network after an expected or unexpected event, a hold-off time of 16 minutes is implemented, which means that no nodes are exclusion-listed during this period of time after system initialization.

This exponential backoff and advance algorithm is unique and has the following properties:

- It allows a node to correctly identify the parent nodes whether it is a true honeypot or is just experiencing temporary outage conditions.
- It credits the good parent nodes according to the time it has enabled a node to stay connected with the network. The crediting requires less and less time to bring the exclusion-list conviction period to be very low for real transient conditions and not so low for transient to moderate outages.
- It has a built-in hysteresis for encountering the initial condition issue where many nodes try to discover each other only to find that those nodes are not really meant to be in the same network.
- It has a built-in memory for nodes that can appear as neighbors sporadically so they are not accidentally considered as parents if they were, or are supposed to be, on the exclusion-list database.

The node exclusion-listing algorithm guards the mesh network against serious stranding. It integrates into AWPP in such a way that a node can quickly reconverge and find the correct network.

**Throughput Analysis**

Throughput depends on packet error rate and hop count.

Capacity and throughput are orthogonal concepts. Throughput is one user's experience at node N and the total area capacity is calculated over the entire sector of N-nodes and is based on the number of ingress and egress RAP, assuming separate noninterfering channels.

For example, 4 RAPs at 10 Mbps each deliver 40 Mbps total capacity. So, one user at 2 hops out, logically under each RAP, could get 5 Mbps each of TPUT, but consume 40 Mbps of the backhaul capacity.

With the Cisco Mesh solution, the per-hop latency is less than 10 msecs, and the typical latency numbers per hop range from 1 to 3 msecs. Overall jitter is also less than 3 msecs.

Throughput depends on the type of traffic being passed through the network: User Datagram Protocol (UDP) or Transmission Control Protocol (TCP). UDP sends a packet over Ethernet with a source and destination address and a UDP protocol header. It does not expect an acknowledgement (ACK). There is no assurance that the packet is delivered at the application layer.

TCP is similar to UDP but it is a reliable packet delivery mechanism. There are packet acknowledgments and a sliding window technique is used to allow the sender to transmit multiple packets before waiting for an ACK. There is a maximum amount of data the client transmits (called a TCP socket buffer window) before it stops sending data. Sequence numbers track packets sent and ensure that they arrive in the correct order. TCP uses cumulative ACKs and the receiver reports how much of the current stream has been received. An ACK might cover any number of packets, up to the TCP window size.

TCP uses slow start and multiplicative decrease to respond to network congestion or packet loss. When a packet is lost, the TCP window is cut in half and the back-off retransmission timer is increased exponentially. Wireless is subject to packet loss due to interference issues and TCP reacts to this packet loss. A slow start recovery algorithm is also used to avoid swamping a connection when recovering from packet loss. The effect of these algorithms in a lossy network environment is to lessen the overall throughput of a traffic stream.

By default, the maximum segment size (MSS) of TCP is 1460 bytes, which results in a 1500-byte IP datagram. TCP fragments any data packet that is larger than 1460 bytes, which can cause at least a 30-percent throughput drop. In addition, the controller encapsulates IP datagrams in the 48-byte CAPWAP tunnel header as shown.
in Figure 65: CAPWAP Tunneled Packets, on page 202. Any data packet that is longer than 1394 bytes is also fragmented by the controller, which results in up to a 15-percent throughput decrease.

**Figure 65: CAPWAP Tunneled Packets**

### CAPWAP Tunneled Packet

<table>
<thead>
<tr>
<th>MAC</th>
<th>IP</th>
<th>UDP</th>
<th>CAPWAP</th>
<th>IP</th>
<th>UDP</th>
<th>Application Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>14 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
<td>6 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
<td></td>
</tr>
</tbody>
</table>

**CAPWAP Tunnel Headers**

<table>
<thead>
<tr>
<th>Original UDP Packet</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>MAC</th>
<th>IP</th>
<th>UDP</th>
<th>CAPWAP</th>
<th>IP</th>
<th>TCP</th>
<th>Application Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>14 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
<td>6 bytes</td>
<td>20 bytes</td>
<td>20 bytes</td>
<td></td>
</tr>
</tbody>
</table>

**CAPWAP Tunnel Headers**

<table>
<thead>
<tr>
<th>Original TCP Packet</th>
</tr>
</thead>
</table>

### Wi-Fi Encapsulated, CAPWAP Tunneled Packet

<table>
<thead>
<tr>
<th>802.11 SNAP</th>
<th>MAC</th>
<th>IP</th>
<th>UDP</th>
<th>CAPWAP</th>
<th>IP</th>
<th>UDP</th>
<th>Application Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 bytes</td>
<td>8 bytes</td>
<td>14 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
<td>6 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
</tr>
</tbody>
</table>

**802.11 Encaps CAPWAP Tunnel Headers**

<table>
<thead>
<tr>
<th>Original UDP Packet</th>
</tr>
</thead>
</table>

<table>
<thead>
<tr>
<th>802.11 SNAP</th>
<th>MAC</th>
<th>IP</th>
<th>UDP</th>
<th>CAPWAP</th>
<th>IP</th>
<th>TCP</th>
<th>Application Data</th>
</tr>
</thead>
<tbody>
<tr>
<td>24 bytes</td>
<td>8 bytes</td>
<td>14 bytes</td>
<td>20 bytes</td>
<td>8 bytes</td>
<td>6 bytes</td>
<td>20 bytes</td>
<td>20 bytes</td>
</tr>
</tbody>
</table>

**802.11 Encaps CAPWAP Tunnel Headers**

<table>
<thead>
<tr>
<th>Original TCP Packet</th>
</tr>
</thead>
</table>

*IE* to avoid fragmentation
Managing Mesh Access Points with Cisco Prime Infrastructure

Cisco Prime Infrastructure is a complete platform for enterprise-wide WLAN systems management. It provides a wide range of tools for visualizing and controlling the mesh, including histograms of signal-to-noise ratio, mesh detail information, mesh access point neighbor and link information, seven-day temporal link information, and tools to identify and avoid RF interference.

This section addresses the following Prime Infrastructure monitoring capabilities:

- Monitoring Mesh Networks Using Maps
- Monitoring Mesh Health
- Viewing Mesh Statistics for a Mesh Access Point
- Viewing the Mesh Network Hierarchy
- Using Mesh Filters to Modify Map Display of Maps and Mesh Links
- Adding Campus Maps, Outdoor Areas, and Buildings with Cisco Prime Infrastructure, page 204
- Adding Mesh Access Points to Maps with Cisco Prime Infrastructure, page 206
- Monitoring Mesh Access Points Using Google Earth, page 207
- Adding Indoor Mesh Access Points to Cisco Prime Infrastructure, page 211
- Managing Mesh Access Points with Cisco Prime Infrastructure, page 212
- Monitoring Workgroup Bridges, page 225
- Viewing AP Last Reboot Reason, page 232
Adding Campus Maps, Outdoor Areas, and Buildings with Cisco Prime Infrastructure

For mesh networks, maps and items on those maps (buildings and mesh access points) are added to Cisco Prime Infrastructure in the following order:

- **Step 1** Add a campus map.
- **Step 2** Add an outdoor area map.
- **Step 3** Add buildings.
- **Step 4** Add mesh access points.

Detailed steps for adding these maps and components are noted below.

## Adding Campus Maps

To add a single campus map to the Cisco Prime Infrastructure database, follow these steps:

- **Step 1** Save the map in .PNG, .JPG, .JPEG, or .GIF format.
  - **Note** The map can be any size because the Prime Infrastructure automatically resizes the map to fit its working areas.
- **Step 2** Browse to and import the map from anywhere in your file system.
- **Step 3** Choose Monitor > Maps to display the Maps page.
- **Step 4** From the Select a command drop-down list, choose New Campus and click GO.
- **Step 5** On the Maps > New Campus page, enter the campus name and campus contact name.
- **Step 6** Browse to and choose the image filename containing the map of the campus and click Open.
- **Step 7** Select the Maintain Aspect Ratio check box to prevent length and width distortion when the Prime Infrastructure resizes the map.
- **Step 8** Enter the horizontal and vertical span of the map in feet.
  - **Note** The horizontal and vertical span should be larger than any building or floor plan to be added to the campus.
- **Step 9** Click OK to add this campus map to the Prime Infrastructure database. The Prime Infrastructure displays the Maps page, which lists maps in the database, map types, and campus status.

## Adding Outdoor Areas

To add an outdoor area to a campus map, follow these steps:
You can add outdoor areas to a campus map in the Cisco Prime Infrastructure database regardless of whether you outdoor area maps are in the database.

---

**Step 1**
If you want to add a map of the outdoor area to the database, save the map in .PNG, JPG, JPEG, or .GIF format. Then browse to and import the map from anywhere in your file system.

**Note** You do not need a map to add an outdoor area. You can simply define the dimensions of the area to add it to the database. The map can be any size because Cisco Prime Infrastructure automatically resizes the map to fit the workspace.

**Step 2**
Choose Monitor > Maps to display the Maps page.

**Step 3**
Click the desired campus. Cisco Prime Infrastructure displays the Maps > Campus Name page.

**Step 4**
From the Select a command drop-down list, choose New Outdoor Area and click GO.

**Step 5**
On the Campus Name > New Outdoor Area page, follow these steps to create a manageable outdoor area:

a) Enter the outdoor area name.

b) Enter the outdoor area contact name.

c) If desired, enter or browse to the filename of the outdoor area map.

d) Enter an approximate outdoor horizontal span and vertical span (width and depth on the map) in feet.

**Tip** You can also use Ctrl-click to resize the bounding area in the upper left corner of the campus map. As you change the size of the bounding area, the Horizontal Span and Vertical Span parameters of the outdoor area change to match your actions.

e) Click Place to put the outdoor area on the campus map. Cisco Prime Infrastructure creates an outdoor area rectangle scaled to the size of the campus map.

f) Click on the outdoor area rectangle and drag it to the desired position on the campus map.

g) Click Save to save this outdoor area and its campus location to the database. Cisco Prime Infrastructure saves the outdoor area name in the outdoor area rectangle on the campus map.

**Note** A hyperlink associated with the outdoor area takes you to the corresponding Map page

**Step 6**
Click Save.

---

**Adding a Building to a Campus Map**

You can add buildings to the Cisco Prime Infrastructure database regardless of whether you have added campus maps to the database. This section explains how to add a building to a campus map or a standalone building (one that is not part of a campus) to the Prime Infrastructure database.
To add a building to a campus map in the Prime Infrastructure database, follow these steps:

**Step 1** Choose Monitor > Maps to display the Maps page.

**Step 2** Click the desired campus. Cisco Prime Infrastructure displays the Maps > Campus Name page.

**Step 3** From the Select a command drop-down list, choose New Building and click Go.

**Step 4** On the Campus Name > New Building page, follow these steps to create a virtual building in which to organize related floor plan maps:
   a) Enter the building name.
   b) Enter the building contact name.
   c) Enter the number of floors and basements.
   d) Enter an approximate building horizontal span and vertical span (width and depth on the map) in feet.
      Tip The horizontal and vertical span should be larger than or the same size as any floors that you might add later.
      You can also use Ctrl-click to resize the bounding area in the upper left corner of the campus map. As you change
      the size of the bounding area, the Horizontal Span and Vertical Span parameters of the building change to match
      your actions.
   e) Click Place to put the building on the campus map. Cisco Prime Infrastructure creates a building rectangle scaled to
      the size of the campus map.
   f) Click on the building rectangle and drag it to the desired position on the campus map.
      **Note** After adding a new building, you can move it from one campus to another without having to recreate it.
   g) Click Save to save this building and its campus location to the database. Cisco Prime Infrastructure saves the building
      name in the building rectangle on the campus map.
      **Note** A hyperlink associated with the building takes you to the corresponding Map page.

**Step 5** Click Save.

---

**Adding Mesh Access Points to Maps with Cisco Prime Infrastructure**

After you add the .PNG, .JPG, .JPEG, or .GIF format floor plan and outdoor area maps to the Cisco Prime Infrastructure database, you can position mesh access point icons on the maps to show where they are installed in the buildings.

To add mesh access points to floor plan and outdoor area maps, follow these steps:

**Step 1** Click the desired floor plan or outdoor area map in the Coverage Areas component of the General tab. Cisco Prime Infrastructure displays the associated coverage area map.

**Step 2** From the Select a command drop-down list, choose Add Access Points and click GO.

**Step 3** On the Add Access Points page, choose the mesh access points to add to the map.

**Step 4** Click OK to add the mesh access points to the map and display the Position Access Points map.
Themeshaccesspointiconsappearintheupperleftareaofthe
map.

Step 5  Click and drag the icons to indicate their physical locations.

Step 6  Click each icon and choose the antenna orientation in the sidebar.

**Figure 66: Antenna Sidebar**

The antenna angle is relative to the map's X axis. Because the origin of the X (horizontal) and Y (vertical) axes is in the upper left corner of the map, 0 degrees points side A of the mesh access point to the right, 90 degrees points side A down, 180 degrees points side A to the left, and so on. The antenna elevation is used to move the antenna vertically, up or down, to a maximum of 90 degrees.

Make sure each mesh access point is in the correct location on the map and has the correct antenna orientation. Accurate mesh access point positioning is critical when you use the maps to find coverage holes and rogue access points.

See this location for further information about the antenna elevation and azimuth patterns:


Step 7  Click **Save** to store the mesh access point locations and orientations. Cisco Prime Infrastructure computes the RF prediction for the coverage area. These RF predictions are popularly known as heat maps because they show the relative intensity of the RF signals on the coverage area map.

**Note**  This display is only an approximation of the actual RF signal intensity because it does not take into account the attenuation of various building materials, such as drywall or metal objects. It also does not display the effects of RF signals bouncing off obstructions.

---

**Monitoring Mesh Access Points Using Google Earth**

Cisco Prime Infrastructure supports both Google Earth Map Plus or Pro and displays, when present, mesh access points and their links.
Launching Google Earth in Cisco Prime Infrastructure

Cisco Prime Infrastructure supports both Google Earth Map Plus or Pro and displays, when present, mesh access points and their links.

To launch Google Earth maps, follow these steps:

**Step 1** Launch Google Earth plus or pro and add a new folder.

**Step 2** Create a mesh access points placemark on Google Earth plus or pro.

**Note** You must use the exact name of the mesh access point when creating the placement mark to ensure Prime Infrastructure can recognize these mesh access points.

**Step 3** Place the mesh access point placemarks in the new folder. Save the folder as a .KML file.

**Step 4** In the Prime Infrastructure, choose **Monitor > Google Earth Maps**. Select Import Google KML from the Select a command drop-down list.

**Step 5** Import the new Google KML folder. It displays in the folder name summary.

*Figure 67: Importing New Folder into Google Earth*

**Step 6** Click the launch icon next to the new folder to launch the Google Earth map from the Prime Infrastructure.

Viewing Google Earth Maps

You can view campus maps, mesh access point and link information using Google maps.
To view Google Earth maps, follow these steps:

**Step 1** Log on to Cisco Prime Infrastructure.

**Step 2** Choose **Monitor > Google Earth Maps**. The Google Earth Maps page displays all folders and the number of mesh access points included within each folder.

**Step 3** Click **Launch** for the map you want to view. Google Earth opens in a separate window and displays the location and its mesh access points.

*Note* To use this feature, you must have Google Earth installed on your computer and configured to auto-launch when data is sent from the server. You can download Google Earth from Google’s website.

**Figure 68: Google Earth Map Page**

**Step 4** Click **Launch** for the map you want to view. Google Earth opens in a separate window and displays the location and its mesh access points.
Note  To use this feature, you must have Google Earth installed on your computer and configured to auto-launch when data is sent from the server. You can download Google Earth from Google's website.

Figure 69: Google Earth Map With Mesh Access Point Details

Figure 70: Google Earth Map With Mesh Link Details
To view details for a Google Earth Map folder, follow these steps:

**Step 5**

From the Google Earth Map page, click the folder name to open the details page for this folder. The Google Earth Details page provides the mesh access point names and MAC or IP addresses.

**Note**

To delete a mesh access point, select the applicable check box and click **Delete**. To delete the entire folder, select the check box next to **Folder Name** and click **Delete**. Deleting a folder also deletes all subfolders and mesh access points inside the folder.

**Step 6**

Click **Cancel** to close the details page.

---

# Adding Indoor Mesh Access Points to Cisco Prime Infrastructure

You have a choice of ordering indoor access points directly into the bridge mode, so that these access points can be used directly as mesh access points. If you have these access points in a local mode (nonmesh), then you have to connect these access points to the controller and change the radio role to the bridge mode (mesh). This task can become cumbersome particularly if the volume of the access points being deployed is large and if the access points are already deployed in the local mode for a traditional nonmesh wireless coverage.

For local mode indoor access points prior to a mesh installation, you must first connect all indoor mesh access points to the controller and change the mode to **bridge** mode.

To do so, connect all the indoor access points to the Layer 3 network on the same subnet as the Management IP address. Add the MAC address of the indoor mesh access points into the MAC filter list on the controller. All indoor access points will then join the controller in local mode.

You can then change local mode to bridge mode in the controller for every indoor access point.

**Figure 71: All APs > AP Details Controller Page**

After changing the indoor access points to bridge mode on the controller, add these indoor mesh access points into the Prime Infrastructure.
You cannot initially configure indoor mesh access points into bridge mode from the Prime Infrastructure.

Managing Mesh Access Points with Cisco Prime Infrastructure

Cisco Prime Infrastructure is a complete platform for enterprise-wide WLAN systems management. It provides a wide range of tools for visualizing and controlling the mesh, including histograms of signal-to-noise ratio, mesh detail information, mesh access point neighbor and link information, seven-day temporal link information, and tools to identify and avoid RF interference.

This section addresses the following Prime Infrastructure monitoring capabilities:

- Monitoring Mesh Networks Using Maps
- Monitoring Mesh Health
- Viewing Mesh Statistics for a Mesh Access Point
- Viewing the Mesh Network Hierarchy
- Using Mesh Filters to Modify Map Display of Maps and Mesh Links

Monitoring Mesh Networks Using Maps

You can access and view details for the following elements from a mesh network map in the Cisco Prime Infrastructure:

- Mesh Link Statistics
- Mesh Access Points
- Mesh Access Point Neighbors

Details on how this information is accessed and the information displayed for each of these items is detailed in the following sections.

Monitoring Mesh Link Statistics Using Maps

You can view the SNR for a specific mesh network link, view the number of packets transmitted and received on that link, and initiate a link test from the Monitor > Maps display.

To view details on a specific mesh link between two mesh access points or a mesh access point and a root access point, follow these steps:

Step 1: In Cisco Prime Infrastructure, choose Monitor > Maps.
Step 2: Click the Map Name that corresponds to the outdoor area, campus, building, or floor you want to monitor.
Step 3: Move the cursor over the link arrow for the target link. A Mesh Link page appears.
The AP Mesh Info checkbox under the Layers drop-down list must be selected for links to appear on the map.

**Step 4**
Click either **Link Test, Child to Parent** or **Link Test, Parent to Child**. After the link test is complete, a results page appears.

**Note**
A link test runs for 30 seconds.

**Note**
You cannot run link tests for both links (child-to-parent and parent-to-child) at the same time.

**Step 5**
To view a graphical representation of SNR statistics over a period of time, click the arrow on the link. A page with multiple SNR graphs appears.

---

The following graphs are displayed for the link:

- **SNR Up**—Plots the RSSI values of the neighbor from the perspective of the mesh access point.
- **SNR Down**—Plots the RSSI values that the neighbor reports to the mesh access point.
- **Link SNR**—Plots a weighed and filtered measurement based on the SNR Up value.
- **The Adjusted Link Metric**—Plots the value used to determine the least cost path to the root mesh access point. This value is the ease to get to the rooftop access point and accounts for the number of hops. The lower the ease value, the less likely the path is used.
- **The Unadjusted Link Metric**—Plots the least cost path to get to the root access point unadjusted by the number of hops. The higher the value for the unadjusted link indicates the better the path.

---

**Monitoring Mesh Access Points Using Maps**

You can view the following summary information for a mesh access point from a mesh network map:

- Parent
- Number of children
- Hop count
- Role
- Group name
- Backhaul interface
- Data Rate
- Channel

**Note**
This information is in addition to the information shown for all mesh access points (MAC address, mesh access point model, controller IP address, location, height of mesh access point, mesh access point up time, and CAPWAP up time).
To view summary and detailed configuration information for a mesh access point from a mesh network map, follow these steps:

**Step 1** On the GUI of Cisco Prime Infrastructure, choose Monitor > Maps.

**Step 2** Click the Map Name that corresponds to the outdoor area, campus, building, or floor location of the mesh access point you want to monitor.

**Step 3** To view summary configuration information for a mesh access point, move the cursor over the mesh access point that you want to monitor. A page with configuration information for the selected mesh access point appears.

**Step 4** To view detailed configuration information for a mesh access point, click the arrow portion of the mesh access point label. The configuration details for the mesh access point appears.

**Note** If the mesh access point has an IP address, a Run Ping Test link is also visible at the bottom of the mesh access point panel.

**Step 5** On the Access Point configuration page, follow these steps to view configuration details for the mesh access point:

- a) Choose the General tab to view the overall configuration of the mesh access point such as AP name, MAC address, AP Up time, associated controllers (registered and primary) operational status, and software version.

  **Note** The software version for mesh access points is appended the letter *m* and the word *mesh* in parentheses.

- b) Choose the Interface tab to view configuration details for the interfaces supported on the mesh access point. Interface options are radio and Ethernet.

- c) Choose the Mesh Links tab to view parent and neighbors’ details (name, MAC address, packet error rate, and link details) for the mesh access point. You can also initiate link tests from this panel.

- d) Choose the Mesh Statistics tab to view details on the bridging, queue, and security statistics for the mesh access point. For more details on mesh statistics, see the Viewing Mesh Statistics for a Mesh Access Point section.

---

**Monitoring Mesh Access Point Neighbors Using Maps**

To view details on neighbors of a mesh access point from a mesh network map, follow these steps:

**Step 1** Choose Monitor > Maps.

**Step 2** Click the Map Name that corresponds to the outdoor area, campus, building, or floor you want to monitor.

**Step 3** To view detailed information on mesh links for a mesh access point, click the arrow portion of the access point label. The Access Points screen appears.

**Step 4** Click the Mesh Links tab.

**Note** You can also mesh link details for neighbors of a selected mesh access point by clicking on the View Mesh Neighbors link on the mesh access point configuration summary panel that displays when you mouse over a mesh access point on a map.

**Note** Signal-to-noise ratio (SNR) only appears on the View Mesh Neighbors panel.

**Note** In addition to listing the current and past neighbors in the panel that displays, labels are added to the mesh access points map icons to identify the selected mesh access point, the neighbor mesh access point, and the child mesh access point. Select the clear link of the selected mesh access point to remove the relationship labels from the map.
The drop-down lists at the top of the mesh neighbors page indicate the resolution of the map (100%) displayed and how often the information displayed is updated (5 minutes). You can modify these default values.

Monitoring Mesh Health

Mesh Health monitors the overall health of outdoor and indoor mesh access points, except as noted. Tracking this environmental information is particularly critical for mesh access points that are deployed outdoors. The following factors are monitored:

- **Temperature**—Displays the internal temperature of the mesh access point in Fahrenheit and Celsius (AP1500s only).
- **Heater status**—Displays the heater as on or off (AP1500s only).
- **AP Up time**—Displays how long the mesh access point has been active to receive and transmit.
- **CAPWAP Join Taken Time**—Displays how long it took to establish the CAPWAP connection.
- **CAPWAP Up Time**—Displays how long the CAPWAP connection has been active.

Mesh Health information is displayed in the General Properties panel for mesh access points. To view the mesh health details for a specific mesh access point, follow these steps:

**Step 1**  
Choose **Monitor > Access Points**. A listing of access points appears.

**Note**  
You can also use the New Search button to display the mesh access point summary shown below. With the New Search option, you can further define the criteria of the access points that display. Search criteria include AP Type, AP Mode, Radio Type, and 802.11n Support.

**Step 2**  
Click the **AP Name** link to display details for that mesh access point. The General Properties panel for that mesh access point appears.

You can also access the General properties panel for a mesh access point from a Cisco Prime Infrastructure map page. To display the panel, click the arrow portion of the mesh access point label. A tabbed panel appears and displays the General properties panel for the selected access point.

To add, remove, or reorder columns in the table, click the **Edit View** link. Table 26: **Monitor Access Points Additional Search Results Parameters**, on page 215 displays optional access point parameters available from the Edit View page.

**Table 26: Monitor Access Points Additional Search Results Parameters**

<table>
<thead>
<tr>
<th>Column</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>AP Type</td>
<td>Indicates the type of access point (unified or autonomous).</td>
</tr>
<tr>
<td>Column</td>
<td>Options</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Antenna Azim. Angle</td>
<td>Indicates the horizontal angle of the antenna.</td>
</tr>
<tr>
<td>Antenna Diversity</td>
<td>Indicates if antenna diversity is enabled or disabled. Antenna diversity refers to the access point sampling the radio signal from two integrated antenna ports in order to choose the preferred antenna.</td>
</tr>
<tr>
<td>Antenna Elev. Angle</td>
<td>Indicates the elevation angle of the antenna.</td>
</tr>
<tr>
<td>Antenna Gain</td>
<td>Indicates the peak gain of the dBi of the antenna for directional antennas and the average gain in dBi for omnidirectional antennas connected to the wireless network adapter. The gain is in multiples of 0.5 dBm. An integer value 4 means 4 x 0.5 - 2 dBm of gain.</td>
</tr>
<tr>
<td>Antenna Mode</td>
<td>Indicates the antenna mode such as omni, directional, or nonapplicable.</td>
</tr>
<tr>
<td>Antenna Name</td>
<td>Indicates the antenna name or type.</td>
</tr>
<tr>
<td>Antenna Type</td>
<td>Indicates whether the antenna is internal or external.</td>
</tr>
<tr>
<td>Audit Status</td>
<td>Indicates one of the following audit statuses:</td>
</tr>
<tr>
<td></td>
<td>- Mismatch—Config differences were found between Cisco Prime Infrastructure and controller during the last audit.</td>
</tr>
<tr>
<td></td>
<td>- Identical—No config differences were found during the last audit.</td>
</tr>
<tr>
<td></td>
<td>- Not Available—Audit status is unavailable.</td>
</tr>
<tr>
<td>Bridge Group Name</td>
<td>Indicates the name of the bridge group used to group the access points, if applicable.</td>
</tr>
<tr>
<td>CDP Neighbors</td>
<td>Indicates all directly connected Cisco devices.</td>
</tr>
<tr>
<td>Channel Control</td>
<td>Indicates whether the channel control is automatic or custom.</td>
</tr>
<tr>
<td>Channel Number</td>
<td>Indicates the channel on which the Cisco radio is broadcasting.</td>
</tr>
<tr>
<td>Controller Port</td>
<td>Indicates the number of controller ports.</td>
</tr>
<tr>
<td>Node Hops</td>
<td>Indicates the number of hops between access point.</td>
</tr>
</tbody>
</table>
Options

Column | Options
---|---
POE Status | Indicates the Power-over-Ethernet status of the access point. The possible values are as follows:
  - Low—The access point draws low power from the Ethernet.
  - Lower than 15.4 volts—The access point draws lower than 15.4 V from the Ethernet.
  - Lower than 16.8 volts—The access point draws lower than 16.8 V from the Ethernet.
  - Normal—The power is high enough for the operation of the access point.
  - Not Applicable—The power source is not from the Ethernet.
Primary Controller | Indicates the name of the primary controller for this access point.
Radio MAC | Indicates the radio’s MAC address.
Reg. Domain Supported | Indicates whether or not the regulatory domain is supported.
Serial Number | Indicates the access point’s serial number.
Slot | Indicates the slot number.
Tx Power Control | Indicates whether the transmission power control is automatic or custom.
Tx Power Level | Indicates the transmission power level.
Up Time | Indicates how long the access point has been up in days, hours, minutes, and seconds.
WLAN Override Names | Indicates the WLAN override profile names.
WLAN Override | Indicates whether WLAN Override is enabled or disabled. Each access point is limited to 16 WLAN profiles. Each access point broadcasts all WLAN profiles unless the WLAN override feature is enabled. The WLAN override feature allows you to disable any of the 16 WLAN profiles per access point.

Viewing Mesh Statistics for a Mesh Access Point

Mesh Statistics are reported when a child mesh access point authenticates or associates with a parent mesh access point.

Security entries are removed and no longer displayed when the child mesh access point disassociates from the controller.
The following mesh security statistics are displayed for mesh access points:

- Bridging
- Queue
- Security

To view the mesh statistics for a specific mesh access point, follow these steps:

**Step 1** Choose Monitor > Access Points. A listing of access points appears.

*Note* You can also use the New Search button to display the access point summary. With the New Search option, you can further define the criteria of the access points that display. Search criteria include AP Name, IP address, MAC address, Controller IP or Name, Radio type, and Outdoor area.

**Step 2** Click the AP Name link of the target mesh access point.

A tabbed panel appears and displays the General Properties page for the selected mesh access point.

**Step 3** Click the Mesh Statistics tab. A three-tabbed Mesh Statistics panel appears.

*Note* The Mesh Statistics tab and its subordinate tabs (Bridging, Queue and Security) only appear for mesh access points. The Mesh Link Alarms and Mesh Link Events links are accessible from each of the three tabbed panels.

*Note* You can also access the Mesh Security panel for a mesh access point from a Cisco Prime Infrastructure map. To display the panel, click the arrow portion of the mesh access point label.

Summaries of the Bridging, Queue and Security Statistics and their definitions are provided in the following tables.

### Table 27: Bridging Mesh Statistics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>The role of the mesh access point. Options are mesh access points (MAPs) and root access points (RAPs).</td>
</tr>
<tr>
<td>Bridge Group Name (BGN)</td>
<td>The name of the bridge group to which the MAP or RAP is a member. Assigning membership in a BGN is recommended. If one is not assigned, a MAP is by default assigned to a default BGN.</td>
</tr>
<tr>
<td>Backhaul Interface</td>
<td>The radio backhaul for the mesh access point.</td>
</tr>
<tr>
<td>Routing State</td>
<td>The state of parent selection. Values that display are seek, scan, and maint. Maint displays when parent selection is complete.</td>
</tr>
<tr>
<td>Malformed Neighbor Packets</td>
<td>The number of malformed packets received from the neighbor. Examples of malformed packets include malicious floods of traffic such as malformed or short DNS packets and malformed DNS replies.</td>
</tr>
<tr>
<td>Poor Neighbor SNR</td>
<td>The number of times the signal-to-noise ratio falls below 12 dB on the backhaul link.</td>
</tr>
</tbody>
</table>
### Table 28: Queue Mesh Statistics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Silver Queue</td>
<td>The average and peak number of packets waiting in the silver (best effort) queue during the defined statistics time interval. Packets dropped and queue size are also summarized.</td>
</tr>
<tr>
<td>Gold Queue</td>
<td>The average and peak number of packets waiting in the gold (video) queue during the defined statistics time interval. Packets dropped and queue size are also summarized.</td>
</tr>
<tr>
<td>Platinum Queue</td>
<td>The average and peak number of packets waiting in the platinum (voice) queue during the defined statistics time interval. Packets dropped and queue size are also summarized.</td>
</tr>
</tbody>
</table>
### Table 29: Security Mesh Statistics

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Association Request Failures</td>
<td>Summarizes the total number of association request failures that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Association Request Success</td>
<td>Summarizes the total number of successful association requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Association Request Timeouts</td>
<td>Summarizes the total number of association request time outs that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Authentication Request Failures</td>
<td>Summarizes the total number of failed authentication requests that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Authentication Request Success</td>
<td>Summarizes the total number of successful authentication requests between the selected mesh access point and its parent mesh node.</td>
</tr>
<tr>
<td>Authentication Request Timeouts</td>
<td>Summarizes the total number of authentication request timeouts that occur between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Invalid Association Request</td>
<td>Summarizes the total number of invalid association requests received by the parent mesh access point from the selected child mesh access point. This state might occur when the selected child is a valid neighbor but is not in a state that allows association.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Reassociation Request</td>
<td>Summarizes the total number of invalid reassociation requests received by the parent mesh access point from a child. This state might occur when a child is a valid neighbor but is not in a proper state for reassociation.</td>
</tr>
<tr>
<td>Invalid Reauthentication Request</td>
<td>Summarizes the total number of invalid reauthentication requests received by the parent mesh access point from a child. This state might occur when a child is a valid neighbor but is not in a proper state for reauthentication.</td>
</tr>
<tr>
<td>Packets Received</td>
<td>Summarizes the total number of packets received during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td>Packets Transmitted</td>
<td>Summarizes the total number of packets transmitted during security negotiations by the selected mesh access point.</td>
</tr>
<tr>
<td>Reassociation Request Failures</td>
<td>Summarizes the total number of failed reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reassociation Request Success</td>
<td>Summarizes the total number of successful reassociation requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reassociation Request Timeouts</td>
<td>Summarizes the total number of reassociation request timeouts between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Request Failures</td>
<td>Summarizes the total number of failed reauthentication requests between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Request Success</td>
<td>Summarizes the total number of successful reauthentication requests that occurred between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Reauthentication Request Timeouts</td>
<td>Summarizes the total number of reauthentication request timeouts that occurred between the selected mesh access point and its parent.</td>
</tr>
<tr>
<td>Unknown Association Requests</td>
<td>Summarizes the total number of unknown association requests received by the parent mesh access point from its child. The unknown association requests often occur when a child is an unknown neighbor mesh access point.</td>
</tr>
</tbody>
</table>

Managing Mesh Access Points with Cisco Prime Infrastructure

Viewing Mesh Statistics for a Mesh Access Point
<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unknown Reassociation Request</td>
<td>Summarizes the total number of unknown reassociation requests received by the parent mesh access point from a child. This state might occur when a child mesh access point is an unknown neighbor.</td>
</tr>
<tr>
<td>Unknown Reauthentication Request</td>
<td>Summarizes the total number of unknown reauthentication requests received by the parent mesh access point node from its child. This state might occur when a child mesh access point is an unknown neighbor.</td>
</tr>
</tbody>
</table>

**Viewing the Mesh Network Hierarchy**

You can view the parent-child relationship of mesh access points within a mesh network in an easily navigable display. You can also filter which mesh access points display on the Map view, by selecting only mesh access points of interest.

To view the mesh network hierarchy for a selected network, follow these steps:

**Step 1**: Choose Monitor > Maps.

**Step 2**: Select the map that you want to be displayed.

**Step 3**: Click the Layers arrow to expand that menu.

**Step 4**: Select the AP Mesh Info check box if it is not already checked.

**Note**: The AP Mesh Info check box can be selected only if mesh access points are present on the map. It must be checked to view the mesh hierarchy.

**Step 5**: Click the AP Mesh Info arrow to display the mesh parent-child hierarchy.

**Step 6**: Click the plus (+) sign next to a mesh access point to display its children. All subordinate mesh access points are displayed when a negative (-) sign displays next to the parent mesh access point entry.

**Step 7**: Move the cursor over the colored dot next to each mesh access point child to view details on the link between it and its parent. Table 30: Bridging Link Information, on page 223 summarizes the parameters that display. The color of the dot also provides a quick reference point of the SNR strength.

- A green dot represents a high SNR (above 25 dB).
- An amber dot represents an acceptable SNR (20 to 25 dB).
- A red dot represents a low SNR (below 20 dB).
- A black dot indicates a root access point.
Table 30: Bridging Link Information

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Information fetched on</td>
<td>Date and time that information was compiled.</td>
</tr>
<tr>
<td>Link SNR</td>
<td>Link signal-to-noise ratio (SNR).</td>
</tr>
<tr>
<td>Link Type</td>
<td>Hierarchical link relationship.</td>
</tr>
<tr>
<td>SNR Up</td>
<td>Signal-to-noise radio for the uplink (dB).</td>
</tr>
<tr>
<td>SNR Down</td>
<td>Signal-to-noise radio for the downlink (dB).</td>
</tr>
<tr>
<td>PER</td>
<td>Packet error rate for the link.</td>
</tr>
<tr>
<td>Tx Parent Packets</td>
<td>TX packets to a node while acting as a parent.</td>
</tr>
<tr>
<td>Rx Parent Packets</td>
<td>RX packets to a node while acting as a parent.</td>
</tr>
<tr>
<td>Time of Last Hello</td>
<td>Date and time of last hello.</td>
</tr>
</tbody>
</table>

Using Mesh Filters to Modify Map Display of Maps and Mesh Links

In the mesh hierarchical page, you can also define mesh filters to determine which mesh access points display on the map based on hop values as well as what labels display for mesh links.

Mesh access points are filtered by the number of hops between them and their root access point.

To use mesh filtering, follow these steps:

Step 1

To modify what label and color displays for a mesh link, do the following:

In the Mesh Parent-Child Hierarchical View, select an option from the Link Label drop-down list. Options are None, Link SNR, and Packet Error Rate.

In the Mesh Parent-Child Hierarchical View, select an option from the Link Color drop-down list to define which parameter (Link SNR or Packet Error Rate) determines the color of the mesh link on the map.

Note  The color of the link provides a quick reference point of the SNR strength or Packet Error Rate.
### Table 31: Definition for SNR and Packet Error Rate Link Color

<table>
<thead>
<tr>
<th>Link Color</th>
<th>Link SNR</th>
<th>Packet Error Rate (PER)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Green</td>
<td>Represents an SNR above 25 dB (high value)</td>
<td>Represents a PER of one percent (1%) or lower</td>
</tr>
<tr>
<td>Amber</td>
<td>Represents an SNR between 20 and 25 dB (acceptable value)</td>
<td>Represents a PER that is less than ten percent (10%) and greater than one percent (1%)</td>
</tr>
<tr>
<td>Red</td>
<td>Represents an SNR below 20 dB (low value)</td>
<td>Represents a PER that is greater than ten percent (10%)</td>
</tr>
</tbody>
</table>

**Note** The Link label and color settings are reflected on the map immediately. You can display both SNR and PER values simultaneously.

**Step 2** To modify which mesh access points display based on the number of hops between them and their parents, do the following:

- In the Mesh Parent-Child Hierarchical View, click the Quick Selections drop-down list.
- Select the appropriate option from the list.

### Table 32: Quick Selection Options

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select only Root APs</td>
<td>Choose this setting if you want the map view to display root access points only.</td>
</tr>
<tr>
<td>Select up to 1st hops</td>
<td>Choose this setting if you want the map view to display 1st hops only.</td>
</tr>
<tr>
<td>Select up to 2nd hops</td>
<td>Choose this setting if you want the map view to display 2nd hops only.</td>
</tr>
<tr>
<td>Select up to 3rd hops</td>
<td>Choose this setting if you want the map view to display 3rd hops only.</td>
</tr>
<tr>
<td>Select up to 4th hops</td>
<td>Choose this setting if you want the map view to display 4th hops only.</td>
</tr>
<tr>
<td>Select All</td>
<td>Select this setting if you want the map view to display all access points.</td>
</tr>
</tbody>
</table>

Click Update Map View to refresh the screen and redisplay the map view with the selected options.

**Note** Map view information is retrieved from the Cisco Prime Infrastructure database and is updated every 15 minutes.

**Note** You can also select or deselect the check boxes of mesh access points in the mesh hierarchical view to modify which mesh access points are displayed. For a child access point to be visible, the parent access point to root access point must be selected.
## Monitoring Workgroup Bridges

You can monitor workgroup bridge (WGB) clients separately.

**Step 1**

On the Cisco Prime Infrastructure GUI, choose **Monitor > WGBs**.

*Figure 72: Monitor > WGBs*

<table>
<thead>
<tr>
<th>Client Properties</th>
<th>RF Properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client User Name</td>
<td>AP Name</td>
</tr>
<tr>
<td>Client IP Address</td>
<td>SJC14-42A-AP-C2</td>
</tr>
<tr>
<td>Client MAC Address</td>
<td>AP Type</td>
</tr>
<tr>
<td>Client Vendor</td>
<td>AP Base Radio MAC</td>
</tr>
<tr>
<td>Controller</td>
<td>Protocol</td>
</tr>
<tr>
<td>Port</td>
<td>AP Mode</td>
</tr>
<tr>
<td>Interface</td>
<td>Profile Name</td>
</tr>
<tr>
<td>VLAN ID</td>
<td>SSID</td>
</tr>
<tr>
<td>802.11 State</td>
<td>Security Policy</td>
</tr>
<tr>
<td>Mobility Role</td>
<td>Association Id</td>
</tr>
<tr>
<td></td>
<td>Reason Codes</td>
</tr>
<tr>
<td>Policy Manager State</td>
<td>802.11 Authentication</td>
</tr>
<tr>
<td>Anchor Address</td>
<td>Authenticated</td>
</tr>
<tr>
<td>Mirror Mode</td>
<td>Policy Type</td>
</tr>
<tr>
<td>CCK</td>
<td>Encryption Cipher</td>
</tr>
<tr>
<td>IEEE</td>
<td>PAP Type</td>
</tr>
<tr>
<td>WGB Status</td>
<td>WGB Status</td>
</tr>
</tbody>
</table>

### WGB SNMP Monitoring

- **SNMP Status**: Unreachable
- **This WGB is monitored by WCS as Autonomous AP** [Click for more details](#)
Step 2 Click the WGB Clients tab to see a summary of WGB clients.

Figure 73: Monitor > WGBs > WGB Clients Panel

Multiple VLAN and QoS Support for WGB Wired Clients

A WGB is a small standalone unit that can provide a wireless infrastructure connection for Ethernet-enabled devices. Devices that do not have a wireless client adapter to connect to the wireless network can be connected to the WGB through the Ethernet port. The WGB associates with the root AP through the wireless interface, which means that wired clients get access to the wireless network.

This feature provides the segregation of traffic based on VLANs for different applications running on different devices connected to a switch behind a WGB. Traffic from WGB clients are sent in the right priority queue in the mesh backhaul based on DSCP/dot1p values.

Note

You need a special autonomous image on the autonomous access points being used as a WGB for interoperability with the Unified CAPWAP infrastructure. This image will be merged with the next official autonomous release.

The WGB informs the WLC about the wired-client VLAN information in an IAPP association message. The WGB removes the 802.1Q header from the packet while sending to the WLC. The WLC sends the packet to the WGB without the 802.1Q tag and the WGB adds 802.1Q header to packets that go to the wired switch based on the destination MAC address.

The WLC treats the WGB client as a VLAN client and forwards the packet in the right VLAN interface based on the source MAC address.
You must enable the WGB unified client for multiple VLAN support on the WGB by entering the workgroup-bridge unified-VLAN-client command. This WGB unified client is disabled by default.

You have to configure subinterfaces on the WGB that corresponds to the VLANs on the switch ports to which the wired clients are connected.

**Workgroup Bridge Guidelines**

Follow these guidelines when configuring WGBs:

- A dynamic interface should be created in the controller for each VLAN that is configured in the WGB.
- Only one WLAN (SSID) for a wireless association of the WGB to the access point infrastructure is supported. This SSID should be configured as an infrastructure SSID and should be mapped to the native VLAN. The WGB drops everything that is not in the native VLAN in the mesh infrastructure.
- We recommend that you configure the same native VLAN in the switch that connects the WLC, WGB, and in the switch behind the WGB.

All native VLAN clients on the WGB Ethernet side are part of the same VLAN in which the WGB is associated. The WGB is part of the VLAN to which the WLAN (in which the WGB has associated) is mapped.

For example, if in the WGB, the 5-GHz radio (dot11radio1) is mapped to a native VLAN 184, and the switch behind WGB has wired clients only in VLAN 185 and 186, then you may not require the native VLAN to be identical to the native VLAN on the WGB (VLAN 184).

But, if you add one wired client in VLAN 184 and this VLAN client in the WGB belongs to a native VLAN, you must define the same native VLAN on the switch.

- Intersubnet mobility is supported with this feature for VLAN clients behind the WGB with a limitation that the dynamic interface for all VLANs of the WGB should be configured in all the controllers.
- Interoperability with a VLAN-pooling feature is not supported. When the VLAN-pooling feature is enabled, the WGB and its native VLAN clients become part of the same VLAN.
- AAA-override for WGB clients is not supported, but AAA-override for the WGB is supported.
- Only Layer 3 multicast is provided for WGB VLAN clients and there is no support for Layer 2 multicast.
- There is a 20-client limitation in WGB that includes wireless clients.
- Link testing for WGB wired clients is not supported.
- Roaming is supported for wireless and wired clients behind WGB.
- Multicast is supported for wired clients behind WGB.
- Broadcast is supported.
- Non-Cisco workgroup bridges are supported on Mesh access points.
Configuring VLAN and QoS Support (CLI)

In the following example, VLANs 184 and 185 exist on the wired switch behind WGB. WGB’s native VLAN is 184. SSID is auto-wgb mapped to native VLAN 184. Radio 1 (5 GHz) radio is used to connect to the CAPWAP infrastructure using this SSID.

```
ap# config t
ap(config)# workgroup-bridge unified-VLAN-client
ap(config)# int FastEthernet0.184
ap(config-subif)# encapsulation dot1q 184 native
ap(config-subif)# bridge-group 1
ap(config-subif)# exit
ap(config)# int FastEthernet0.185
ap(config-subif)# encapsulation dot1q 185
ap(config-subif)# bridge-group 185
ap(config-subif)# exit
ap(config)# int Dot11Radio 1.185
ap(config-subif)# encapsulation dot1q 185
ap(config-subif)# bridge-group 185
ap(config-subif)# exit
ap(config)# int Dot11Radio 1.184
ap(config-subif)# encapsulation dot1q 184 native
ap(config-subif)# bridge-group 1
ap(config-subif)# exit
ap(config)# dot11 ssid auto-wgb
ap(config-ssid)# authentication open
ap(config-ssid)# infrastructure-ssid
ap(config-ssid)# VLAN 184
ap(config-ssid)# exit
ap(config)# int Dot11Radio 1
ap(config-if)# station-role workgroup-bridge
ap(config-if)# ssid auto-wgb
ap(config-if)# exit
ap(config)# bridge irb
ap(config)# hostname WGB
```

The `bridge irb` command is used to enable integrated routing and bridging, which the Auto AP code has retained from other higher end platforms.

You have to create dynamic interfaces 184 and 185 on the WLC for the above configuration to work. The WGB updates the WLC about the wired-client VLAN information in the IAPP association message. The WLC treats the WGB client as a VLAN-client and forwards the packet in the right VLAN interface based on the source MAC address. In the upstream direction, the WGB removes the 802.1Q header from the packet and sends it to the WLC. In the downstream direction, the WLC sends the packet to the WGB without the 802.1Q tag and the WGB adds the 802.1Q header based on the destination MAC address, while forwarding the packet to the switch that connects the wired client.

**Workgroup Bridge Output**

Enter the following command:

```
WGB# sh bridge
Total of 300 station blocks, 292 free
Codes: P - permanent, S - self
```
<table>
<thead>
<tr>
<th>Address</th>
<th>Action</th>
<th>Interface</th>
<th>Age</th>
<th>RX count</th>
<th>TX count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0023.049a.0b12</td>
<td>forward</td>
<td>Fa0.184</td>
<td>0</td>
<td>2</td>
<td>0</td>
</tr>
<tr>
<td>0016.c75d.b48f</td>
<td>forward</td>
<td>Fa0.184</td>
<td>0</td>
<td>21</td>
<td>0</td>
</tr>
<tr>
<td>0021.91f8.e9ae</td>
<td>forward</td>
<td>Fa0.184</td>
<td>0</td>
<td>110</td>
<td>16</td>
</tr>
<tr>
<td>0017.59ff.47c2</td>
<td>forward</td>
<td>Vi0.184</td>
<td>0</td>
<td>22</td>
<td>22</td>
</tr>
<tr>
<td>0021.5504.07b5</td>
<td>forward</td>
<td>Fa0.184</td>
<td>0</td>
<td>6</td>
<td>0</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Address</th>
<th>Action</th>
<th>Interface</th>
<th>Age</th>
<th>RX count</th>
<th>TX count</th>
</tr>
</thead>
<tbody>
<tr>
<td>0016.c75d.b48f</td>
<td>forward</td>
<td>Fa0.185</td>
<td>0</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>001e.5831.c74a</td>
<td>forward</td>
<td>Fa0.185</td>
<td>0</td>
<td>9</td>
<td>0</td>
</tr>
</tbody>
</table>
WGB Detail on Controller

To display WGB details about the controller, enter the following command:

(Cisco Controller) > show wgb summary

Number of WGBs........................................ 2

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN</th>
<th>Auth</th>
<th>Protocol</th>
<th>Clients</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:1d:70:97:bd:e8</td>
<td>209.165.200.225</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>2</td>
</tr>
<tr>
<td>00:1e:be:27:5f:e2</td>
<td>209.165.200.226</td>
<td>c1240</td>
<td>Assoc</td>
<td>2</td>
<td>Yes</td>
<td>802.11a</td>
<td>5</td>
</tr>
</tbody>
</table>

(Cisco Controller) > show client summary

Number of Clients........................................ 7

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>AP Name</th>
<th>Status</th>
<th>WLAN/Guest-Lan</th>
<th>Auth</th>
<th>Protocol</th>
<th>Port</th>
<th>Wired</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:00:24:ca:a9:b4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>N/A</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:3a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f4</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:61:f8</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:0a</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:62:42</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
<tr>
<td>00:24:c4:a0:71:d2</td>
<td>R14</td>
<td>Associated</td>
<td>1</td>
<td>Yes</td>
<td>802.11a</td>
<td>29</td>
<td>No</td>
</tr>
</tbody>
</table>

(Cisco Controller) > show wgb detail 00:1e:be:27:5f:e2

Number of wired client(s): 5

<table>
<thead>
<tr>
<th>MAC Address</th>
<th>IP Address</th>
<th>AP Name</th>
<th>Mobility</th>
<th>WLAN</th>
<th>Auth</th>
</tr>
</thead>
<tbody>
<tr>
<td>00:16:c7:5d:b4:8f</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
<tr>
<td>00:21:91:f8:e9:ae</td>
<td>209.165.200.232</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:21:55:04:07:b5</td>
<td>209.165.200.234</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:1e:58:31:c7:4a</td>
<td>209.165.200.236</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>Yes</td>
</tr>
<tr>
<td>00:23:04:9a:0b:12</td>
<td>Unknown</td>
<td>c1240</td>
<td>Local</td>
<td>2</td>
<td>No</td>
</tr>
</tbody>
</table>
### Troubleshooting Tips

If a WGB client does not associate with the WGB, note these tips to troubleshoot the problem:

- The native VLAN that is configured on the WGB needs to be the same VLAN on the switch to which the WGB is connected. The switch port connected to the WGB should be Trunk.
- Verify the client configuration and ensure that the client configuration is correct.
- Check the show bridge command output in the autonomous AP and confirm that the AP is reading the client MAC address in the right interface.
- Confirm that the subinterfaces that correspond to specific VLANs and different subinterfaces are mapped to the bridge group.
- WGB reads the switch port behind as a client in its MAC address table.
- If required, clear the bridge entry using the clear bridge command (remember that this command will remove all the wired and wireless clients associated with the WGB and make them associated again).
- Ensure that the WGB has not exceeded its 20-client limitation.
Cisco Prime Infrastructure reports the reason for the most recent reboot on the general panel of the access point details page (Monitor > Access Points > AP Name).

Listed below is a summary of each of the possible Last Reboot Reasons that might be reported and its definition:

- **none**—Access point reported a reboot reason unknown to the controller
- **dot11gModeChange**—Change of 802.11g mode change occurred
- **ipAddressSet**—Set of static IP address
- **ip AddressReset**—Reset of static IP address
- **rebootFromController**—Reboot of access point initiated from the controller
- **dhcpFallbackFail**—Fallback to DHCP did not occur
- **discoveryFail**—Discovery was not sent
- **noJoinResponse**—Join response was not received
- **denyJoin**—Join attempt at the controller was denied
- **noConfigResponse**—Config Response was not received
- **configController**—Configured or master controller found
- **imageUpgradeSuccess**—Upgrade of image successful
- **imageOpcodeInvalid**—Invalid image data opcode
- **imageChecksumInvalid**—Invalid image md 5 checksum
- **imageDataTimeout**—Image data message timed-out
- **configFileInvalid**—Invalid config file
- **imageDownloadError**—Process error during the image download
- **rebootFromConsole**—Reboot command initiated from AP console
- **rapOverAir**—Root access point (RAP) is connected over the air
- **brownout**—Power failure caused reboot
- **powerLow**—Low power caused a reboot
- **crash**—Software failure caused crash
- **powerHigh**—Power spike caused reboot
- **powerLoss**—Power loss caused reboot
- **powerCharge**—Change in power source caused reboot
- **componentFailure**—Component failure caused reboot
- **watchdog**—Watch dog timer reset caused reboot
## INDEX

### A

- **Access Point Roles** 2, 83, 189
  - Defining 83, 189

### B

- **Backup Controllers** 86
- **Base License** 24
- **Beamwidth** 8

### C

- **CAC** 145
  - in mesh networks 145
- **CAPWAP** 10
- **Cell Planning and Distance** 45, 47
  - AP1520 Series 45
  - AP1550 Series 47
- **CleanAir** 71, 73, 74, 75
  - Access Point Deployment Recommendations 73
  - Advisor 74
  - Licensing 75
  - Modes of Operation 71
- **Controller Planning** 23

### D

- **Dynamic Frequency Selection** 7, 191

### F

- **Frequency Bands** 6
- **Fresnel Zone** 37, 39

### G

- **Google Earth Map** 207
- **Google Earth Maps** 208
  - Viewing 208

### I

- **Indoor Mesh Access Points** 4

### L

- **LinkSNR Requirements** 20, 21
- **Locally Significant Certificates** 158

### M

- **mesh** 176
  - statistics 176
  - viewing for an access point using the GUI 176
- **Mesh Range** 18
  - Configuring 18
- **Monitoring Mesh Health** 215
- **Monitoring Mesh Link Statistics Using Maps** 212

### P

- **Polarization** 9
- **Pre-Survey Checklist** 37
- **Preferred Parent** 42
  - Configuring 42
  - Selection Criteria 42
- **Pseudo MAC and Merging** 72
U
Universal Access 16
Upgrade Controller Software 80

W
Wireless Backhaul 15

Wireless Backhaul Data Rate 113
Wireless Bridging 16, 17
    Point-to-Multipoint 16
    Point-to-Point 17
Wireless Software Compatibility Matrix 80
Workgroup Bridges 225
    Monitoring 225
WPlus License 24